FDSS7000EX/uCELL Software
Instruction Manual

Version 2.9.5

Thank you for your purchase.

/A\CAUTION

* Follow the safety precautions in order to avoid personal injury and damage
to property when using this system. The manual describes the correct
handling method of the system and provides cautions in order to avoid
accidents. Read this manual carefully beforehand use the system
correctly. After reading the manual, store it in a location where you can refer
to it at any time.

FDSS7000EX is an upper compatible model of FDSS7000 and this
software can be used for both FDSS7000 and FDSS7000EX.
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[ 405, AL ATA BVEL B T ST




FDSS7000EX/uCELL Software Instruction Manual Ver.2.9.5 72360301-05

(This page is blank.)

HAMAMATSU PHOTONICS KK



FDSS7000EX/uCELL Software Instruction Manual Ver.2.9.5 72360301-05

SAFETY PRECAUTIONS

CLASSIFICATION OF WARNING

We have classified the warnings symbols that appear in this instruction manual and on the
system as follows for your convenience. Make sure that you fully understand them and obey
the instructions they contain.

Improper handling of the system without observing

AWARN|NG these warnings could lead to serious injury to the user
and even death.

Improper handling of the system without observing

ACAUTlON these cautions could lead to personal injury to the user
or damage to property.

This symbol indicates a note to help you get the best performance
from the system. Read the contents of the note carefully to ensure
correct and safe use. Failure to observe one of these notes might
impair the performance of the system.

This symbol indicates a cautionary item that should be obeyed when
handling the system. Read the contents carefully to ensure correct
and safe use.

This symbol indicates an action that is forbidden. Read the contents
carefully and be sure to obey them.

This symbol indicates a compulsory action or instruction. Read the
contents carefully and be sure to obey them.

o0l 6

In the software, a character of ‘Y’ is not indicate. So, in the
software window, a character of ‘U’ is used instead of ‘W’
For example, ul is used in stead of pl.
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SOFTWARE USER AGREEMENT

In order to use the software that comes with this product (indicates entire product if software
is a single product item; hereafter called "this software"), the user must agree to the
following terms and conditions. Always be sure to read these terms before use.

Copyrights

All ownership rights, intellectual property rights and all other rights relating to this software
and instruction manual are the property of Hamamatsu Photonics K. K. (hereafter called
"Hamamatsu"). Except for those items expressly permitted in this user agreement,
Hamamatsu does not assign or grant any rights to the user, and Hamamatsu retains all
rights relating to this software and instruction manual.

Scope of usage rights

Hamamatsu grants the user non-exclusive rights to use of this software subject to the
following conditions.

(1) User may install and use this software on a single computer.
(2) User may copy this software only for the purpose of making a backup.

(3) User may not analyze, change or modify this software.

(4) User may transfer this software to a third party provided that all of the
following conditions are fulfilled.

. User transfers all software products including this software and related materials
and copies of this software, and retains absolutely none of the materials or copies of
this software.

. The third party who will receive this software agrees to the terms in this software
user agreement

Scope of warranty Limited Warranty

(1) If the storage media containing this software is found to be defective
during the warranty period and this software does not properly function,
then this software will be replaced free of charge or a substitute product
given to the user.

(2) Hamamatsu accepts absolutely no liability in any case whatsoever, for
damages or losses arising directly or indirectly relating to or incidental to
use of this software.

(3) If an error (bug) is discovered in this software and is corrected, then the
corrected software or software for making the correction (hereafter written
as "correction software") or information relating to making the correction
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will be provided. However, the necessity, the time, and the period for
providing the correction software or information relating to the correction
will be decided at the discretion of Hamamatsu.

Disclaimer of liability for damages

The legal liability of Hamamatsu including warranty against defects relating to this software
and its usage is limited to the contents of this software user agreement. Hamamatsu shall
not be liable to provide compensation for any damage or loss resulting from using this
software, including direct, indirect or incidental damages or losses to the user. This holds
true even if Hamamatsu or its suppliers have been advised of the possibility of such
damages or losses.

Governing law

This software user agreement shall be governed by the laws of Japan.

Others

If a conflict or doubt should arise regarding this user license agreement or items not
established within this user license agreement, then that matter shall be resolved by mutual
consultation carried out in good faith by both parties. In the event a lawsuit should arise, it
shall be resolved by a court of law having jurisdiction in the area where the head office of
Hamamatsu Photonics is then located.
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CONTACT INFORMATION

HAMAMATSU PHOTONICS K. K., Systems Division
812 Joko-cho, Higashi-ku, Hamamatsu City, 431-3196,Japan
Telephone (81) 53-431-0124, Fax: (81) 53-435-1574
E-mail: export@sys.hpk.co.jp

U.S.A. and Canada:

Hamamatsu Corporation
360 Foothill Road,Bridgewater,N.J. 08807-0910,U.S.A.
Telephone: (1)908-231-0960, Fax: (1)908-231-0852
E-mail: usa@hamamatsu.com

Germany:
Hamamatsu Photonics Deutschland GmbH

Arzbergerstr. 10, D-82211 Herrsching am Ammersee, Germany
Telephone: (49)8152-375-0, Fax: (49)8152-265-8
E-mail: info@hamamatsu.de

France:

Hamamatsu Photonics France S.A.R.L.
19,Rue du Saule Trapu, Parc du Moulin de Massy, 91882 Massy Cedex, France
Telephone: (33)1 69 53 71 00, Fax: (33)1 69 53 71 10
E-mal: infos@hamamatsu.fr

United Kingdom:
Hamamatsu Photonics UK Limited

2 Howard Court, 10 Tewin Road, Welwyn Garden City
Hertfordshire AL7 1BW, United Kingdom

Telephone: (44)1707-294888, Fax: (44)1707-325777
E-mail: info@hamamatsu.co.uk

North Europe:
Hamamatsu Photonics Norden AB

Smidesvagan 12, SE-171 41 Solna, Sweden
Telephone: (46)8-509-031-00, Fax: (46)8-509-031-01
E-mail: info@hamamatsu.se

Italy:
Hamamatsu Photonics Italia S.R.L.

Strada della Moia, 1/E 20020 Arese (Milano), Italy
Telephone: (39)02-935 81 733, Fax: (39)02-935 81 741
E-mail: info@hamamatsu.it

China:

Hamamatsu Photonics (China) Co., Ltd.
1201 Tower B, Jiaming Center, 27 Dongsanhuan Beilu, Chaoyang District, Beijing 100020, China
Telephone: (86)10-6586-6006, Fax: (86)10-6586-2866
E-mail: hpc@hamamatsu.com.cn

@ The contents of this manual are subject to change without notice.

@ The unauthorized reproduction or distribution of part or all of this manual is prohibited.

@ If one of the following problems occurs, contact Hamamatsu Photonics. (See the
Contact Information.) We will deal with the problem immediately.

Some contents of the manual are dubious, incorrect or missing.
Some pages of the manual are missing or in the wrong order.
The manual is missing or dirty.
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1. FDSS software installation

@ Hamamatsu engineer installs software basically.

1) Before FDSS software installation

Before installing the FDSS application software, check that Microsoft Windows 7 or XP
is installed in the computer. If not, install it according to the Microsoft Windows

Reference Manual.
All the FDSS software is supplied on CD-ROM. The setup program contained on the
disk allows easy installation of the software.

The setup program performs the following tasks.
1. Creating the FDSS directory
When the FDSS directory is not created, the setup program automatically
creates it.
2. Copying files
The setup program copies the FDSS source module run files and all other
necessary files into the FDSS directory.

2) FDSS software installation

If other application software is installed, check that it is not running.

1. Insert Install CD-ROM into the CD-ROM drive of the computer.

2. Select "Run..." from the Start menu.

3. The dialog box then appears, so enter "<CD-ROM Drive>:¥FDSSXXXX
Ver.2.9.5¥Disk1¥setup” and click "OK". (Enter "E:¥FDSS7000EX
Ver.2.9.5¥Disk1¥setup" when installing the software from drive E. The
splash screen and the first setup dialog box soon appear.

3-1) In the case of FDSS7000EX

(CD-ROM Drive):¥FDSS7000EX Ver.2.9.5¥Disk1¥setup
3-2) In the case of uCELL

(CD-ROM Drive):¥uCELL Ver.2.9.5¥Disk1¥setup
3-3) In the case of FDSS Offline

(CD-ROM Drive):¥FDSS Offline Ver.2.9.5¥Disk1¥setup
4. Follow the instructions displayed on the screen and proceed to the
subsequent steps.

HAMAMATSU PHOTONICS KK
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3) Microsoft-Windows operation
This manual does not include a description of how to operate Microsoft Windows. If you
are not familiar with Microsoft Windows, you should first read the Microsoft Windows
User's Guide and make yourself understood it

4) About a power supply option setup of Windows
Please set a sleep setup of a power supply option as OFF.
A problem may arise in connection of a camera after a sleep return.

HAMAMATSU PHOTONICS KK
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2. How to operate FDSS (EASY MANUAL)

1) Starting system

(1-1) In the case of FDSS3000/6000/7000EX

[ Turn ON the light source (Xe lamp). (Central power+Light Source Switch Panel) ]

!

[ Turn On the other devices. (Central power) ]

PC starting up and Windows running up ]

Starting up FDSS application.
Double-click the icon of FDSS.

%

FDS52xe

FDSS application starting up ]

The following box appears. Choose 1) method type, 2) microplate format,
and 3) camera exposure time and then click ‘OK’ button.

Select Method

Wi e — i

Ftwell =l Cancel | 2) Choose ‘96’ or ‘384’
format.

Camera Exposure

| 3) Choose exposure time,

‘short’, ‘normal’ or ‘long’.

1) Choose measurement

\ method

HAMAMATSU PHOTONICS KK
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< In the case of FDSS7000EX >

After door of dispenser open, the following box appears.
First of all, Place the 1) Head, 2) Tip used

Choose the combination between ‘Head’ and ‘Tip’ used, and then click ‘Set Tip &
Head’ button

Select Tip & Head Oombination Mode:

<A> No Tip + No Head <B> 1 Tip+ 1 Head 0> 2 Tip + 2 Head

Chose the combination between

e i —— ‘Head’ and ‘Tip’
L= L.
384-voll ITTOTRLLL [ToThLL
[ | Set Tip & Head (The modk ic changed) Jl CIle ;Set T|p & Head, button

After door of dispenser close, the following box appears.

Click ‘OK’ button after push ‘Preparation button’ of front panel of dispenser.
(It is not displayed according to the system, and Preparation is done by the
automatic operation. )

! 5 Dispenser :

[100] Please push <Preparation: button that exists in the operation panel of the dispenser,

@ Click ‘OK’ button

[ Main screen appears. ]
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(1-2) In the case of uCELL

[ Turn On all devices. (Central power) ]

PC starting up and Windows running up

Starting up FDSS application.
Double-click the icon of FDSS.

l FDSS application starting up

ﬁhe following box appears. Choose 1) method type, 2) microplate format,

and 3) camera exposure time and then click ‘OK’ button.

Select Method

Microplate Format

format.

Lumitfnalog)
Offline

Camera Exposure

method

-~

Finels =] __cameel | | 2)Choose ‘96’ or ‘384’

| 3) Choose exposure time,
‘short’, ‘normal’ or ‘long’.

1) Choose measurement

l

The following box appears.
First of all, place the head used.
Choose the ‘Head Mode’ used, and then click ‘Set the head’ button

Select Head Mode
<A> Mo Head <B> Head 1

Plate Format

384 well

- % ],_ Chose the combination between ‘Head’

\ [ osormtre s | Click ‘Set the head’ button

!

[ Main screen appears. ]
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2) System exiting

(2-1) In the case of FDSS3000/6000/7000EX

/ Exiting FDSS application software
Choose Exit command in File menu.

P FDSST000EX/uGELL <Lum
21=8 Protocal  Wiew Setup Hel

COpen Plate Data.. |

Print Out 3 I

Save by Bitmap (3
Digplay Graph in Mew Windaw ¥
Copy Graph to Clipboard 3

\ l )— Choose ‘Exit’.

l

< In the case of FDSS7000EX >
After door of dispenser open, the following box appears.
Bring out ‘Head’ and ‘Tip’ from dispenser and then Click OK button.

FDS55 Dispenser gl

! E Please take out the head and the tip.

L Click ‘OK’ button.

After door of dispenser close, the following box appears.

Click ‘OK’ button after push ‘Preparation button’ of front panel of dispenser.
(It is not displayed according to the system, and Preparation is done by the
automatic operation. )

! E Dispenser :

[100] Please push <Preparation: button that exists in the operation panel of the dispenser.

Click ‘OK’ button.

FDSS application software exiting ]

Exiting Windows
Choose shutdown command in Start menu.
All Programs D

.| Log OFf El Turn OfF Computer C‘hOOSG ,
— — Turn Off Computer’.

12
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/Exiting box appears. Choose shutdown and click ‘OK’.

Choose ‘Turn Off’

Cancel

Exiting Windows ]

A 4
[ Turn OFF the other devices expect for the light source (Xe lamp). (Central power) ]

\ /
[ Turn OFF the light source (Xe lamp). ]

l

[ Exiting the system ]

13
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(2-2) In the case of UCELL

/ Exiting FDSS application software
Choose Exit command in File menu.
P FDSSTN00EX/uGELL <Lum
218 Protocol  Miew Setup  Hel
Open Plate .Data.. |
Pr‘lnl .O;A( = 3 I
Save by Bitmap 3}
Dizplay Graph in Mew Window »
Copy Graph to Clipboard L3
k E— Choose ‘Exit'.

v

The following box appears.
Bring out ‘Head’ and ‘Tip’ from dispenser and then Click OK button

k | Click ‘OK’ button.
FDSS application software exiting l
Exiting Windows
Choose shutdown command in Start menu.
All Programs D
og O - urn OFF Computer Choose
!|L'; . @JT” R ‘Turn Off Computer’.

v

f Exiting box appears. Choose shutdown and click ‘OK’.
- Choose ‘Turn Off’

Exiting Windows

[ Turn OFF all devices . (Central power) ]

)

[ Exiting the system ]
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3) Workflow of FDSS application software

[ Starting up FDSS application ]
v

[ Select Method: choose measurement method, format and exposure time l

!

~_FDSS7000EX,uCELL >

[ Choose the combination between Head&Tip

0

Exchange Head&Tip

—_FDSS7000EX UCELL >

Protocol setting / Data acquisition] Measurement data loading l

________ o

Lo

Protocol menu -> Setup & Acquire l File menu -> Open Plate Data command ’

|
[ Assay protocol setting]

%[ Aspirating ligand from loading line ]

D|spensmg/asp|rat|ng before measurement ]

T|p/||gand exchanging ]

Camera sensitivity adjustment ]

Dlspensmg preparation ]

[
[
[ Pre Incubatlon ]
[
[
[

Data acqmsmon starting ]

| Dispensing ]

[ Data acquisition finishing ]

I
[ Data saving (New FDSS format) ]
Vv

[ All well graph, multi overlay, diagram, calculation and

pseudo-color plate l

Vv
[ Print Out, Text Save ]

[ Plate out ]

[ Measurement finishing ] [ Data calculation, Print Out, Text Save

HAMAMATSU PHOTONICS KK
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4) Measurement example

<Experiment to get data and save text data automatically>

Here one example is shown to explain measurement flow. The condition is fluorescence
measurement, 2-excitation switching, 1 emission, 20 pul dispensing quantity, 1 time
dispensing, 2 seconds interval, and 2 minuets measurement time.

And then the data is saved with text format. (File name is ‘TESTXXXX’)

[ FDSS software starting ]

\

Assay Protocol setting j

v

Toolbar —> Protocol or Protocol menu —> Choose Setup & Acquire

?"‘] FDSSTO00EX/uCELL <

File  Protocol” Wew et
Choose ‘Protocol’
= S
Cpen Data Protocaol r

Assay protocol setting box appears and protocol is set in the box. Set the following

example and then click Start <Single> button.
| Dispensing I

Mamw Pratocal Fa [ Load Gava ""‘""'. """"""""""" L

Fis Haew | Tl + 5N :._.'..'."_ cidmal | B bt |
Sampling interval 00:02.00 (s T g T e g R

Total Zarwp nx ] Ql 3] ...... al o °3
Measurement time 0:02:00 ~ — T S Trwtmsrad <) o
Filter selection _[ Zahip FEA1Em o TE:2Em | EdUESND / B EnSET ] ] e, :
Ex340Em540, ExX380EmM540 — v :

. N s T - D g e
Dispensing timing and stage b b oL J V3 e o <
Stage No.1 8.0 s (5" sampling) - = S i i

B e || RS
F,TafhatiRny Tt Oumfles TR e () T
o 'c.
. - g T bty I-ll!\-imfl!
Correction / analysis / output 5
N m.’ :7 i-llu M Maz e A Mac-Mr,
:::Egﬁg u Fi=e I LI r He [ Lo Wiz - M| r Pyt W
P Darta & Platm Forrut Dt oo fr
Next page! e, [ dwzm Pratacal
Fligrss £ Teutue
i'!.u,,r:lrr - Mdwath [T T
................... - Next page!
ETAAT < Grala STHAT ¢ fwdn s Lhara
Assay start| ——— 1 sl = -
l \4

16
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Dispensing parameter
<In the case of FDSS3000/6000/7000EX>

Set parameter for dispensini quantiti, speed and height.
Dispenser Gontrol

| | TH1+Stage1 tab
Or Head1 + Stage1 tab

R —
TH1+Staes] ]J—ﬂ +Staze? | THI+Staged | THI +Loader |

Dizpense Start | Mozzle Wash ‘ Detail.. ‘

Dispensing quantity

]___ Dispensing speed / height

Height 25mm 4| | 2
Multi Wach Off Setup | T~ affer meazurement

Washing setting: Off or 0

[ Yolume | 20 ul ﬂJ ﬂ 20 pl
Azpirate
S';ee; = 3| Ll Aspirating speed / height
Height [ 05 mm 4| | N 50 pl/s-0.5 mm
Dispense
[ Speed B0 ulfs 4 ﬂ 50 |J|/S'25 mm
(

Mixing setting

3 mlxmg ﬁssay Eate }
s Chanee Head & Ligand Flate Enabler (check)

* Setup for the washing differ by FDSS configuration

Dispensing parameter
<In the case of uCELL>

Dispenser Control

fssay Plate Aecess

Set parameter for dispensing quantity, speed and height.
[osperser o |

THi+Stagel | Th1 oS«%ez TH1+Stagel | THI+Stage2 | TH1 +Stage1 tab
—
‘ ‘ Setup
Dispense Start Nozzle Wash

Aspirate from

e Staget
fonees = Dispensing quantity
Spont ol N 20l
S o B Aspirating speed / height
i ,;”‘—ﬂjﬂ 50 pl/s+0.5 mm
Height Dsmm i’j:'I
= Dispensing speed / height

Dispense Wash
| T e oo 50 plis+2.5 mm

@ e
Heieht (100 mm__ < »

W Trituration Yat A= i .
v fod j arce F = - Washing setting: Off or 0
Count |5 1 »
;
;

Height 00 mm 4

Offsst 0O mm ¢ Pos.  [i0mm
Change Head
[~ Wipe:A Access Ligand Mol

* Setup for the washing differ by FDSS configuration
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|Correctionlana|ysisloutput

<Correction param

Output | Frepa | Sens. | Graph| Froc. | Galc Param |

r>
Corr. tab

Auto Fluorescence, Shading On

Correction Type Filename Date
o s Fiisreseence)
e Shading Greinerx4 PSD 2007/06/18 1930

<Auto output parameter>

Output tab

Cutput | P¥eaT Sere, | Gragh] Proc. | Galc.Param | T T

5 Oltput Method

[ Text OutCRaw> [ Text OutcPlate> [ Print Graph [~

)

Raw Data & Print Graph_Selection

Output item TextOut(Raw), TextOut(PlateFormat)

]_

Display graph item at raw data Ratio

[¢ Ratic | Ex480EmSA0 | [~ Tteeral || with SepFile
(| Hituells T~ Hit

Ratio ¥ Intee [~ Max [ Min [~ év. [ Max-Min

Exa80Em540 [~ Itee | Max [~ Min [ Av.

T~ Max-Min [~ Rat Max
Ex4B0E 540 o o

Raw Data & Plate Format Data <Faoter> ]

\

Filename <TextOut>

 Each Plate File ¢ Addto a file

Hit well On Hit well condition Ratio Max

<Calculation parameter>

utput| Preps | Sens. | Graph] prod CaleParam | T T T

Calc.Param tab

Ratic:Denominator |1t Samp. Point ~mve [1eamp. x|

Hit Well:Intergral item, Ratio
Hit Well:Peak Select, Max

— Hit condition

Wl Wesral em [Pt =T
it Vel - Select Peak  [Wax ~
it sl &
e
<MolData> T = .t El
¥ Nol Max oo -+ ¢ oo =
T f =
o = =
r | - I (-
r om =] < foo =]

Output| Prepa | Sens. | Graph| Proc. | Gale.Para

<Calculation range parameter>

e vl

Calc.Range tab

=2 S
Z| " Baseline teeral/Mas/Min/fve) N\
— I~ Enable Sub Bassline | |
g r T | |
| imteeral dres
~ HIAE | 2
| | 2|
Mao/Min Area
" Al Ares Al |
ki 2|
Average Frea
@ Al Area 4l L]
—3 3

Calculation range All ranges

[ Plate in and loading

18
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Camera auto sensitivity adjustment ]

Auto sensitivity adjustment is executed and the message box appears for confirmation.

Gheck Sensitivity

Filter Setting
Ex340/EmGdn | Ex380/EmG40 |
Senzitivity
5 4 j
[0]:4 | Cancel |

Change sensitivity

Confirm the sensitivity level

\ 4
Data acquisition starting

Tlf}e following is shown during data acquisition.

All well graph

_ Remark graph

| Raw image

Time flow

19
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A\ 4
[ Data acquisition finishing ]

\ 4
Measurement data display

When data acquisition finishes, the result is shown as bellow.

Data Conrol [ checketmel 1

Sarolie wo00msnei/ml | | i
Sekct el ’?!g M eos

st Gt g 'ﬂ‘ seTe g
¥ EBES L] e

Poeh
[p—— )

= formation @ Rt EJ ﬂ E

oM

A\ 4
[ Plate out ] [ Data auto output (TextOut) ]

\ 4
[ Measurement finishing ]

20
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5) Loading data file

Plate data (New FDSS format) can be loaded with ‘Open Plate Data’ command in File
menu.

Click Open Data in toolbar.

Eile  Protocol  Wiew &

=

Qpen Data Protocal

I

Click ‘Open Data’

\
Choose a file to open and then click ‘OK’.

Assign a folder

#= Open Plate Data [C:¥FDSSDATA¥DAT AL

e 0= T4 15D \ # [ Plate Hame i [ Date & | Plate Comment |~
+ ) DGAMSDK tept0E1108061 2008/11/08 1811
+-3) Documents and Ssttings 1021108050 2008/11/09 1515
~ ) FDSSDATA =511 03049 200841108 1513
21057105048 2008/11/08 1510 Choose a file
() BITMAP 510271109047 2008/11/09 1507
+-03) DATA <t051109046 2008/11/09 1505
) RAWTEXT =511 03045 200841108 1502
= TET 21087108044 2008/171/08 1459
St021109043 2008/11/09 1457
-2 HPK 1081108042 200811 /08 1454
1) MAGE <t051108041 2008/11/08 1452
+) My nstallstions 24087108040 2009/11/00 14:47
= MewData <t0271109039 2008/11/09 14:45
p Fil <t021109038 2008/11/09 1410
QD Proeram Files <t051103037 2008/11/08 1408
1) RAWTERT 24087108036 2008/11/08 1405
() RayGatcher Data <t0271109035 2008/11 /08 14:02
() SHADING <t057109034 2008/11/09 1400
5.5 Source =511 03033 2008./11/08 1347
24087108032 2008/171/08 1354
-3 SUFPORT =t0271109031 2008/11/09 1351
N Th J || fEsmeiice030 2008./411/09 1349 v
< ¥ = >
‘ Gancel ‘
\ 4

[ Loading data ]
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6) Dispensing head / tip / ligand plate exchanging

(6-1) In the case of FDSS7000EX
In order to exchange dispensing head / tip or ligand plate before / after measurement, the
procedure is taken from Dispenser Control box.

Choose ‘Change Tip&Ligand Plate’ button in the Dispenser Control Box

Dispenser Gontro |

Assay Plate i o

THI+Stage | THi+5tage2 | TH1+Stages | TH1+Loader |

Dispense Start Hozzle Wash ‘ Detail

Volume Wul o |

— Change Tip
Multiwash [ Off Setup| [ after mescurement &ngand Plate button

In the case of exchange head and Tip. Choose ‘Exchange the tip and the head'.
In the case of exchange Ligand plate. Choose ‘Open the door’.

Change Tip & Ligand Plate

Flease select it from the following two.

{ The door is opend (Access Ligand Stage) |

The tip and the head are exchanged |

Cancel

[ Head and Tip and Ligand plate can be exchanged ] [ Ligand plate can be exchanged ]

v \ 4

Place the 1) Head, 2) Tip used Exchange Ligand plate and then
Choose the combination between ‘Head’ and ‘Tip’ used,§| click OK button
and then click ‘Set Tip & Head’ button

P — ... — Choose the
combination between
Head and Tip

!! You can acoess Ligand Stage.
Please push the O button after & complstes &,

. SetTip&Head
button

22
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[ The door closes. ]

\ 4 A\ 4

After door of dispenser close, the following box appears.

! 3 Dispenser

[100] Please push <Preparation:= button that exists in the operation panel of the dispenser,

‘OK’ button

(=

Click ‘OK’ button after push ‘Preparation button’ of front panel of dispenser.

‘Preparation’ button

(It is not displayed according to the system, and Preparation is done by the
automatic operation. )

[ Door is closed and then exchanged Head and tip is set ]

v \ 4

[ Dispensing tip/Ligand plate exchanging is completed ]

HAMAMATSU PHOTONICS KK
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(6-2) In the case of uCELL

In order to exchange dispensing head or ligand plate before / after measurement, the
procedure is taken from Dispenser Control box.

In the case of exchange head, Choose ‘Change Head’ button.
In the case of exchange Ligand plate. Choose ‘Access Ligand No.X’ button.

—  Change Head button

—

Choose the tab in stages to exchanged

Access Ligand No.X button

[ Head can be exchanged

\ 4

] [ Ligand plate can be exchanged ]

\ 4

head’ button

Select Head Mode

Place the Head used
Choose the ‘Head Mode’ used, and then click ‘Set the

a <#> No Head

<B> Head 1

Head]

o

J

L Choose the
Head Mode

L Set the head button

Exchange Ligand plate and then
click OK button

! ! Y Casn aCcess Ligand Stage.
Flease push the Ok button after & completes k.

[ Dispensing tip/Ligand plate exchanging is completed ]

HAMAMATSU PHOTONICS KK
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(6-3) In the case of FDSS3000/6000

In order to exchange dispensing tip or ligand plate before / after measurement, the
procedure is taken from Dispenser Control box.

Choose dispensing head / stage tab in Dispenser Control and then click
‘Change Tip&Ligand Plate’ button.

Dizpenser Gontrol

fzzay Plate J |
2" Headl +5tacetF Hoad 1 +Staee? Feadi+Staes| + ——— Choose tab to exchange.

Dispenze Start Mozzle Wazh Detail.. ‘

Waolume 20 ul ﬂ J j

Azpirate

Speed 50 wifs ﬂ_| ﬂ

Height 05 mm <] | 0
Dizpenze

Speed B0 ulis 4 ﬂ

Height 25mm | | |

Wash Cycles 0 4| [ after meazurement

v Mixine fizzay Plate

Change Tip & Ligand Plate
[ Auto Cell Tank

S

___ Change Tip & Ligand Plate.

Chosen dispensing head and round table moves to door place and the tip
or ligand plate can be exchanged.

The following message appears. After exchanging tip or ligand plate,
click ‘OK’ button.

FDSS 300046000

The nozezle was moved to the exchange position,

Please push CF button after exchanging nozzles,

!

[ The door is closed and dispensing head and round table returns to the initial position. ]

25
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7) Data display with correction

FDSS can calculate correction data for raw data and show the graph with corrected data.
Correction data can be set at assay protocol setting.

I@ Beforehand correction data is taken and registered. Refer to next page.

Click Protocol in toolbar.

¥l FDSST000EX/uGELL <Lu

Eile  Protocol  Wiew Setup He
= [[] |—m— Choose Protocol

Cpen Dat Protocol Manua

Assay protocol setting box appears. Choose Corr. tab and enable correction
parameter ‘Auto Fluorescence’ and ‘Shading’.

E | |
Assay Pratacol File Load.. Save.. .
ssay Flate
File Name [ [ Titial + /N Setup | os ‘
Interval (s} K| M w0 sew | THI +5tage! | Thi+Stane | TH1+Staeed | THi+Loader |
Tatal Samples B Dl o1 ‘ Dispense Start Nozzle Wiash | Detail |
Total Sampling Timeth:mis.ms} 2000
Select Waveleneth Volume Wu 4| |
Setup. 2Ex1Em or 2Ex2Em [ Ex4B0:EmB4D / ExdBlEmE40 1 Aspirate
Speed | B0 ulfs 4 |
o S Mol E
sl s«::: NZz b 2 Height a5 mm o | ol
 Stage Moz ‘| 5
o Dispense
Speed | 50 ulfs 4 -
Output| Prepa.| Sens. | Graph| Proc. | Gale:Param | Heiht [ z5mm 4| | 5
Correction Type Filename: Multi Wash Off Setup | [™ after measurement
[V #uto Fluorescencs Greinerd4Exph PAF ] [7 Mizing Assay Plats
¥ Shadine Greinerded PSD I~ Wipe e ——
Choose Corr. tab
Enable AutoFluorescence
and Shading

START < Sinele > START < futo > Close ‘

* No ‘Auto Fluorescence’ in luminescence measurement.

A\ 4

[ Correction is set. ]
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8) Correction data creation

(8-1)At fluorescence measurement

[ Auto fluorescence correction data creation ]

y

Shading correction data making with auto fluorescence correction data

m Auto fluorescence correction is used only for fluorescence measurement

Correction data can be obtained by the following equations:

<Autofluorescence correction data>
= Fluorescent intensity — Dark signal

< Shading correction data >
= Fluorescent intensity — Dark signal — Autofluorescence correction data

< Experiment data
(after running autofluorescence correction and shading correction >
= (Fluorescent intensity — Autofluorescence correction data — Dark signal)
x Shading correction coefficient

< Shading correction coefficient >
= Average value of shading correction data / Shading correction data for target well

27
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(8-2) At luminescence [Photon Counting] measurement

[ Shading correction data creation ]

Correction data can be obtained by the following equations:

<Shading correction data>
= Photon Counting value

<Experiment data (after running shading correction>
= Photon Counting value x Shading correction coefficient

<Shading correction coefficient>

= Average value of shading correction data /
Shading correction data for target well

(8-3) At luminescence [Analog][EMCCD] measurement

[ Dark correction data creation ]

A 4
[ Shading correction data creation ]

Dark correction is used for only luminescence measurement [Analog][EMCCD]

Correction data can be obtained by the following equations:,

<Dark correction data (Luminescence [Analog][EMCCD] measurement>
= Luminance — Camera offset

<Shading correction data>
= Luminance — Camera offset — Dark correction data

<Experiment data
(after running Dark current correction and shading correction>
= (Luminance — Camera offset — Dark correction data) x
Shading correction coefficient

<Shading correction coefficient>
= Average value of shading correction data /
Shading correction data for target well

28
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9) Auto fluorescence correction data(at fluorescence)
| Dark correction data(at luminescence[Analog][EMCCD]) creation

<Sample for auto fluorescence correction data>
The sample for auto fluorescence (dark) correction should be ideally prepared with the
actual measurement condition. It needs to prepare the same plate, filter and buffer

quantity/type.
Choose Auto Fluorescence/Dark command in Setup menu.
P FDSSID00EX/UGELL <Fura? [384wells]

File  Protocol  Wiew Help

Supervizor Pazzword

Open Data Protoct

[ Set sample plate for correction

Microplste Mappine. Auto Fluorescence / Dark

Auto Fluorezcence..

) ,,

A

<In the case of FDSS3000/6000/7000EX>

<In the case of uCELL>

Sample plate for correction loaded in.

Sample plate for correction loaded in.
Set the plate onto the stacker and click
Load button in Dispenser Control box.

Dispenser Gontrol

Load button

Click Access button in Dispenser Control box
and set sample plate.

Digpenser, Control

Access button

Access

TH1+StaeeT | TH1+Stage2 | THI+Stagel | THI+5tage2 |

fzzay Plate fizsay Plate

THi#Stage1 | THi+Stae2| THI+Staged | TH+Laader |

Digpenze Start | Mozzle Wash | Detail.. ‘ ”

Nozzle Wash

| Dispense Start

| '
Check auto fluorescence image of the sample plate
Set Sensitivity Max in Camera Control box. Click ‘Pre Acquire’ button in Setup

Auto Fluorescence Data box and get image data.

- -
Live
[EerE|
. . +—— Set sensitivity max
=)

Setup AutoFluorescence Data

futo Fluorezcence File Greinerdx4Exp0.PAF
Format
@ Howellss (s
_ Click ‘Pre Acquire’ to check an image.
Pre fcquire J
Dizplay Current Data | —————— Cancel
Import Data

29
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)

The following box appears after getting an image. Check whether it has unnecessary
bright spot by dust. If it has, load the plate out and remove the dusts. And then try it
again. If not, click Acquire Data button in Setup Auto Fluorescence(Dark) Data box.

Setup AutoFluorescence Data

Auta Fluorescence File Gireinerd::4 Exp0. PAF

Format

* G6wells 0

’—[—h— Click ‘Acquire Data’.
i Pre Acquire Acquire Data

Digplay Cutrent Data Import Data | Cancel ‘
[ Acquiring correction data. ]
\ 4
The following box appears after acquiring correction data. Click ‘Save’ and register
the data. It is registered automatically.
Setup AutoFlucrescence Dats
Puto Fluorescence File Greinerdxd Expl PAF
Farmat
« QGwells O (ol
Pre Acquire | Acquire Data Save CliCk ‘Save, tO register.
Export Data _— ‘
Iniport Data | =
Display Sensitivity
i R[] o
Whell No. | Fx840Em540 E‘xmmzmsm ~
A1 ,e% 000 000 '.‘
B 0% b :
Yy o Display the result
L 000 000 5
A7 000 000
Ag 000 000
A9 000 000
Ao 000 000
A1 000 000
M2 000 000
Bl 000 000
B2 000 000
B3 000 000
B4 000 000
BS 000 000
B 000 000
B7 000 000
Ba 000 000
BI 000 000
10 000 000
| i &
Pl o | Ex340Em540 [ ExasoEmsan o
Fvegaee 000 o
Max ®, 000 000
Miz e .u-u.u. u.u-u- et
‘ A\ 4
<In the case of FDSS3000/6000/7000EX> <In the case of uCELL>
Sample plate loaded out Sample plate loaded out
Click Unload button in Dispenser Control box. Click Unload button in Dispenser Control box

Dispenser. Control

Aszsay Plate { IUnload |
TH1#Stags] | THT Stazez | THTStaged] THI +Loader |

| Dispense Start | Nozzle Wash | Detail.. | ”

and take out sample plate.

Unload button Dispenser Gontrol

fssay Plate %
TH1+Stagel | THI+Staee? | TH1+Staget | THI+Stace? |

Access button

v v

[ Finish ]

30
HAMAMATSU PHOTONICS KK



FDSS7000EX/uCELL Software Instruction Manual Ver.2.9.5 72360301-05

10) Shading correction data creation

The sample data that has homogeneous fluorescence can be used to correct nonuniformity
on hardware and optics.

<Sample for shading correction data>
The sample for shading correction should be ideally prepared with the actual

measurement condition. It needs to prepare the same plate, filter and buffer
quantity/type.

Click Shading command in Setup menu.

P EDSS7000EX/uGELL <Fura? [384wells]

File  Protocol  Wiew Help

= []

Dpen Data Protocs

Supervizor Paszword

Microplate Mapping..

F DS w Auto Fluorescence.. 4 Shadlng button

Azzaw Pratnrnl Fils

[ Set the sample for shading correction. ]

A 4

v

<In the case of FDSS3000/6000/7000EX>

Sample plate for correction loaded in.
Set the plate onto the stacker and click
Load button in Dispenser Control box.

Digpenser Gontrol

Load button

fizzay Plate

THi+Staee | THi+Staze2 | THi+Stage3 | THI+Loader |

| Dispense Start Mozzle Wash ‘ Detail.. | ”

<In the case of uCELL>

Sample plate for correction loaded in.
Click Access button in Dispenser Control box
and set sample plate.

Dispenser Gontrol

Access button

4
Access l‘

THi+Stagel | THi+Stage2| THi+Stage1 | THi+Stee=2]

Aczay Plate

Nozzle Wash

| Dizpense Start
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<At fluorescence measurement and luminescence[Analog][EMCCD] measurement>
To check shading image of the sample plate. Set Sensitivity a certain value in
Camera Control box. Click ‘Pre Acquire’ button in Setup Shading Data box to
acquire image data.

F 3

Live

Live On Live Off
Live Image Window..

Set Sensitivity

1 5 10

[t o

Setup Shadine Data

Shading File Greinerdxd PSD

Farmat
* Pomels © =

. . Click ‘Pre Acquire’ to acquire
Pre Acquire -
[:Ju | | fluorescence image.

Display Current Data

Cancel

Import Data |

<At luminescence [Photon Counting] measurement>
To acquire shading image of the sample plate. Click ‘Acquire Start’ in Setup
Shading Data box to start acquiring photon counting image data. Integration images
are observed then.

Setup Shading Data

Shading File Greinerlx1.PSD

Format
S =

Acquire Start

Dizplay Gurrent Data

,‘ ‘ Click ‘Acquire Start’ to start acquire
BLY | photon counting image data.

Import Data ‘

<Fluorescence measurement>
Acquiring fluorescence image for checking
<Luminescence [Analog] [EMCCD]measurement>
Acquiring luminescence image for checking
<Luminescence [Photon Counting] measurement>
Acquiring Photon Counting image

HAMAMATSU PHOTONICS KK
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l

<At fluorescence measurement and luminescence[Analog][EMCCD] measurement>
To Check after getting an image whether it has unnecessary bright spots by dusts or
not. If it has, load plate out and remove dusts. And then try again. If not, click
Acquire Data.

Setup Shading Data

Shading File Greinerdxd PSD
Format
@ 96wells i

‘ Pre Acquire

[ Acquire Data I]—’— click ‘Acquire data,.

GCancel ‘

Display Current Data

Import Data |

<At luminescence [Photon Counting] measurement >
Click ‘Acquire Stop&Calc.’ to stop acquisition and to create shading data when total
image is homogeneous and doesn’t have unnecessary bright spots.

Setup Shading Data

Shading File Greiner1x1.PSD

Format

o QGwells r

| Biquire Stopatale Click ‘Acquire Stop&CaIc.’.
e |

HAMAMATSU PHOTONICS KK
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l

A

the data. It is registered automatically.

Setup Shading Data

<Fluorescence measurement>
<Luminescence[Photon Countinglmeasurement>

The following box appears after acquiring correction data. Click ‘Save’ and register

Shading File Greinerdxd PSD Shading Fils Muncixls, $~PSD
Format Format
= o ~ = ¢ ) - @& 3Bdwells
Bl '3 Click ‘Save’ to register.
Fim o | = o 1 5 Pre Acquie ‘[ J ]
ve fcquire ||| Acquirs Data | [ Save ] iee s
: j Sensitivity changes Y
M Display Current Data ‘ Close
Cancel Impork Data:
| Inport Data | hange Sersiiviy
ettt Tte., Acquisition D ate
Wiell No_ [ EMIEm540 | Ex380En0 [~ 1 4 | 2007/07/16 1255
Al 000 0o .
42 oo 0oo WellNo. | Lumingseat®®*®®e e, ~
3 00 0 o . = A
Mo 000 -, Display the result ]
:2- 00 0o . f—af
A .
000 0 3 27 i
o ilii} il . 0 o
3 ilii} il e ooz
3 ilii} o ar 0.08
AT0 i} 0o “6 018
ATl 00 0 53 0.26
H 00 0o 10 039
B1 00 0o 2l oo
B2 000 0
B3 ilii} il 413 0.43
B4 [ilin} 000 o1 o=
B5 ilii} o o e
B8 i} 0o o A%
g7 00 0 o e
8 00 0o 19 00s
ooa 000 420 0.28
B, 000 0 52 012
BI ilii} il 2 045
R19% nnn nnn ™ &35 0.33 4
Vel Hs, | ExB40EmB40 | Ex330.EmB40 [ Lo, %
fverage o D00 000 el e, | Luminescence )
lax ooo Average ®e .26
Mix 0ir., 000 . Max ﬁ.-w_ .
............. Min 000 ee,y yreans®’

<Luminescence[Analog][EMCCD]Jmeasurement>

Setup Shading Data

Fluorescence/Luminescence [Photon
Counting] measurement

The relation is not in sensitivity,

and common correction data is used.

Luminescence[Analog][EMCCD] measurement
It has the correction data of each sensitivity.
Sensitivity is changed and all the sensitivity
correction data is acquired.

\4

A\ 4

<In the case of FDSS3000/6000/7000EX>

Sample plate loaded out
Click Unload button in Dispenser Control box.

Dispenser. Control

Azzay Plate

Unload button

Unload

TH1#Stags] | THT Stazez | THTStaged] THI +Loader |

| Dispense Start | Nozzle Wash | Detail.. | ”

<In the case of uCELL>

Sample plate loaded out
Click Unload button in Dispenser Control box
and take out sample plate.

Dispenser Gontrol

fooess

THI+Stage] | THi+Staee2 | THi+Stagel | THI*Stasez |

Access button

Bzsay Plate

!

[ Finish

J
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3. How to operate FDSS software

1) Starting the software
Start up the program as outlined below.

1) Check each cable connection.
2) Turn on the excitation light source (at fluorescence)

Noise usually generates at the instant that the light source is turned on or off.
Make a habit to first turn on the light source before turning on other peripheral
units, and last turn off the light source after turning off other units. It will take
time for the light source to become stabilized. So turn on the light source about
30 minutes before beginning experiments.

3) Turn on the peripheral equipment other than the excitation light source.

4) Start up the FDSS software. Double-click FDSS icon or choose Program =>
HAMAMATSU => FDSS from start menu.

When starting the FDSS software and in the case the anti-virus software is
installed, there will be possibility that the time of acquiring data takes longer than
the set-up time. In the case, set the monitoring function of anti-virus software off or
other set-up which might cause longer time acquisition off.

And since starting screen saver function and set-up of the electric power saving
during the measurement might cause problem, set these function off ( during the
measurement. )
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2) Measurement method choice

When the FDSS software starts up, the following dialog box appears for selecting the
measurement method, plate format and camera exposure time.

Select Method

Method Type Microplate Format
T Tl = | Choose microplate format.

LumitPhotonGaunting?

Lumi{fnalog}
Oftline

Camera Exposure . ‘ ,
ol e = Choose exposure time, ‘short,
‘normal’ or ‘long’.

Choose measurement method

J

< Method Type> Choice of measurement method
Fura2 : Fura2 (2 wavelength excitation) fluorescence measurement

Fluo3 : Fluo3 (1 wavelength excitation) fluorescence measurement
Lumi[Photon Counting]: Photon counting luminescence measurement
Lumi[Analog] : Analog luminescence measurement

Lumi[EMCCD] : Analog luminescence measurement by EMCCD camera

< Microplate Format> Choice of microplate format

96wells : 96 well format plate usage
384wells : 384 well format plate usage
1536wells : 1536 well format plate usage

<Camera Expo.> Choice of camera exposure time

Normal Expo. : Standard exposure time
Long Expo. : Long exposure time used when the sample image is too much dark
Short Expo. : Short exposure time used when the sample image is too much bright.

@ The measurement method list depends on the system configuration.
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Combination between dispensing head and ti

(FDSS7000EX)

At FDSS7000EX, after selecting how to measurement and then clicking OK button ( as
described pre-page.) if dispensing unit keep the head and tip installed, after the head and tip
was installed, the door of FDSS7000EX is opened.

When the door is opened, such box as follows is displayed.

Ghange Tip & Head Gombination

Select Tip & Head Combination Mode

<C>—2-Tip + 2 Head i Choose
~

<Az Mo Tip + Mo Head <B> 1 Tip+1 Head
Headl
| | X
T and tio
Tipl
e >
(5te Format N Tip & Head are used as follows N1
TH Mo Gombination TH Mo2 Gombination
384w | [ and tip
)L [ mm

[ Set Tip & Head (The mode is chaneed)

]

Select the applied mode of head

Tip&Head are used as follows:
The combination between head

Plate Format:
Selected plate format

Set Tip&Head:
Tip&Head is installed as selected

Tip&Head Combination

Exchange of the dispensing unit and tip or ligand plate is performed.
In the above box, select the combination between head and tip used and then click the Set

tip & Head button.

After that, the door of FDSS7000EX is closed and then the head and tip are loaded as being

set.

For details, Please refer to Chapter 12 4) As for exchange of dispensing head&tip and ligand

plate.
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4) Combination between dispensing head (uCELL

At uCELL, after selecting how to measurement and then clicking OK button ( as described
pre-page.) if dispensing unit keep the head installed, after the head was uninstalled, such

box as follows is displayed.

Ghanee the dispenser head
)

Select Head Mode

| —————— Choose Head Mode:
Select the applied mode of head

Plate Format:

Set the head (The mode iz chaneed?

Selected plate format
Set the head:

Head is installed as selected

Exchange of the dispensing head is performed.
In the above box, select the combination between head used and then click the Set the head

button.

For details, Please refer to Chapter 12 6) As for exchange of dispensing head and ligand

plate.
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5) Main Window

After selecting the way of measurement and then clicking ‘OK’ button as described at 2), or
after clicking ‘Set Tip&Head’ button as described at 3), the window as follows is displayed.
The main window starts up with the assay protocol setting box. The operation mode and
commands can be set with Toolbar or menu command.

<Main Window>

3

(1) Menu : To choose the menu such as File and Setup and to
execute each command from the menu.

(2) Operation mode : To choose the operation mode such as the data opening,
protocol setting and manual control.

(3) Plate select bar : To set the plate type to be used at the measurement.
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6) Running a command

This section explains brief description of each menu. For more details on how to run use
menu, refer to the corresponding chapter.

¥ FDSSTO00EX/uGELL <Lumi{PhotonCou
Eile Protocol Wiew Setup Help

(1) File : Used to load recorded measurement data as necessary. And the
graphs can be printed out and data can also be saved as text format.

(2) Protocol : Used to set parameters for data acquisition and create various types of
correction data.

(3) View : Used this menu to switch display for tool bar and status bar.

(4) Setup  : Used this menu to get correction data, to set data folders and to make
setting file. Supervisor password is needed for this menu.

(5) Help : It shows software version information.

Running a command

Each command can be run in the main window that is displayed as shown below.
Clicking the menu name opens the command list and then clicking command name make
it running.

P FDSST000EX/UCELL <Fura? [384wells

Er' otoco |

M FDSS70D00EX/UGELL <Fura2? [384wells
Protocol

Setup & Acquire <Mew Protocols.. .
Setup & Aoquire <Last Protocaols . == ODE.

Start External Contral.. b Start External Contral. e

Miew  Setup  Help

Wiew Setup Help

Setup & F'ucquire-<New Protocals...
Setup & Acquire <Last Protocol:.

Ope

40
HAMAMATSU PHOTONICS KK



FDSS7000EX/uCELL Software Instruction Manual Ver.2.9.5 72360301-05

7) Toolbar

The frequently used functions can be chosen by clicking the icons.

Frequently used functions

= [ o

Open Data Protocol Mariual Ctrl
(1) (2) (3)

(1) Open Data : Loading data

(2) Protocol : Setting assay protocol and start measurement

(3) Manual Ctrl : Display Camera Control Box, Filter Control Box and Dispenser
Control Box.

(7-1) Open Data

‘Open Plate Data’ box appears and the plate data can be chosen for loading. It is the
same as to choose ‘Open Plate Data’ command from File menu.

<Open Data>

= ] fet) Assay Flate Ligand Plate No1 [NONG PP ~]  Ligand Plat
Open Data Protocol Manual Ctr|
Live Filter
gy Plate Unisad
Open, Plate Data DSSDATA¥DATA tagel | Wi +5taze2 | THI
W e 0=l 7420 ©) A~ |[Flate Name_=& [Date = [ Flate Comment__|~
() DCAMSDE test0E1108061 2008711708 1811 Dispense Star Hozz
Sedeitill | # ) Documents and Settings 1est081108050 2008/11/08 15185 1)
= () FDSSDATA test081108049 2008/11/08 1613 |
testDE1108048 2008/11/08 1610 Vome [ [T ul
[ D BrrmAp 1est081108047 2008/11/08 1507 =
# 3 DATA test081108046 2008/11/08 1608 Aspirate
RAWTEXT test01108045 2008/11,/08 1502 Speed 50 P
Ca g pidiat test0a1108044 2001708 1450 oeed [ [ uiie
test081108043 2008/11/08 1457 Height 05 mm <
Exp. T | F B HPK {est081108042 2008/11/08 1454 =
) MAGE testD1 08041 2008/11/08 1452 5
o #2) My Installations 1e5t081108040 2008/11/08 14:47 e
P ULV N | 5oecs [ (50w ¢
test 138 2008, 81410 |
1est081108037 2008/11/08 1408 Height ’_‘ 20 mm 4
test081108036 2008/11/08 14086 !
testD81108035 2008/11/08 1402 —
) SHADING 1est031108034 200811708 1400 ult Wesh [ OR Se
&3 Source 1est081108033 ZDDE;H;DE 1387
test081108032 2008/11/08 1354 A Pl
) SUPRORT test0S102081 2008/11/08 1351 s
oTA || test081108030 2008/11/08 1348
< bY test081108029 2008/11/08 11:39 o
| [ S /
N

(1) Open Plate Data box : To choose the Plate Data for loading.
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(7-2) Protocol
Assay protocol setting box appears and the protocol for the measurement can be set in it.
It is the same as to choose Setup&Acquire command from Protocol menu.

<Protocol>

<1 Usond Plate to2 [NONG P =] Usond Plat o [NONG PP =l
Dispense.
Speed [ S0 /s 4|
Heieht [~ 25 nm «| |
Wash Oyoles [0 <[] o

(1) FDSS Application box

: To set the assay protocol. The measurement starts with the box.
(2) Dispenser Control box

: To set the parameter of the dispensing on the assay protocol.

(7-3) Manual Control

Manual Control boxes appear and the devices can be controlled manually with them.

<Manual Control>

{EIFDS53000/6000 <Offline [6mels] >

Eile Datahcquisiton View Setp Help

B | e tasay Plate. NG ot

=] Lisand Plate No [NONG PP ] Liand Plate No2 [NUNG PP R L R T —

3

Dispense.
Speed Tuss 4
Heignt [ 00 mm o

W Gt 5 4[| I~ fter mosseament

J

(1) Camera Control box

: To control the camera manually. It can control High Voltage (HV) as well.
(2) Filter Control box (At the fluorescence measurement)

: To control the shutter, excitation and fluorescence wavelength manually.
(3) Dispenser Control box

: To control the dispensing system manually.
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8) Plate choice

To choose an assay plate type and ligand plate type to be used at measurement from the
registered plate information selection in Plate Selectbar. It leads parameters to be
automatically set here such as ROI (Region Of Interest), correction data and  dispensing
initial position according to the chosen plate.

<Assay plate setting>

[ Azzay Plate |[NUNG OpticalBottom jli 1)
2)
<L[igand plate> |

fissay Plate ‘NUNCOptica\Eottom j Ligand Plate Mo ‘NUNOPP j Ligand Plate No? ‘NUNCFP j Ligand Plate Noft INUNG PP » | Ligand Plete Loaer {NUNC PP ']

1) Assay Plate
: To choose a plate to be used for measurement. It automatically sets
ROI, correction data file, dispensing initial position and luminescence
sensor position.

2) Ligand Plate No.1,2,3,Ligand Plate Loader
: To choose a ligand plate to be used for measurement. It automatically
sets aspirating initial position. No1, 2, 3 corresponds to Stage1, 2, 3
respectably at ‘Dispenser Control’.
Ligand Plate Loader corresponds to the plate of the ligand loader line.

This plate choice setting is linked with Assay Protocol.
(This is loaded/saved with AssayProtocol. )
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9) Quitting software

To quit the program, follow the procedure below.

(1) Select “Exit” from the File menu. Or, double-click the left top of the main window.

P FDSST0DDEX/uGELL <LumilP
28 Protocol  Wiew Setup  Help

Qpen .Plate Data.. |

Print Cut 3 |

Save by Bitmap [
Dizplay Graph in Mew Window »
Copy Graph to Clipboard 3

(2) The main unit loads a plate out if it is set inside and then finish its behavior. Click ‘OK’,
when the following message appears after finishing.

Choose ‘Exit’ command

FDSS7000/uGELL g|

The assav and the ligand plates were taken oot outside,
Please push O.K. button after taking out plates,

See you nexk,

L Click OK button

(3) If head and tip is loaded, after unloading them the door is opened.
Message as below is displayed. After unloading head and tip, click ‘OK button’
(FDSS7000)

FD55 Dispenser

! E Pleaze take out the head and the tip.

Click OK button

(4) FDSS software closes and then quite Windows.
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4. Protocol Menu

This menu is used to acquire data and to set an assay protocol for data acquisition. When you
choose Protocol menu, the command list appears as bellow.

¥ FDSS7000EX/UGELL <Fura2 [384welld

Sl Wiew  Setup Help

Setup & Acguire <Mew Protocol:.
Setup & Acquire <Last Protocols.

d=zza
Dpe

Start External Control.. It

Setup & Acquire<New Protocol>

: This command displays an assay protocol setting box by an initial value.
Protocol can be set and data acquisition can be started in this box.

Setup & Acquire<Last Protocol>

: This command displays an assay protocol setting box by the last value.
Protocol can be set and data acquisition can be started in this box.

Start External Control
: This command starts the external control mode. (Optional Function)
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1) Assay protocol setting (Setup & Acquire command)

The following box appears with clicking ‘Setup & Acquire’ command. The protocol can be
set and data acquisition can start in this box.

FD5S5 Application

1) — . = 6
( ) \ﬁssay Protocol File [ ]: Load. 1} Save.. I] THifsest | 7 .|mu:m|f- ( )
(2) —tFwerm I [ initial+ S/H__Setg ) | o |

Interval (&) Al | 200 Setwp | > >
(3) T Totel Samples Kl M
Total Sampling Timebrme.ms) 2000
Joct
(4) —[ 2Ex1Em or 2Ex2Em [ Ex480:Em540 / Ex480:Em540 ] ]
=
15 E No. | ; P

5 —ilrann: J . J

G e sellins

Outper™Frepa | Sens. | Graph | Proc. | Cale.Param | frea | 1
/F\utn Output Method

v Text Out{Raw> | Text Out<Plate> [™ Print Graph [~
(7) Raw Data & Print Graph Selection

¥ Ratio [~ Ex460EmB40 [ [~ Integral [~ with SepFile
Plate Format Data Selection -
Hit Wells ™ Hit I with Av/5.0.
Ratio W Iteg [ Max [ Mn [ Av. [ Maxhin
Ex480:Em540 [ integ [~ Max [~ Min [ Av. [T Max=Min [ Rat Max
Ex480:Em540 ¥ i = H i 1=
Raw Data & Plate Format Data <Footer>
™ Assay Protocol

Filename <TextOuty
@ Each Plate File " Add to a file
START ¢ Sinle > I [ START € fute > ]‘ ( Close ]
1|

—) — (9 — (10

(1) Assay Protocol File : To save and load an assay protocol.

(2) File Name : To name the measurement data.

(3) Measurement time : To set a sampling interval and total samples.
(4) Select Wavelength : To set wavelength for measurement

(5) Dispense Timing : To set dispensing timing.

(6) Dispenser Control : To set dispensing parameter at each stage.

(7) Setting Tab : To set correction, calculation, output and so on.

(8) START <Single> : To start single measurement with only one plate.

(9) START <Auto> : To start sequential measurement with plural plates.
(10) Close : To finish an assay protocol setting and close the box.
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(1-1) Assay Protocol File
Used to save and load an assay protocol. Clicking ‘Open’ and ‘Save’ displays the loading
box and saving box respectably. The file format is ‘assay protocol file (*.PFA).

fzzay Protocol File [| testPFA ] Load.. I Save..

File name is displayed.
(1) Load : Toload an assay protocol file.
(2) Save : To save an assay protocol file.

(1-2) File Name

Used to set how to name the measurement data file.

File Mame ( ) (Chnitial+ &/ (78t
\_ File name is displayed. \_ Naming method is displayed.
Setup : To set the auto plate naming function. (Refer to 1-2-1)
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(1-2-1) Auto plate-naming function
Clicking ‘Setup’ leads a setting box ‘Setup Plate name’ for auto plate-naming function.

Setup File Hame

Automatic File Mame
* On (futamatic) " Off{ Manual) 1 Cancel I (1 )

Automatic Parameter B de-Cipt

I~ Fefiected in a Fiie ame: (3)

Method Serial Mum. (Count up) :l' [ zame name is permitted
Thitial Name [v Reflected in a Comment
Plate Read : rwien b (7)
: 1 2 barcode is written
2) e st
Qigit of Serial number 3 h " Front Loader )
— (5)
Data Ealder E——
Y e e [C¥FDSSDATARDATAR Browse\*
Text Data (Table :Plate Format) |O:¥FDSSDP|TP|¥TE}(T¥ Browse | [I— “ 1. THT" iz added ]
Text Data (Raw : Data Array) |C:¥FDSSDP.TP.¥RP.W'I'E}(T¥ Erowse ‘\_ (6)
\Elitmap Data {Screen Image) |D:¥FDSSDHTH¥BI’I’MHP¥ Browse) (4)

(1) Automatic File Name
Automatic Plate Name
: Choose the automatic naming function, On, or manual naming at each
measurement, Off, at single measurement. Auto naming function is
aromatically applied at sequential measurement with plural plates.
(2) Automatic Parameter
Method : Choose the plate-naming method from the following options.

Serial Number = Named with auto count up as Serial Number (S/N).
Initial count number is set at ‘Serial number’.

Initial + S/N = Named with combination of Initial Name and S/N.

Initial + Date + SIN =Named with combination of Initial Name,Date and S/N.

Date + S/N = Named with combination of Date(yymmdd) and S/N

Barcode = Named with the read barcode data (Option)

Initial Name : To set header characters when ‘Initial+S/N’ method is chosen.
Serial number : To set initial numbers for auto count up.
Digit of Serial number: To set digit numbers at auto count up.
(3) Barcode Reader (Option)
Reflected in a File Name
: When checked, the barcode data reflects onto File Name.
Reflected in a Comment
: When checked, the barcode data reflects onto Comment field.
Plate Read
: Choose which barcode is employed from an assay plate or ligand plate
(4) Data Folder
Plate Data
: To specify the data folder for Plate Data
Text Data (Table: Plate Format)
: To specify the data folder for Text Data with a plate format.
Text Data (Raw: Data Array)
: To specify the data folder for Text Data with a data array format.
Bitmap Data (Screen Image)
: To specify the data folder for Bitmap Image.
(5) Saved in Date Folder
: The date subfolder is made and the plate data is saved.
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(6) “_1.TXT”is added <Please refer to 2-1 in Chapter 6>
:“ 1.TXT” is put on the end of the file name of the No.1 data.
(7) 2barcode is written in a comment
: The barcode data of front and back is reflected in the comment.

(1-3) Measurement time

Used to set a sampling interval and choose the single or double interval. Two different
sampling intervals can be set as one part of the protocol and then be switched during
measurement accordingly with Double interval function.

(1) —[Interval (=) 1 ] ] L] | E.EI][ Setup ].I—- (4)
(2) —ﬂ'c:tal Samples L] _] L] ] E'IJ

(3) —ﬂ'c:tal Sampling Time s | EI:EIE:EIEI]

(1) Interval (s) : To set a sampling interval between data points.

(2) Total Samples : To set the total sampling number.

(3) Total sampling Time (h:m:s): To display the total measurement time.

(4) Setup : To set the double interval (Refer to 1-3-1).

(1-3-1) Double Interval
Clicking ‘Setup’ in Interval leads a setting box ‘Setup Double Interval’ for double
interval setting.

Setup Double Interval

Select Double
(1) _'[ " Sinele + Double ] %
2 (~ Interval =F
( ) 1st/3rd/5th Interval l—mﬂ_| j]
\__ 2nd/4th Interval [ 80 « | v
(3) —'(Samplmg Number ]
Total Samples l—mﬂJ ﬂ
\__Tatal Samplicg Timatcmems) [ 02090
(4) /Zﬁ;:::al Section Samples Section Time  Total Time#Samp.Mo.
. . liij j’w g 00:0000 (13
;n;’;gz)) 0« | o ®m < 00:080 (10
adsro [ 10 «f | [ mann o ,7,%
ghsen [ 0 «f | ff oos0 < a0 ¢a0 )
Sh/106 [0 «| | )] 00 < 01590 (40}
vth/&ﬂ(s) 7 4 | msE0 < ,%
(1) Select Double : Choose the interval method, single or double.
Single : to acquire data with a certain amount of interval.
Double : to acquire data with switching 2 kinds of sampling
interval at specified timing
(2) Interval : To set a sampling interval.
(3) Sampling Number : To set total sampling number.
(4) Sequence : To set timing for switching 1% interval and 2" interval
at Double Interval.
Interval : To display the set interval.
Section Samples: To set the sampling number by specified interval.
Section Time : To display period of the specified interval
Total Time : To display the total period from measurement starting.
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(1-4) Select Wavelength
Use to set and display filters for measurement. The measurement method cannot be
changed here.

Select Waveleneth

[ Setup.. | (2Ex1Em or 2Ex2Em [ Ex340:EmB40 / Ex300:EmB4n ] |

The measurement method and filters are displayed.
Setup : To set a filter for usage. (Refer to 1-4-1)

(1-4-1) Select Wavelength
Clicking ‘Setup’ leads a setting box ‘Select Wavelength’ for filter setting.

Setup - Select Waveleneth

Methad

(1) | —t i)
Wavelength 1 ‘Wavelength?

[ A E el / |ExoenEmEan - (3)

(1) Method
: To display the chosen measurement method at Select method box. It cannot
be changed here.

(2) Wavelength1
: To choose a filter set for numerator of ratio calculation.

(3) Wavelength2
: To choose a filter set for denominator of ratio calculation. When 1Ex1Em
(one wavelength excitation and one wavelength emission fluorescence
measurement) is set as a measurement method, this cannot be chosen.
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(1-5) Dispense Timing
Use to set dispensing timing with the specified stage.

ovp PJr_Jv_Jr_ @

139 21 (3)
ChgOut IZIEEI Dd?[l 1: 340 2180 324

(1) Stage selection
: Choose one stage from four and then set timing with the specified stage. The
color of characters corresponds to the color of timing arrow bar.

(2) Dispensing timing arrow bar
: Arrows with the colored bars show dispensing timing. And the length of the bar
means mechanical moving period of dispenser, and next dispensing timing
cannot be set among the period.

(3) Dispensing timing frame bar
: The white bar means total measurement time and timing arrow bars are
relatively changed accordingly. Downside number shows a sampling number
and time.

(4) The presence of the Preparation setting is displayed
: When various settings are done in “Prepa.” Tab of the protocol, the display

that shows the presence of the setting is done.

Disp. : Itis displayed that the setting that does “Preparation of Dispenser” is
done.
Incu. : Itis displayed that the setting that does “Pre Incubation” is done.

ChgOut : It is displayed that the setting that does “Change Out” is done.

<How to set dispensing timing>
Choose a stage and then move timing bar or left-click at dispensing setting area.
<How to cancel dispensing timing>
Choose a stage and then right-click at arrow-head part of timing bar.
<How to set dispensing parameter>
Parameters such as dispensing volume, speed, height and washing number can
be set at the separate Dispenser Control box.

Dispensing timing might be not in time though the interval between
dispensing and dispensing can be set at executable intervals according to
the parameter of dispensing set.

Please confirm there is no problem by trying before it measures it actual.
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(1-6) Dispenser Control box <In the case of FDSS3000/6000/7000EX>
Use to control a dispenser manually and set dispensing parameter. Setting can be done
as a Stage unit, and the dispensing head corresponding to the stage is set at shipping
according to the configuration.

Dispenser Gontrol

— (1)
[P.ssay Plate ‘ LoadD
(2)
[ TH1+Btage] | THi+Stage2| TH1+Staged | THI+Loader |
/ Dizpense Start Mozzle Wazh ‘ Detail..
N
“olume 20 ul SJ ﬂ — (3)
Azpirate
Speed B0 ylis 4 ﬂ
Height 05 mm «| | v
Dispense
Speed 50 ulfs ﬂ_| ﬂ
Height 2Bmm ¢ | ¥
Wi iazh Off Setup | [ after measureﬁ/
T : (4)
{; IU:L?E e Tk ])\ [Ohange Head & Ligand Plate — (6)

@)
(®)

(1) Assay Plate
: To load an assay plate in or out when manually controlling the dispenser.
Load : To load an assay plate in.
Unload : To load an assay plate out.
(2) Stage selection tag
: To display combination between dispensing heads and ligand plate stages
and to set dispensing parameter here.
(3) Dispensing parameters
: To set dispensing parameter with a Stage unit, choosing a Stage selection
tag (Refer to 1-6-1)
(4) Mixing Assay Plate
: To choose ON or OFF of mixing (vibration) function for an assay plate. It is
available only at fluorescence measurement.
(5) Auto Ligand Tank
: To choose ON or OFF of auto ligand feeding function. (Option)
(6) Change Head & Ligand Plate
: To exchange dispensing head, tips or ligand plates, specifying which tips
and plates with Stage selection tag.
(7) On/Off of tip wiping function at the washing.

@ Click the tag into active and then click this command.
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(1-6-1) Dispensing parameter
Used to set dispensing parameter. Setting can be done as a Stage unit, and the
dispensing head corresponding to the stage is set at shipping according to
configuration.

(1) ——{ TH1+Stagel | TH1+Staze2 | THI+Staged | THI+Loader | 3)

(2) ||| Dispensze Start hNozzle Wasf'q‘ Detail.. (4)

[\-‘elume [ 20 ul JJ (5)
Azpirate
[ Spoed |57 uie 4] |

(6)

Heieht 05 mm ﬂJ

Dizpenze

Speed 80 ulfs
Height 2R mm J J

[ Multi Wash Off Setup]|[|_ after measurement]

(7)
)
(8)

=L =Ll )|

(1) Stage selection tag
: Choose at which combination dispensing parameter is set.
(2) Dispense Start
: To start dispensing operation when operated manually. It dispenses liquid with
the active tab head/stage and set parameters in it.
(3) Nozzle Wash
: To wash a dispensing head when operated manually. It washes with the active
tag head and washing times set into ‘Wash Cycles’.
(4) Details
: To set the detail parameter such as aspirated place and mixing in/out function
(Refer to 1-6-2).
(5) Volume
: To set dispensing quantity (unit: pl) with the active tag head.
(6) Aspirate
: To set aspirating parameter with the active tag head.
Speed : To set aspirating speed (unit: pl/s).
Height : To set aspirating height from the bottom of plate, (unit: mm).
(7) Dispense
: To set dispensing parameter with the active tag head.
Speed :To set dispensing speed (unit: pl/s).
Height :To set dispensing height from the bottom of plate, (unit: mm).
(8) Multi wash ( In the case there is Multi wash function)
: By clicking set up button, to set how many times the dispensing head is
washed
Wash Cycles ( In the case there is no Multi wash function)
: To set how many times the dispensing head is washed.
(9) after measurement
: To choose at which timing the dispensing head is washed.
Check : To wash a dispensing head after measurement. It works at data
acquisition measurement, not at manual control.
No Check
: To wash a dispensina head after dispensina operation.
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(1-6-2) Dispensing detail parameter setting
Used to set dispensing parameter. Setting can be done as a Stage unit, and the

dispensing head corresponding to the stage is set at shipping according to
configuration.

<FDSS7000EX>
Tp & Hesd Mo
Mol TipkHead " HoZ Toshead | (1)
Aspirate From
: BN )
Trituration
F Gource Plte Tribration]
I volume [ 20ul Al v
Height [ 50 mm a | v
Otz Disp-Asp) IWT._ +
Miach Pogition
Height [E0mm 4| A (4)
Lgand Tank,
* Aconss | J—— (5)
ot |

<FDSS6000> (Tip&Head No of FDSS7000EX change as follows)

Detail Setup

Head Type
&+ Tip

Azpirate From

" Mozzle

(1) Tip & Head No: To choose the combination of dispensing head and tip
There are No.1 and No.2 in the combination, it can be set when
starting or changing the head and tip

Head Type : To choose the dispensing head type, tip or nozzle.

(2) Aspirate From: To choose from which place liquid is aspirated and then dispensed.

Stage : Aspirate from a ligand plate on the round table.
Loader : Aspirate from a ligand plate on the loading line.
(3) Trituration : To set mix-in/out at aspirating and/or dispensing

<Please refer to 2-1 in Chapter 12>
Source Plate : To run mix-in/out at aspirating
Destination Plate: To run mix-in/out at dispensing

Count : To set how many times mix-in/out is done (Common at Aspirate
and Dispense).
Volume : To set how much quantity is used at mix-in/out.
Height : To set the height at mix-in/out.
Offset : To set the difference of the height when mix-in and mix-out.
(4) Wash Position: To set the washing position
Height : To set the height at washing. (Unit: mm, from the default value
where the edge of tip a bit entrances into the washing nozzle.)
(5)Ligand Tank : To access the ligand tank for the auto ligand feeder. (Option)
Access : To turn the position of the cell tank for the auto cell feeder to the

door position and then to open the door so that it can be accessed
for exchanging it
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(1-6-3) Parameter setup for Multi Wash Function

In the case there are Multi wash function in your FDSS7000EX, parameter setup is
performed on the following box. The setup is performed by Stage

Setup Multi Wash Parameter

[ Pulti Wash

& {ni " Off

Multi Wash : On/Off

3
=

Parameter

1st Washing

3rd Washing

2nd Washing E -

Wash Cvcles Ultra Sonic Wash Method
IE—jj |ON ﬂ |Overf|ow ﬂ
FE < [0FF =] [Replace  ~] [~} Setup of Parameter
E «|r| |oFF =] |Replace |

Cancel |

Multi Wa

Ul

Parameter

sh : Setup of On/Off

tra Sonic

Wash Method

Replace

Overflow

: Setup of washing parameter
It is possible to use the washing bat up to 3 bats
The washing is performed in order of 1% Washing -> 2" Washing -> 3™ Washing
Same washing bat can not be set more than once.
Vat No
Wash Cycles

: Setup for the number of washing unit used
: Setup for how many times washing is performed
(In the case‘0’ is set, washing is not performed.)
: Setup for On/Off of ultrasonic function
: Setup for how to wash
: After filling the washing bat by washing solvent, aspirating
and draining washing is performed.
: while flowing the washing solvent, washing is performed

@ Wash method depends on setup state of washing bat
Please use this function after confirming the using dispensing setup
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(1-7) Dispenser Control box <In the case of uCELL>

Use to control a dispenser manually and set dispensing parameter. Setting can be done

as a tab unit.

(For details, Please refer to Chapter 12.)

Dizpenzer, Gontrol

[ Azeay Plate

Access ]

(1)

— (4)

CTHT+=1age] | TH1+5tage2 | TH1+Stagel | THI +StageEﬂ A

. Setup
~ Dizpense Start Mozzle Wash —_—
J/

c
/

(®)

B0 ulis 4
100 mm 4

v Trituration

[v ol [10ul 4
Count |2 4
Height |20 mm 4
et (00 mm 4

7 Di v L

( ) \ feed [Eluls 4 % Wash [ After Measurement
eight [100mm o 1st

v Trituration at p, :l'

L flou Ol o ]

4
Count |3 d
Height |00 mm <
et (00 mm 4

— (8)

]

1 00 mm

9)
(10)

(1 1 ) __\ [ Change Hearl ’

[r Wipe:d [ Access Ligand Mol g

-

(1) Assay Plate Access : Loading and unloading of assay plate

(2) TH1+StageX tag : Switching of dispensing parameter combination
(3) Dispense Start : Execution of dispensing

(4) Setup : Setting of various setting box

(5) Nozzle Wash : Washing of tip nozzle

(6) Aspirate : Setting of aspiration parameter

(7) Dispense : Setting of dispensing parameter

(8) Wash : Setting of washing parameter

(9) Change Head : Exchange of dispensing head
(10) Access Ligand No.X : Exchange of ligand plate
(11) Wipe : Setting of On/Off of wiping after washing

m Click the tag into active and then click this command.
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(1-8) Setting tab

Used to set correction, auto sensitivity adjustment, graph display, auto data output, graph
calculation parameter and preparation, specifying a tab to be set.

[ Clutput] F‘repa.] Sens. ] Graph] Proc. ] Calc.Param l

\—/

Output
Prepa.

Sens.
Graph
Proc.
Calc.Param

Calc.Range
Corr.

\_ Click a tab to de displayed and to be set

: To set auto data output (Refer to 1-8-1).
: To set preparation parameter such as pre-incubation and plate

number. (Refer to 1-8-2)

: To set the auto sensitivity adjustment function. (Refer to 1-8-3)

: To set parameter to be displayed in a graph. (Refer to 1-8-4)

: To set parameter of group and data processing. (Refer to 1-8-5)
: To set calculation parameter in graph data such as Hits Well and

Baseline. (Refer to 1-8-6)

: To set the calculation area. (Refer to 1-8-7)
: To set correction such as auto fluorescence and shading.

(Refer to 1-8-8)
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(1-8-1) Output setting tab
Used to set parameter to be automatically output with TextOut and PrintOut.

Output l I’repez.] Sens. ] Graph] Proc. | Calc.Param] Cale Rang ] ] NextSeq.]

fﬂg Cutput Method (1 )
v Text{Raw> |v Text{Plate> [ Text{Group> [ Print Graph [ ]—
Raw Data & Print Graph  Selection
i [ ExB40.Emb4d [T 240 1T Integral [ with SepFile ]——-— (2)
Plate Format Data selection
Hit Wells [ Hit
Ratio v Max [ Min [ Av. [ Max-bin [ Ihtee
Ex340EmG4D [~ Max [ Min [~ Bv. [ Max-Min [ Itee. I Rat Max  |H—— (3)
Ex340:Em540 [ Max I [ Mac=Min. [~ itee. [
Raw Data & Plate Format Data <Footer (4)
I Azzay Protocol |_
£ N ExXTULIT,
(+ Each Plate File  pdd to afile [ ]_ (5)
(1) Auto Output Method: To choose the output method from the following.
Text<Raw> : To output graph data of all wells with the text format. Output items
are set at Raw data & Print Graph Selection.
Text<Plate> : To output the calculation result of all wells with text format.

Output items are set at Plate Format Data Selection.
Text<Group> : To output group calculation results (EC/IC Calculation).
No Output data configuration window.
PrintGraph : To printout all wells graph. Output items are set at Raw data &
Print Graph Selection.
<AutoScale> : To set the auto scale at PrintGragh.
(2) Raw Data & Print Graph Selection: To set items to be output at ‘TextOut<Raw>’
and ‘PrintOut’.
Ratio : Ratio value dividing Fluorescence No1 intensity by Fluorescence No2
intensity at 2-wavelength excitation or emission measurement.

Or, Ratio value dividing Fluorescence No1 intensity by initial value of it.
Fluorescence No1 (Luminescence) : Intensity of Fluorescence No1.
Fluorescence No2 : Intensity of Fluorescence No2.

Integral : Integrated value of intensity or ratio, which is set at ‘Calc. Param’.

(Refer to 1-7-6)
With Sep. File : Raw data of each item is output with another file.
(Refer to 2-1 in Chap.6)
(3) Plate Format Data Selection: To set items to be output at TextOut<Plate>.

Hit : Hit data with Hit well analysis function for Peak and Integral parameter.

Ratio : Ratio value dividing Fluorescence No1 intensity by Fluorescence No2
intensity at 2-wavelength excitation or emission measurement. Or, Ratio
value dividing Fluorescence No1 intensity by initial value of it.

Fluorescence No1 (Luminescence) : Intensity of Fluorescence No1.
Fluorescence No2 : Intensity of Fluorescence No2.

Integ. : Integrated value

Max : Maximum value during measurement

Min : Minimum value during measurement

Ave : Average value during measurement

Max-Min :Maximum vale- Minimum value

Rat.Max : Intensity value at the maximum value point of Ratio at 2

excitation or 2 emission measurement.
(4)Raw Data & Plate Format Data <Footer>
Assay Protocol : To output Assay Protocol information at footer of Text data.
(5) Filename: To set a file name at TextOut.
Each Plate File : To create Text file at each measurement. TextOut file name is
named by Plate File name.
Add to a file : To output plural measurement data with the text format into one
file. TextOut name is named by input character in the field.
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(1-8-2) Preparation setting tab
Used to set preparation such as Pre Incubation and Change Out, and dispensing
operation before starting measurement, to set the plate number at sequential
measurement (Auto measurement mode).

<In the case of FDSS3000/6000/7000EX>

Output[mnﬁens. 1 Graph] Proc. ] Ca\c.Param] ] ] SaveImg.} NextSeq.]
[Numbar of plates |5 ﬂ ( F]J . (1 )
Emﬂaﬁ_w—ﬂ_ﬁmes { For Auto Measurement Mode ) (2)
Tt 3)
P T o =1 L—2 S N )
I I
[ - aéaLli 4 |
Before Loadine fzzavPlate Stepl |* ﬂ | J\ (7)
Before Loading AssavPlate Step? |C' ﬂ | J
After Loading Aszay Plate Stepl |Oif ﬂ | J
After Loading Assay Plate Step2 |Cl ﬂ | Jj

<In the case of uCELL> v
I [ Chanee Ligand Plate{No} 1 | Every |1 | plates ] | 6
: [ Chanee Head |0n ﬂ Every |‘I ﬂ plates ] ( )

(1) Number of plates
: To set how many plates are measured at Auto measurement
mode. When plates run out on the way to the specified number,
the measurement finishes.
(2) Exchange cmpd plate Every X plates (Auto measurement)
: The cmpd plate are exchanged every X plates of the measurement
plate.
(3) Pre Incubation(min)
: To run Pre incubation before starting measurement. Choose
the number to wait for how many minutes or ‘Off when not
necessary.
The plate stands by after being loaded in and waits ready for the
specified time (Unit: min).
(4) Change Out : Tip and ligand plate can be exchanged before measurement.
1~4(FDSS6000) : The combination of head and stage of a specified
number are moved forward and the door is opened.
Tip&Head(Fpss7000ex) : Tip+Head can be exchanged and the door is opened.
OpenDoor(Fbss7000EX) : The door is opened.
Every X plates : To set Change Out every X plates. (Auto measurement)
(5) Change Ligand Plate
: Ligand plate can be exchanged before measurement.

1~4(uCELL) : The ligand stage of a specified number
are moved forward.
Every X plates : To set Change Ligand Plate every X plates.

(Auto measurement)
(6) Change Head : Head can be exchanged before measurement.

On(uCELL) : Head can be exchanged.
Off(uCELL) : Head can not be exchanged.
Every X plates : To set Change Head every X plates. (Auto measurement)
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(7) Preparation of Dispenser

: To set the aspirating and/or dispensing before starting
measurement. Is it not available for ‘Change Out’ and
‘Preparation of Dispenser’ to work simultaneously.
Before Loading Assay Plate Step1/2
: Dispensing operation before a assay plate loaded in.
(Useful at configuration, which has only one loading line.)
Dilute Ligand Loader From
: To load a ligand plate in, aspirate from a ligand plate on a
stage and then dispense a ligand plate on the ligand
loader. (If there is no setup of the following “Before
Loading Assay Plate” , load a ligand plate out.)
Choose from which stage the dispensing head aspirates.
Disp.From Ligand Loader To
: To load a ligand plate in, aspirate from a ligand plate on
the ligand loader and then dispense a ligand plate on a
stage. (If there is no setup of the following “Before
Loading Assay Plate” , load a ligand plate out.)
Choose from which stage the dispensing head aspirates.
Aspirate From Loader
: To load a ligand plate in, aspirate ligand from it and then
load it out.
Choose into which stage dispensing heads dispense over
amount aspirated liquid.
After Loading Assay Plate Step1/2
: Dispensing operation after a assay plate loaded in.
Dispense Buffer From
: To aspirate from a ligand plate on the round stage and
then dispense into an assay plate. Choose from which
stage the dispensing head aspirates.
Aspirate Medium To
: To aspirate from an assay plate and then dispense into a
ligand plate on a stage. Choose into which stage
dispensing head dispense.
Disp. To Stage1 From
: To aspirate from a ligand plate on a stage and
then dispense into a ligand plate on the stage1.
Choose from which stage the dispensing head aspirates.
Disp. To Loader From
: To aspirate from a ligand plate on a stage and
then dispense into a ligand plate on the lingad loader.
Choose from which stage the dispensing head aspirates.
Dilute Ligand Loader From <Option Function>
: To aspirate from a ligand plate on a stage and
then dispense into a ligand plate on the lingad loader.
Choose from which stage the dispensing head aspirates.
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(1-8-3) Sensitivity setting tab
Used to set parameter for Auto sensitivity adjustment function. Auto sensitivity

adjustment function is useful to set proper detector gain and to keep reasonable
dynamic range according to sample brightness.

Output] Frepa| Sens. Graph] Proc. ] Oalc.Param] ] ]

(1) ——[ Auto Sensitivity Mode lOn—NormaI ]v_| [ | ] (3)
(2) ——[Threshold Lewvel | L] _] _b] ]

Select Contraol

[ Select Ihtensity 1 Bright | }Jam (4)

(1) Auto Sensitivity Mode
: To choose the setting mode for Auto sensitivity adjustment function.

Off : Not to use Auto sensitivity adjustment function. It doesn’t see
intensity before measurement. It starts measurement with the fixed
initial camera gain at opening the assay protocol box.

Manual-1%.Plate Only

: Not to use Auto sensitivity adjustment function.
(To see intensity and set gain at the first plate by manual at Auto

measurement mode.)

On-Normal
: To see intensity and set camera gain at each plate.

Off-Fix : To see intensity with manually set the fixed gain in ‘Sens’.
On-1°'Plate Only
: To see intensity and set gain at the first plate. And then the
sensitivity adjustment setting is employed for the rest plates at Auto
measurement mode. It sees and sets at each Single measurement

mode.

(2) Threshold Level
: To set Threshold level for sensitivity adjustment standard.

(3) Sens: To set Sensitivity at the fixed sensitivity setting.

(4) Select Intensity
: To choose bright range for the sensitivity setting. (Refer to 1-8-3-1)

Range No 1 to 11
: Brightness comes from average value of 8 well at Auto sensitivity

adjustment setting. All wells are ranked based on high intensity and
divided them into 10 groups. And brightest 8 wells at each group
are picked up and the average is used for sensitivity setting.

Darkest 8 wells are used for Range 11.
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(1-8-3-1) Auto sensitivity setting method
Threshold level is a standard value to set camera gain (Sensitivity) at the sensitivity
adjustment. Threshold level depends on assays but it is basically set as bellow.
Case1: Big intensity change is observed like Fluo3. :
Threshold Level = 1,500 (In the case of ORCA)
Threshold Level = 20,000 (In the case of EMCCD)
Case2: Ratio value is acquired like Fura2 :
Threshold Level = 2,000 (In the case of ORCA)
Threshold Level = 30,000 (In the case of EMCCD)
In Sensitivity adjustment, 8-wells average value which is set at ‘Select Intensity’
(Refer to 1-8-3-2) gets up camera gain (Sensitivity step) by one-steps through to
Threshold level. When 8-wells average intensity reaches Threshold Level, the gain
setting goes back to set the last Sensitivity step of Threshold Level and then start
measurement with the Sensitivity step.

Threshold Level

Low intensity High intensity

»
»

| |
Sensitivitystep 1 2 3 4 5 6 }7

Applied Sensitivity during measurement J

(1-8-3-2) Select Intensity
Intensity values of a certain wells are picked up as standard for Auto sensitivity
adjustment setting and these values are set with Select Intensity parameter. The
following figure shows the concept of Select Intensity. All wells are ranked based on
high intensity and divided them into 10 groups and the brightest 8 wells at each
group are picked up and the average value of the 8 wells is used for auto sensitivity
setting. Darkest 8 wells are used for Range 11.

Concept for relationship between picked wells and Select Intensity

<- Bright Intensity Ranking of all wells Dark>

optonsovete s (- SHIHIHE-E- -0

Select Intensity (Range) 1 2 3 4 5 6 7 8 9 10 11

Select intensity is to set wells for judging the above average intensity. When the set
value is bigger, darker wells are picked up as standard for auto sensitive adjustment.
For example:
Case1: All wells have the same cells with the same quantity (Basically the
intensity values are the same.)
: Select Well Level = Any value is OK
Case2: There are several wells which have much brighter intensity and it would
be better to ignore the bright wells
: Select Well Level = 2 to 3 ( Clear off 20 % to 30 % bright wells)
Case3: Originally there are compounds which have auto florescence in well and
around 50 % of total number and it would be better to ignore the bright wells
: Select Well Level =5 to 6 ( Clear off 50 % to 60 % bright wells)

Relationship between Threshold Level parameter and Intensity Level parameters as
shown when manually adjusting sensitivity
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Target intensity used as standard for auto sensitivity adjustment
= Threshold Level

Average intensity of 8 wells is used for auto sensitivity adjustment
= Select Intensity

(1-8-4) Display Graph setting tab
Used to set which kind of graph and graph scale (y-axis) to be displayed at
measurement.

Output] Prepa.] Sens. Graphl Proc. ] Oalc.Param]

I |
/Ratio Range (2)
Min 050 ) | j]
Max f200 | o]
(1) __| ™ Ex4soEmsen ) S—
(Tntensity Range s (3)
Min 10 JaT o]
Intee. (Mo realtime disp L Max (4000 N | |
[~ Display Marker FURMESE RETED (4)
(5) [ Real Time Auto Scale Min 10 2l 2
|1 I Real Time Time Scale Expand _ Ma= 1000 Al na

(1) Display Graph  : To set which kind of graph to be displayed.
(2) Ratio Range : To set graph scale of ratio value.
(3) Intensity Range : To set graph of ratio value of
fluorescence/luminescence intensity
(4) Integral Range : To set graph scale of integral value.
(5) Display Marker : On/Off of marker display during measurement
Real Time Auto Scale
: On/Off of Auto-scale of Intensity and Ratio during the measurement
Real Time Time Scale Expand
: On/Off of Auto-expand display of time axis during the measurement
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(1-8-5) Processing Setup Tab

Setup for the data processing, data processing is performed when the data is read
after getting data

Setup for ON/OFF of data processing

Sens. ] GFGFH Proc. | Oalc.Param] Gale Rane
[ Ref \
erence range |

.
Megative Cottrol-
M/C paint

<7
|- 5ubtract Bias |

I Minus clip
Ranee of bias

[T 1
Positive Gontrol

Ranee of calc.
W Al ranees

: \'— < I_JH
\ Setup for parameter of each data processing
Setup for select of group well

Processing
: Set up for On/Off of the each data processing
S.U. = Spatial Uniformity Correction
N.C. = Negative Control Correction
S.B. = Subtract Bias
P.C. = Positive Control Scaling
Select Group : Select well group and setup
Group List = Selectable group is shown here.
Select the group and setup well configuration on
the plate well display
Setup Group = Add,delete,edit Group
Spatial Uniformity
: Setup of reference range for use of S.U. (Set up of sampling number)
Negative Control
: Setup of basis area for use of N.C. (Set up of sampling number)
Subtract Bias
: Setup of Bias range (Set up of sampling number)
Minus Clip can caluculate‘0’if the value is minus after being subtracted
Positive Control
: Setup of calculating area for used in P.C.
(Set up of sampling number)

Output] P.epa.] ] Coarr ] NextSeq.]

Sel_ect Group
= .___ Display of the plate well:
Setup & Display of
control well
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(1-8-6) Calc.Param setting tab
Use to set parameter for calculation proceeding about measurement data such as Hit
well analysis.

Output] F‘repa.] Sens. | Graph] Prac. |Cale.Param } il Fiang ] Corr. | NextSeq.]
Ratio:Denominatar |1St Samp. Point j Ave. l1 Samp. LJ ]._—— (1)
Hit Well : Integral ltem | Ratio ~ (2)

[Hit Well : Select Peak Max hd (3)
fic/Ec (80 v| uses [MolData  ~| < Ratio | Max >

Hit;u’eH Raree
[~ Inteeral | = | -
< Mo Data ¥ R =

st TN [ =g | 1IN (5)

¢ No2 Data > [ iieet] | e | =

[~ MoZ Max | = [ =

£ 3 Dt [ It | = =

\ r | =l =

(1)Ratio / Denominator
: To set the denominator item of ratio (refer to 1-8-6-1)
<when two wavelength measurement>
Wavelength2 Intensity
: Intensity value of wavelength2 of each sampling point
<when one wavelength measurement>
15'.Samp.Point
: Intensity value in which 1%, sampling point is assumed to be a reference
point
Ave. : Average value of the set sampling from the 1%'. sampling point
Delay : The reference point is moved behind the set sampling
<Option Function>
X Disp. Point <Option Function>
: Intensity value in which sampling point before No.X dispensing point is
assumed to be a reference point
Ave. : Average value before the set sampling from the reference point
Delay : The reference point is moved behind the set sampling
(2)Hit Well/Integral Item
: To set item for Hit well analysis, Ratio or Florescence( Luminescence)
intensity.
Normally ratio value at fluorescence and Intensity at luminescence
measurement are recommended.
(3)Hit Well/Select Peak
: To set peak for Hit well analysis, Max or Min. Normally Max value at the
measurement where the change goes up.
(4)IC/EC X uses No.X Data
IC/EC X
: Set IC/EC Percentage
Percentage value can be configured from 10 to 90, 10 value step.
Uses No.X Data
: Set the data number using for IC/EC calculation.
The number should be selected from the data number 1 to 3 in
Calc.Range Setup Tab.
(5)Hit Well Range
: To set parameter range at integral and at max at for condition of Hit well
analysis. Hit well analysis function is to automatically pick up
applicable well to the set condition at Integral and Max.
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(1-8-6-1) Ratio/Denominator setting

It can be set which value is used at the denominator of the ratio for the ratio
calculation on one wavelength measurement, using Ratio/Denominator setting.

<1%.Samp.Point setting>
The average value of the set number in ‘Ave.’ is applied for the denominator of the
ratio, being shifted from the set number in ‘Delay’ from 1*".Samp.Point.

Example) Ave.=5samp.,Delay=3samp

st .
17.Samp.Point The average value is applied for the denominator.

I
1 |
i | 4 [
 Delay \ Ave.

<Option Function>

—

<X Disp.Point> (Option Function)
The average value of the set number in ‘Ave.’ is applied for the denominator of the
ratio, being shifted from the set number in ‘Delay’ from X Samp.Point.

Example) Ave.=5samp.,Delay=3samp

X Disp.Point
1St.Samp.Point \ The average value is applied for the denominator.

| I I
LII

|
T N
i—>
1
1

r

~—__ Delay

; Ave.
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(1-8-7) Calc.Area setting tab
Use to set calculation area at calculation proceeding about measurement data.

Output] Prepa.] Sens. ] Graph] Proc. ] Calc.Param :] ]
] )

b Enable Output Mol Data J
drmeerat A=t
: Stat 14 2l 3
[~ To1stDispense End 1 4 ﬂ ( )
Tand, [ =}
[~ Al ranges Start |1 4 ﬂ 4
End [13 4| ’ (4)
[~ Al ranges Start |1 4 1] (5)
End 13 & 3 T
i} =]
I All ranges Start |1 1 _'i )
( End [13 4] » (6)

~

(1) No.1,2,3 Tab

: To select the area which is separated at the dispensing timing.
(2) Enable Output No.X Data

: To enable the calculation of the data with check.
(3) Baseline(Integral:Max;Min:Av.:Max-Min)

: To set the baseline for the calculation. When enabled, the average value
of the baseline range is subtracted at the result. Integral value reflects on
real time graph at measurement.

Enable Sub.Baseline
: To enable the baseline finite difference function with check.
To 1°.Dispense
: To set range to be recognized from measurement start to the first
dispensing timing.
Start/End
: To set range manually to be recognized as a baseline.
(4) Integral Range
: To set range for the integration (Integral)
(5) Max:Min:Max-Min Range

: To set range for Max (maximum intensity) ,Min (minimum intensity) and

Max-Min value.
(6) Average Range

: To set range for Average (average intensity) value.

All ranges : To set all ranges from the first sampling to final one.
Start/End  : To set a certain range with sampling number for Start/End.
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(1-8-8) Correction setting tab
Used to set ON/OFF for auto fluorescence correction data or shading correction data
which are created at each command in Setup menu (Refer to 3 and 4 in Chapter 8 ).

Output] Prepa.] SENS. ] Graph] Froc. ] Oalc.Param] CD

Carrection Type Filename Date
(1) (I Buta Fluorescence] Muncds4 Exp5.P&F 200602416 13:20
(2) — W Shadine ) Nuncdx4.FSD 2ulu5;’11fm1?:n4

It displays correction data information. The data files
are created with plate information and they are
automatically chosen from the reiterated data here.

(1) Auto fluorescence correction On/Off
: To employ auto fluorescence correction data with check (Not necessary at
luminescence measurement).
(2) Shading correction On/Off
: To employ shading correction data with check.

(1-8) Start <Single>
To start single measurement with only one plate. The result is displayed after
measurement.

(1-9) Start <Auto>
To start sequential measurement with plural plates. ‘Number of Plates’ in Preparation
setting tab can set how many plates. File name is named by auto naming function or bar
code reader (optional). In order to finish the easement with fewer plates than the
specified number, click ‘Stop’ during measurement.

(1-10) Close

To close the assay protocol setting box.
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2) External Control (Start External Control command
< Option >

This command is used when FDSS is controlled by the scheduling software at the robot
integration. Clicking ‘Start External Control’ displays the following message box and FDSS
turns to the external control mode. Users cannot operate FDSS directly under the external
control mode.

<Confirmation message for the plate, filter and dispensing head>
Confirm the plate, filter and dispensing head are properly set, and then click ‘OK’.

Please confirm these parameters x|

& < kind of plate used =

Assay Plate + MIUME OpticalBottom
Ligand Plate Mo.1 ¢ MUMNC PP
Ligand Plate Mo.2  : MUNC PP
Ligand Plate Ma.3  : MUMC PP

< Kind of dicraic mirrar >
WWavelength  : ZEx1Em or ZExZEm [ Ex400:Em465 | Ex400:EmS60 ]

< Preparation of dispenser =
Flease confirm the tips loaded

Lo “[ Gt “ Cancel the external control

\ operation
Start the external control operation

<External control mode window>
Under the external control operation, the following box appears. Click ‘End of
Control’. Users cannot operate FDSS directly under the external control mode.

External Control Mode

FOSS iz controlled by Robot

End of contral Finish the external
: control operation
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5. Measurement

This chapter describes to start measurement and to acquire data. It has several
measurement methods such as 1 wavelength excitation measurement (Fluo3/4), 2
wavelengths excitation measurement (Fura2) and Photon Counting measurement
(Luminescence). The measurement method is chosen at starting up software.

<Start measurement>
Clicking ‘Start <Single> or ‘Start <Auto>' in Assay Protocol Setup box starts
measurement based on the set protocol.
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1) Workflow for measurement

Setting Assay Protocol l
N

Measurement start with ‘START in Assay Protocol Setup ]
W

Confirmation on the plate type, filter and tip ]
) N

Aspirating ligand from loading line (*) ]
7

Assay plate in ]

\

Dispensing head tip / ligand plate exchanging (*) ]

\/
( Dispensing / aspirating before measurement (*) ]
[ Pre Incubation *) ]

N2

Camera sensitivity setting (at fluorescence and luminescence measurement)

N2

Data acquisition start ]

(.

( Dispensing, tip washing ]

Data acquisition finish ]
f Tip washing (*) ]
( Assay plate out ] )
7
Data output (TextOut, PrintOut, Bitmap) ]
[ Measurement start ]

(*) : When setting it with assay protocol
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2) Confirmation using plate, filter, tip

When clicking ‘START in Assay Protocol Setup to start measurement, the following
message appears. Confirm the plate type, filter and tip are properly set and then click
‘OK..

Please confirm these parameters E|

1 E < Kind of plate uzed >
=, Azzay Plate : MUMG OpticalBottom 384
Ligand Plate Mol : MUMG PP 384
Ligand Plate Mo.2  : MUMG PP 384
Ligand Plate Mo.3  : NUNG PP 384
Ligand Plate Mod4  : NUNG PP 384

< Kind of dicraic mirrar >
Waveleneth  : 2ExT1Em or 2Ex2Em [ Ex480:EmB40 / Ex480:EmS40 ]

< Preparation of dizspenzer >
Flease confirm the tips loaded

A7)

3) Aspirating ligand from the loading line
(Only at the configuration which has just one loading line.)

It can load a ligand plate through the loading line and aspirate ligand before
measurement. This is used effectively only at the configuration which has just one
loading line.

Enable ‘Aspirate From Loader’ at Preparation tab in Assay Protocol Setup box and then
click ‘Start’. The following box appears at no stackers. Set a ligand plate on the loading
arm and click ‘OK’. The plate is loaded in for ligand to be aspirated and then loaded out.
Automatically done at the configuration with stackers.

Dispenser

-
\lj) Please get a Ligand plate for AspirateFromlLoader
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4) Assay plate In

The following box appears when an assay plate is manually set and then loaded in,
after clicking ‘START’ <Single>. Set a plate onto the loading arm and also click ‘OK’ to
load it in.

(For uCELL, please put an assay plate on the assay plate folder and click ‘OK’ button.)
Automatically done at the configuration with stackers.

Dispenser

jf) Please zet a Assay plate.

}(__Cencdl H—1 @)

(1) OK : To load an assay plate in after setting it onto the loading arm.
(2) Cancel : To cancel operation and finish measurement.

When an assay plate starts to be loaded in, if the loading fails, the following
messages appear. Confirm the plate is set well at the loading arm or stacker
and then click ‘OK’.

FDSS7000/uGELL

Zan not loading assay plake,
Please set assay plake,

! } Cispenser © [9] Plate Loading Error
L

Cancel I
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5) Dispensing head tip/ Ligand plate exchanging

Dispensing heads and/or ligand plates can be exchanged after the plate loaded and
before starting measurement when setting enable ‘Change Out’ at Preparation tab in
Assay Protocol Setup box. The following box appears. Clicking ‘OK’ proceeds to next
step’.

FDS57000/uCELL

i Flease take out and install a head and a ligand,
and push the ©.K. butkon.

For FDSS7000EX.

The door of the dispenser closes when OK button of the above-mentioned
message box is pushed.

After the door of the dispenser closes, the following message box is
displayed. Please push the OK button after pushing the ‘Preparation’ button
of the front panel of the dispenser.

(It is not displayed according to the system, and Preparation is done by the
automatic operation. )

! 5 Dispenser :

[100] Please push <Preparation= button that exists in the operation panel of the dispenser,
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6) Dispensing/Aspirating before measurement

Dispensing ligand and/or aspirating medium runs before starting measurement when
setting enable ‘Dispense Buffer’ and/or ‘Aspirate Medium’ at Preparation tab in Assay
Protocol Setup box. The status message shows ‘moving dispenser’.

Moving Dispenser

Stop | farker |

Display when Dispense Buffer and Aspirate Medium are executed

7) Pre Incubation

Pre Incubation runs before starting measurement when setting enable at Preparation
tab in Assay Protocol Setup box. The plate stands by after being loaded in and waits
ready for the specified time. The following box is displayed during Pre Incubation and it

shows the rest time. Clicking ‘skip’ stops incubation operation even on the way and then
proceeds to next step.

Fre Incubation
Pleasze Wait l (1 )
[ Elapzed Time 00:00:03 A1 min. ] lﬁance (2)
\
AN
(1) Elapsed Time : To show the rest time for Pre Incubation.
(2) Skip Incubation : To stop incubation operation on the way and then proceed
to next step.
(3) Cancel : To cancel operation on the way and then finish
measurement.
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8) Camera sensitivity setting at fluorescence and

luminescence [Analog [EMCCD] measurement

Sensitivity adjustment automatically starts after the plate in and preparation operation
and shows the following setting box. Clicking ‘OK’ after confirming image simulate data
at ‘Microplate Display’.

Gheck Sensitivity

Filter Setting
[ Exaan/EmEan | Ex3a0/EmBd0 | |1 (1)
Senzitivity
= « | v —t— @)
] G
AN AN
) @
(5)
G
H I
(1) Filter Setting : To choose a filter to be used for acquiring image when
checking sensitivity.
(2) Sensitivity : To set manually sensitivity to be used for measurement.
(3) OK : To proceed to next step, data acquisition.
(4) Cancel : To cancel operation on the way and finish measurement.

(5) Microplate Display : To display Ratio/Intensity/Integral on the specified
sampling line with pseudo color.

Sensitivity can be changed manually. In case auto sensitivity adjustment
(Auto, Fix) is ON, it skips the following box and proceeds to next step.
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9) Data acquisition start

It automatically starts data acquisition after auto sensitivity adjustment. The following is
displayed during acquisition.

(1) Real time graph display
: To display all wells graph data. The items and scale to be
displayed are set at ‘Display Graph’ tab in assay protocol.

(2) Process status and operation
: To display the process status and how many samplings remains,
and to operate commands during data acquisition. (Refer to 9-1).

(3) Single graph display
: To display single graph data. It can show maximum 10 wells
data with overlay. Left- clicking one graph on (1) Real time graph
display shows it at this display.

(4) Live image : To display camera live images.
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(9-1) Operation during data acquisition

Acquisition status is shown as below during data acquisition. Clicking ‘Stop’ stops
acquisition and finish measurement. Clicking ‘Marker’ records a marker at clicking
timing onto graphs. The marker is automatically recorded at dispensing timing.

It can show single graph and also show maximum 10 wells data with overlay. Left-
clicking one graph on Real time graph display shows it at Single graph display.

UGetling Fluorescence Image l

(1)

47 181 ()

[ Auto Scale
(3) (4)

()

(1) Status message
: To display the status message
(2) Progress bar : To display the process status and how many samplings remain
(3) Stop : To stop data acquisition on the way and finish measurement.
(4) Marker : To record a mark at clicking timing onto graphs. The mark is
automatically recorded at dispensing timing.

(5)Auto Scale : To perform auto scale of intensity and ratio value.

Auto Time Expand : To perform auto scale of time axis

10) Measurement finish

It shows measurement result just after completing measurement. When running
sequential measurement with plural plates with START <Auto>, the plate loader comes
back to the initial position and then loads a plate in for next measurement.

| @ Measurement data can be processed at Data control box.
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6. File menu

Used to load Plate Data (measurement data), print out graphs and output data with a text
format.

<Command> Clicking File menu leads commands as bellow.

¥ FDSST000EX/uGELL <Fura? [l

Protocol  MWiew Setup  Help (1)

(Cpen Flate Tiata.. ]_/T’/_ )
(Text Out Data.. ]——”‘G{H—//_ (3)

(Frint Out V—

((mave by Bitmap (4)
( Lheplay Graph n Meww windo (5)
(Copy Graph to Llipboard (6)
((Batch Export.. (7)
CER (8)

el

(1)Open Plate Data... : To load FDSS plate data (measurement data).
(2) Text Out Data... : Export data with a text format.
(3) Print Out... : To print out graphs with some methods.
(4) Save by Bitmap... : To save the display by a bitmap format.
(5) Display Graph in New Window...
: To display the graph in new window.
(6) Copy Graph to Clipboard...
: To copy the graph to clipboard.
(7) Batch Export...  : Text out and calculation are done by plural data.
(8) Exit : Quitting FDSS application software.
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1) FDSS Plate Data loading (Open Plate Data command)

Clicking ‘Open Plate Data’ command from File menu leads the following box. Specify
Plate Data to be loaded with a mouse or key and click ‘OK’ to loads Plate Data which is
specified. Clicking ‘Cancel’ cancels operation and goes back to the original screen.

(3)
*= Open Plate Data [G:¥FDSSDATA¥DATAI X
- = . # | Plate Mame % | Date © | Plate Comment |A
Z/;, DCAMSDE N\ |t 2 .
) Documents and Settings r.!;tusmsnsu N\ Ao0g/11/08 1515 \ /7 \
o FDSSDATA £st031108049 2009/11 /08 1513
= testE1108045 2005/11 /08 1510
i) BITMAP test031108047 2002/11,/08 1507
w3 DATA test091102046 2009/11 /08 1505 (4)
=) RAWTEXT test0E1108045 2008/11 /08 1502
& TET testE108044 2005/11 /08 1459
testE1108043 2005411 /08 1457
H- HPK test091102042 2009/11 /08 1454
1) MAGE test081102041 2008/11 /08 1452
-5 My Ihstallations testla]108040 2008/11 /06 14:47
i testiE 11 i 2 ——
D NewData 1108110 2008/11 0
{3 Proeram Files test051108037 2008/11,/08 1408
I RAWTERT test081 108036 2008/11/08 1405
#5) RayCatcher Data test81108035 200511 /08 1402
[ SHADING te=t031108034 2003,/11./08 1400
© Source test0E1108033 2008411 /08 1357
testlE1108032 2005/11 /08 1354
i) SUPPORT test021102031 2005,/11/08 1351
- Soanmatie/ \___
< AnAr A A 11:-\—: v
[0]4 ]] [ Cancel ]]
S AN A
) () N~ (5) \— (6)
(1) Folder Name : To specify a folder where Plate Data files are stocked.
(2) Plate Name : To display a file name of Plate Data.
(3) Date : To display a date when it is created.
(4) Plate Comment : To display a comment which is recorded in Plate Data.
(5) OK : To load Plate Data which is specified.
(6) Cancel : To cancel loading data.
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(1-1) Plate data

Plate Data consists of six different format data files and the files are managed in one

folder.

<Example: Plate Data name ‘TEST001’ (with 96well format)>
‘TESTO001’ folder
‘TESTO001.FDSS’ file
‘TESTO001.CLC’ file
‘FDSS_96.DAT file
‘FDSS_96.FLI file
‘GLPINFO.GLP’ file
‘OUTINFO.IEOQ’ file

Copy or delete Plate Data as folder unit.

~N

[ DATA Folder

“TEST001.FDSS' file
‘ , “TEST001.CLC file
[ TESTO001 fo'der] ‘FDSS_96.DAT’ file
‘FDSS_96.FLI file
‘GLPINFO.GLP’ file
‘OUTINFO.IEO' file

“TEST002.FDSS' file
“TEST002.CLC' file
[ ‘TEST002' fo'der] ‘FDSS_96.DAT file
‘FDSS_96.FLI file
‘GLPINFO.GLP’ file
‘OUTINFO.IEQ’ file

‘TESTO003.FDSS’ file
‘TEST003.CLC’ file
‘FDSS_96.DAT file
‘FDSS_96.FLI file
‘GLPINFO.GLP’ file
‘OUTINFO.IEO’ file

[ ‘TESTO03’ folder ]
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2) Text output (Text Out Data command)

Clicking ‘“Text Out Data’ command from File menu leads the setup box to save a file.
Name the file and set Output items, then click ‘OK’ to save data

Setup Text Out Parameter (7)

Filename ak

Data Mame [111018003 )—1_ (1)
TR — ] — (9

Plate Format Data Mol : C¥FDSSDATA¥TEXTE 11016003 THT

Mo.2 : CEFDSSDATA¥TEAT¥ITI0T18002 2 THT (2)
Nod: [NAA T
Group Data : CHFDSSDATAYTEXT¥111018003 GRP.TXT
Output Ttem 4 (3)
Raw Data T (4)
[ ™ Ratio [ Ex480EmS40 [ [~ Intee. | with Sep File I Usze Azzay Pratocol
[ vels T HG ] — (5)
Ratio [ Max [~ Min [ &wv. [ Max-Min [~ Intes.
Ex480:Em540 [~ Max [ Min [ Av. [ Max-Min [ htee [ Rat Max
ExdftEmedn | = r I= - C R
Group Data )
[ I—DGrouD Data J (6)
s ) (7)
(1) Data Name : To set a file name of data.
(2) Filename : To display a file name of actual output.
(3) Raw Data : To set output items with a text format at Raw data.
With Sep.File : Raw data of each item is output with another file.
(4) Use Assay Protocol: To choose items which are set at an assay protocol

setting box.
(5) Plate Format Data: To set items to be output at TextOut<Plate>.

Hit : Hit data with Hit well analysis function for Max and Integral parameter.

Ratio : Ratio value dividing Fluorescence No1 intensity by Fluorescence No2
intensity at 2-wavelength excitation or emission measurement. Or, Ratio
value dividing Fluorescence No1 intensity by initial value of it.

Fluorescence No1 (Luminescence) : Intensity of Fluorescence No1.

Fluorescence No2 : Intensity of Fluorescence No2.

Integral : Integrated value of intensity or ratio, which is set at ‘Calc. Param’.
Integ. : Integrated value.

Max : Maximum value.

Min : Minimum value.

Av. : Average value.

Max-Min : Maximum - Minimum value.
Rat.Max : Intensity value at maximum value point of Ratio at 2 excitation or 2
emission measurement.
(6) Group Data
: Check “Group Data” when you need group data output.
(7) Raw Data & Plate Format Data <Footer>
: To set the assay protocol information at the footer part of text
data.
(8) OK : To set output parameter and to proceed to next step.
(9) Cancel : To cancel operation

72360301-04
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(2-1) File name of Text output

Text output can output text data with Raw and/or Plate format (max. 3 files for 3 data

areas).

Plate Format data can output max 3 files according to the number of the data area.

Setup Text Out Parameter

Filename

Data Name  [{7101800%
Raw Data G¥FDSSDATA¥RAWTEXT¥111018003_RAW.THT
Plate Format Data Mol : G¥FDSSDATA¥TEXT¥111018003 TXT

No2 : G¥FDSSDATAFTEXTHI 11018008 2THT

No3: [N/A

Group Data G#FDSSDATA¥TEXT¥ 11018003 GRP.TXT

Output Ttem
Ran Data
I~ Ratio [~ Ex480EmS40 I~
Plate Format Data ~
Hit Wells
Ratio

==z

-
I~ Max Min A Mac-Min Intee
[~ Max Av. T Max-Mi Tnteg. [ Rat. Max
= r

711
-
Lmm
:
L mE

Ex480:E mGdn
Ex420-EmB40

Raw Data & Plate Format Data <Footer>
I~ Hssay Protacol

IS

|_—— ‘with Sep.File’ Option

Group Data:
Group data :

Plate Format Data :
No.1 data :
No.2 data :
No.3 data :

Plate Format Data Filename
TESTO001.TXT

TESTO001_2.TXT
TESTO001_3.TXT

¥— “_1.TXT” is added’ is checked

Plate Format Data Filename
TESTO001_1.TXT
TEST001_2.TXT
TESTO001_3.TXT

Plate Format Data

ones. To output with the added c
named ones when “ 1.TXT” is a
Raw Data

ones. To output with the added c
tail end of the named ones when
Group Data

Group Data Filename:
TEST001_GRP.TXT

Raw Data :
Ratio data :

Ex480Em540 data :

Raw Data Filename:
TEST001_RAW.TXT

&«— ‘with Sep.File’ is checked

Raw Data Filename:
TEST001_RAW_Ratio.TXT
TEST001_RAW_Ex480Em540.TXT

: To output with the added characters * 2", ‘ 3’ at the tail end of the named

haracters * 1", 2’ ,‘ 3’ at the tail end of
dded’ parameter is checked.

: To output with the added characters * RAW’ at the tail end of the named

haracters *_RAW_"ltem name” at the
‘with Sep.File’ parameter is checked.

: Outputs of group data have *_GLP’ on the tail of file name.

The place and “_1.TXT” is

added’ parameter that saves data

can be set in ‘Setup Filename’ box in Assay Protocol setting box.
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(2-2) Text output format

Text output format is tab-delimited base. And it consists of the header part and well
data.

<Raw data format>
It is tab-delimited base text data. (x , y) = (time , well) format is saved at bellow

header part.
(1)
A B [ @ | o | F/VF/| 8 (2)
1 ; ChGwE (3)
| 2| | Commert foa=asdidesTat ] iy
| 3| | (Date: 200479727 ) %) 5
L4l (Time— FARERE]  I— ( )
| 5| | (Frocessing . SUNGSEFO ) (TZ)(G)
G\ | ([Warker SIS 8X8] )
| 7] (7)
g Mo \ Comment  (Tvpe ) @ 1001 2002 }——
3 i Ratio 46.433 45.0
10 B Ratio g/ 45108 45.9?3
11 | a3 Ratin 0 46911 46222 (8)
12 el Ratio o] 46512 46.593
9)
103 |Hi1 Ratio 1 1.002 0999 (10)
104 Hi2 Ratio T [OR=1E0] [OR=1E0]
105 | ~—F—— N J
106 [Assay Protocal]

o
~

Item Parameter  Waluel Yalue? Walued Yalued
<Measurement Parameter>
Protocol Name

E
[}
—
-_
-_
~

(=]
@©

110 Measurement1 Exi Em

111 Measurement Ex480:Em540 / Ex480-Em540 15t Data

112 Samples 121

113 Interval Mode Single

L et 1o T 4 %
(1) Header

(2) Plate Data File Name : To describe a file name of data.
(3) Comment : To describe an input comment.

(4) Date : To describe data when data is acquired.

(5) Time : To describe time when data is acquired at the date.

(6) Mark1 : To describe when marking is put during measurement.

(7) Sampling Time : To describe sampling time (Unit: ms) and shows time axis|
(8) Data : To describe measurement data.

(9) Type : To describe data item.

(10) No. : To describe Well number.

(11) Footer : To describe the assay protocol information.
(12) Processing: To describe data processing information.

When the number of markers increases, the record is added
below ‘Mark1’.
Note that the below rows are shifted down.
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<Plate Format data format>

It is tab-delimited base. Data is saved with a plate format at below header part.

(1)
e o o e F & (2)
1 ([Data File NG ¥FO5SDATAYDAT A¥checkitwell ) (3)
2 ([Comment fdasasdfdasfdaf } (4)
3 ([(Date . 200473727 } (5)
4 Time . 211543 } (12)
5 [Processing SUNC SB,PC I (6)
[[Marker : [e]eR eXe] } (/)
7 . (13)
8 | (Tyee ) [Not IntegRatio) Calc.Range 1 < 1§ @)
] Mo, [ i Z 3 7 5
10 A 4751 (A¥X=E 2] Lo e A A SRS
11 B 2218843 274672 3345949 3855.046
12 G 2618.715  2872.754 3578.778 4521.052 (9)
13 D 2775145 3213551 4077551 4534812
14 E 2502151 304815 3513521 3988752
15 F 2837.454 36843 4266668 4404845
16 G > 3333756 3842554 4181.989 5026.196
17 H 3392824 2EA2 02T A0S 05 ASGT 184 (1 0)
18
19 [Assay Pratocol]
20 Item Parameter YWaluel Yalue? YWalue3 YWalue (1 1)
21 Measuran —
22 Protocol Mame
23 WMeasurement Mo 1Ex1 Em
(1) Header
(2) Plate Data File Name : To describe a file name of data.
(3) Comment : To describe an input comment.
(4) Date : To describe data when data is acquired.
(5) Time : To describe time when data is acquired at the date.
(6) Mark1 : To describe when marking is put during measurement.
(7) Type : To describe data item.
(8) Column : To describe column number of well
(9) Data : To describe measurement data.
(10) Row : To describe row number of well.
(11) Footer : To describe the assay protocol information.
(12) Data processing : To describe the data processing information
(13) Calc.Range : To describe range of calculation
When the number of markers increases, the record is added on right
side of ‘Mark1’.
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<Group Data Format>
Group data format is TAB separated text data.

Consists of Header part, Group data parts, IC/EC value, and well group information

part showing in plate format.

(1)
/T al E | B [ D ] E | 2)
1 (Data File Name C¥FOSSOAT AYDAT A%Che ckifiwell
2 Corarmernt TEST Comment ) (3)
3 [_De‘te - 2014 00 | (4)
4 (T 16:45-0 } (5)
5 |F'mcessing : I (6)
(Marker 00:20.0 } (7)
7 (8)
| & | Myee . ) Mo Integ Ratio | Calc Range © All ranges =
| 9 | Group MNg. [Concentration | Units Mo.1 Max. Ratio | Stancard Devmlz— (10)
10 ] Me gativeContro ot ErEdd -
11| |Groupe 10/ uM 0.047
112 ] Groupds 100 uh 0335
13 | |Groupod 1 mh 0.69 (11)
14|  |Groupos 10/ mh 0.806
1 15 | Groupds 100 mh 1.082
116 | |Groupod 1M 1.338
17|  'sroupd 10/M 1.265 (12)
18
18| [orEcso 4314132 uM ] (13)
20 |
121 | Group Map —
22 | |Mo. 1 2 3 (14)
| 23 | A I A I A I A MagativeContral I
24 =] I A I A I A Groupds &
o5 : RIS A RIS A RIS A T 7
(1) Header

(4) Date
(5) Time

(2) Plate Data File Name

: To describe a file name of data.

(3) Comment : To describe an input comment.

: To describe data when data is acquired.
: To describe time when data is acquired at the date.

(6) Data processing

To describe the data processing information

(7) Marker : To describe when marking is put during measurement.
(8) Type : To describe data item.
(9) Calc.Range : To describe range of calculation.
(10) Column

: To describe type of calculation.
(11) Calculation value

: To describe calculation value.
(12) Row : To describe row number of group.
(13) IC/EC Value

: To describe value of IC/EC.
(14) Group Map

: Well group in plate format.

When the number of markers increases, the record is added on right
side of ‘Marker’.
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3) Graphs printout (Print Out command)

Clicking ‘Print Out’ command from File menu leads the following pop up menu when

Plate data is loaded.

Protocol  Wiew Setup Help

Open Plate Data.. aag]

s
Text Out Data.. l Manual Cir| (1)
Print Ciut
Save by Bitmap  # (2)
I
(1) All Wells Graph... : To print out all wells graph.
(2) Zoom Graph... : To print out remark graph.

Clicking ‘All Wells Graph’ command or ‘Zoom Graph’ command leads the following box
(Windows printer box) . Specify a printer type to be used and click OK to execute
printout. Graph items which are set at ‘Select Graph’ are printout. Clicking ‘Cancel’

cancels operation and goes back to the original screen.

Prirter

Harme: $45WR17_DELLYSLP-8700NEPSON

Status: Feady

Type: EPSOM LP-8700
‘where:  WA\LP-BFOMEPSON
Comment:

[~ Print ta file

Frint range Copies

cu (2)
c I
- LIl

@)\ @

(1) Printer name : To specify a printer to be used for printout.
(2) Copy : To set how many copies are printed.
(3) OK : To execute printout.

(4) Cancel : To cancel operation and go back to the original screen.
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4) Save the display (Save by Bitmap command)

Clicking ‘Save by Bitmap’ command from File menu leads the following pop up menu.

e HEEdY o
Text Out Data.. l Manual Gtrl
Print Out [ R— (1 )

Save by Bitmap All Screenz..

(1) All Screens :To save the whole screens.
(2) All Wells Graph :To save all wells graphs.

(3) Zoom Graph :To save a remark graph.

(4) Microplate Display :To save a microplate display.
(5) Diagram :To save a diagram.

(6) Live Image :To save a live image window.

(7) Live Microplate Display:To save a live microplate display.

Clicking each command from the pop up menu leads the following box.

Set Save in and a file name and click OK to execute saving.

saveas 21x
Bave n | < AR E| (1)
004 _ALLSCREEMS. BMP
004 _DIAGRAM.BMP (2)
004 _PLATEDISP.EMP
004 _Z00MGRAPH. EMP
TEMP_ALLWELLS.BMP
(3)

(4)
File name: [TEST_ALCWELLS BFMP | Save |/_ (5)
Save as ype: IBitmap File [*.BMP] ;I [ Cancel ll

i

(1) Save in : To set a folder where a file is saved
(2) File list : To show a file list in the current folder
(3) File name : To set a file name

(4) Save : To save the display

(5) Cancel : To cancel operation

HAMAMATSU PHOTONICS KK

90



FDSS7000EX/uCELL Software Instruction Manual Ver.2.9.3 72360301-04

5) The graph is displayed to new Window
(Display Graph in new window command)

The whole screen, all wells graphs, a remark wells graph, a microplate display, a
diagram,a live image window and a live microplate display are displayed in a new
window.

Clicking ‘Display Graph in New Window' command from File menu displays the
following pop up menu.

Text Out Data..
Print Out
Save by Bitmap
Dizplay Graph in Mew Window
Copy Graph to Clipboard H R G ) — 1 (2)(3)
Batch Export.. (_Zoom Graph. )=
et (CMicroplate Display.. ) (4) (5)
- Chlagram._— )
NN
‘ (T ek tae——— (7)
(1) All Screens :To display the whole screens in new window.
(2) All Wells Graph :To display all wells graphs in new window.
(3) Zoom Graph :To display a remark graph in new window.
(4) Microplate Display :To display a microplate display in new window.
(5) Diagram :To display a diagram in new window.
(6) Live Image :To display a live image window in new window.
(7) Live Microplate Display:To display a live microplate display in new window.

Clicking each command from pop up menu displays the following new window.
This window is always displayed in top most.

=31 New Window

Usual graph displa
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6) The graph is copied to the clipboard
(Copy graph to clipboard command)

The whole screen, all wells graphs, a remark wells graph, a microplate display, a
diagram,a live image window and a live microplate display are copied to the clipboard of
Windows.
Clicking ‘Copy Graph to clipboard’ command from File menu displays the following pop
up menu.

Sy | | N
Dizplay Graph in Mew YWindow  »

Graph to Clipboard (1)

Batch Export... (CATWel Graph. )| — (2)
Camga ———,
n T . f— )
— (6)
(1) All Screens :To copy the whole screens to the clipboard.
(2) All Wells Graph :To copy all wells graphs to the clipboard.
(3) Zoom Graph :To copy a remark graph to the clipboard.
(4) Microplate Display :To copy a microplate display to the clipboard.
(5) Diagram :To copy a diagram to the clipboard.
(6) Live Image :To copy a live image window to the clipboard.

(7) Live Microplate Display:To copy a live microplate display to the clipboard.

Clicking each command from pop up menu copies the selected graph to clipboard of
Windows.
The copied graph image can be used by doing the paste with other software.

92
HAMAMATSU PHOTONICS KK



FDSS7000EX/uCELL Software Instruction Manual Ver.2.9.3 72360301-04

7) Output of two or more data(Batch Export command)

Clicking ‘Batch Export’ command from File menu leads the following window when
Plate data is loaded.

<Setup Batch Export Box>

0
Falder Name ({5 G#FOSSDATASDATAY F
Flste Name  © [ Date = [ Plate Gomment A
13 2005710721 1447
51021014 2005/10/21 1525 (2)
051021015 2006710721 16:31 B
05102106 200510421 1754
051024000 2006/10/24 0949
051024001 2005/10/24 0953
051024002 2006/10/24 11:09
051024003 2005/10/24 11:25
051024004 2006710724 11:34
051024005 2005/10/24 17:35
051024006 2006/10/24 1740
051024007 2005/10/24 17:45
051024008 2006/10/24 1760
051024009 2005/10/24 1755
051025000 200510425 10:05
051025001 2006/10/25 10:23 (7)
peplonn: 200510725 1028 S
i 1 ®)
5) T T 9)
A pracesaie ) || (@ Ghanee Hit & Cale. Paran) [ duwanTex 0w /1(C iy
(3) —— (10)
(Setup Frocessing ) [ Setum it & Gale Param. || [ setup Text out ) || (Lsetup Graph owt J7]
(4) — (12)
(6) [| Start || GCancel ]’
—
(11)
(1) Folder Name : To set a folder where a file is saved
(2) File list : To select a exporting file
(3) Processing : To set On/Off of the data processing

(If ‘Setup Processing’ is done, it becomes effective)

(4) Setup Processing
: To set parameter of the data processing

(5) Change Hit&Calc.Parameter

: To set On/Off of the recalculation when data is output

(If ‘Setup Setup Hit&Calc.Param’ is done, it becomes

effective)
(6) Setup Hit&Calc.Param.

: To set parameter of hit well analysis and calculation
(7) Output(TextOut) : To set On/Off of a text output

(If ‘Setup Text Out’ is done, it becomes effective)
(8) Setup Text Out : To set parameter of text out
(9) Output(Graph) : To set On/Off of a graph output

(If ‘Setup Graph Out’ is done, it becomes effective)
(10) Setup Graph Out : To set parameter of graph out
(11) Start : To start to output data
(12) Cancel : To cancel operation
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(7-1)About setup Processing

In the setup processing, Setup for On/Off of each data processing and re-setup of
parameter can be performed. In the case Setup processing is selected, the
following box is displayed. In order to reflect this setup, put check in Processing in
Setup Butch Export and then start.

<Setup Processing Box>

Setup Processing
TCEESITE 1o 11111
|:| 2 3 4 5 B 7 8 E}
twadr | | | | [ | || ]
e et | | | |

10

Select Group‘

(7)

(1) Processing : Set up for On/Off of the each data processing
S.U. = Spatial Uniformity Correction
N.C. = Negative Control Correction
S.B. = Subtract Bias
P.C. = Positive Control Scaling
(2) Select Group : Select well group and set up
Group List = Selectable group is shown here.
Select the group and setup well configuration on the plate
well display.

Setup Group = Add, delete, edit Group
(3) Spatial Uniformity : Setup of reference range for use of S.U. (Set up of
sampling number)

(4) Negative Control  : Setup of basis area for use of N.C. (Set up of sampling
number)
(5) Subtract Bias : Setup of Bias range (Set up of sampling number)

Minus Clip can caluculate‘Q’if the value is minus after
being subtracted
(6) Positive Control : Setup of calculating area for used in P.C.
(Set up of sampling number)
(7) Selection display : Selection display of well.
(8) OK button : After reflecting the setup, to finish
(9) Cancel button : After deleting the setup, to finish
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(7-2) About Setup Hit&Calc.Param.

To set condition parameter for Hit well function and the area for Integral value and
Max value., then click ‘OK’ to turn effective.

(Refer to 7-2-1 in Chapter10)

To reflect this setting, it is necessary to put the check in Hit&Calc.Parameter of
Setup Batch Export box. And then clock OK to execute Start.

<Hit & Calc.Param. Box>

Setup Table
Ratio:Denominator |1st Samp. Point | #efisamp ~| oK |
Hit Well : Integral Ttem  [Ratio - ok

Hit Well: Seloot Pask [ =]
G/EC (80 =] uses |Mol Data ~ | < Ratio | Max >

Hit Y|l Range

I~ Inteeral = =)
I T M = =
I~ Ditesral = =
™ Mo Max I e

< Mol Data »

‘ < No2 Data >

T = =
H = =
S ¥ Ensble Output Nol Data
|~ Baseline (nteeratMax MinAv.Max-Min)
| | ¥ Enable SubBaseline
i [ TolstDispense Start |l 4 3
End |1 ‘ |
| eers! Ranes
[ All ranees Lzl |
kil I
Range
1ol rees [ 4 A |
Kl I
Average Range
¥ Al ranges | i
K| |
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(7-3) About Setup Text Out

Name a file and set Output items, then click ‘OK’ to turn effective.
To reflect the setting, it is necessary to put the check in Output(TextOut) of Setup
Batch Export box. Then click OK to execute Start.

<Setup Text Out Parameter Box>

m

& Each Plate File e (8)
to a file ( 1 )
O
utput em Vi (2)
Raw Data 3
I~ Ratio [~ Ex4BOEmB40 [ [~ Integ. | [ with Sep. File Use Azcay Protocol |J=g—— ( )
Plata-F. + Diad
Hit Wells I” Hit ()
Ratio [~ Maxt [~ Min [ Av. [~ Max-Min [~ Intee.
ExASEm540 [~ W& [ Min [ Av. T Max-Min [~ Intee. [~ Rat Max
Ex4B0Em540 [ ki) B B [Ci%
Group Data ]
[ ™ Group Data D) (5)
Raw Data & Flate Format Data <Footers ] (6)
[~ Azcay Protocol J

(1) Filename:
Each Plate File : To create Text file at each data. TextOut file is named
by Plate File name.
Add to a file : To output plural data with a text format into one file.
TextOut file is named by input characters in the field.
(2) Raw Data: To set output items with a text format at Raw data format.
With Sep.File : Raw data of each item is output with another file.
(3) Use Assay Protocol: To choose items which are set at assay protocol setting box.
(4) Plate Format Data : To set items to be output at TextOut<Plate>.
Hit : Hit data with Hit well analysis function for Max and Integral parameter.
Ratio : Ratio value dividing Fluorescence No1 intensity by Fluorescence No2
Intensity at 2-wavelength excitation or emission measurement.
Or, Ratio value dividing Fluorescence No1 intensity by initial value of it.
Fluorescence No1 (Luminescence): Intensity of Fluorescence No1.
Fluorescence No2: Intensity of Fluorescence No2.
Integral : Integrated value of intensity or ratio, which is set at ‘Calc. Param’.

Integ. : Integrated value.

Max : Maximum value.

Min : Minimum value.

Av. : Average value.

Max-Min : Maximum-Minimum value.

Rat.Max : Intensity value at maximum value point of Ratio at 2 excitation

or 2 emission measurement.
(5) Group Data
: Check “Group Data” to output group data IC/EC Calculation.
(6) Raw Data & Plate Format Data <Footer>
: To set the assay protocol information at the footer part of text data.
(7) OK : To set output parameters and to proceed to next step.
(8) Cancel : To cancel operation

96
HAMAMATSU PHOTONICS KK




FDSS7000EX/uCELL Software Instruction Manual Ver.2.9.3 72360301-04

(7-4) About Setup Graph Out

In the Setup Graph Out, how to output all of graph can be performed. When Setup
Graph Out is selected, the following box is displayed. In order to reflect this setup,

put check in Output(Graph) in Setup Batch Export and then start.

<Setup Graph Output Parameter Box>

Setup Graph Output Parameter

=elect Method
[v Print Out [~ Save by bitmap

o -

=elect Graph
[ [v Ratio [w Ex480:EmB40 [ [ Intee.

:

W Az
" Default Scale ¢ Auto Scale

(1) Select Method : To select how to out-put graph from print-out and
Bitmap image.

(2) Select Graph : To select the graph to print-out

(3) Y Axis : To select how to display Y axis when printing out

(4) OK button : After reflecting the setup, setup finish

(5) Cancel button : After deleting the setup, setup finish
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8) FDSS software quitting (Exit command)

Click ‘Exit command from File menu to quit FDSS application software. The system

starts moving for the termination.
When a plate is set inside a dark box, automatically it is loaded out and then the

following massage box appears. Take out the plate and click ‘OK’ to close the software.

FDSS7000/uGELL 3

The assay and the ligand plates were taken out outside,
Please push .k, button after taking out plates.

See you next,

For FDSS7000EX.
When the head and tip is installed, the head and tip is removed, the door of the

dispenser opens, and the following message is displayed.
The head and the chip are removed. The OK button is pushed.
(This processing might not be done by the setting. )

EFDSS Dispenser

! E Fleaze take out the head and the tip.
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7. View menu

To set ON/OFF for Tool bar and Status bar.

<Command> Clicking ‘View menu’ shows the following command list.

¥ FDSST000EX/uGELL <Fura? [384wells

File  Protocol [ Setup  Help
« Toolbar.. 4
Open Data « Statuz Bar.. =
1 2 ZoamdUnzoom Graph.. B
I N
Toolbar : To set ON/OFF for Tool bar.
Status Bar : To set ON/OFF for Status bar.
Zoom/Unzoom Graph : To select Zoom/Unzoom Graph.
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1) Tool bar (Tool Bar command)

Tool bar is shown as below. The frequently used commands such as Open Plate Data
and Assay Protocol setting box open can be easily chosen to execute. Clicking Tool
Bar command in View menu can switch tool bar to be displayed or not displayed.

¥ FDSST000EX/uGELL <Fura? [384wells] > - [C:¥

File  Protocol Wiew Setup  Help
@' El nEg ] fzzay Plate |
[Dpen Data Protocol Manual Cirl '
1 2 & 4 5 G 7
I ./ ! /! [ []
Tool bar
<Toolbar>
= [ eag
Qpen Data Protocol Manual Cirl
(1 @ 3)

(1) Open Data
(2) Protocol
(3) Manual Ctrl

: To load Plate Data (Measurement data).
: To set an assay protocol and start data acquisition.
: To export data with a text format when data is loaded.

2) Status bar (Status Bar command)

Start bar is shown as below. It shows the explanation of menu / command. Clicking
Status Bar command in View menu can switch tool bar to be displayed or not displayed.

=1
B
=

A1 1681 on
A8 1654 i

a8 1721 07

1903 081

AT 1835 050

A2 163 07

Bl 1400 64

B2 143 i

B3 1553 06

Bt 1615 o

Wi ~ =

(= )

\ Status bar
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3) Zoom/Unzoom Graph (Zoom/Unzoom Graph command)

Clicking Zoom/Unzoon Graph command from View menu leads switching the ratio of
display between all wells graph display and remark graph / correlation chart.

Switch

g E
i

- gl m™ o> wwm
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8. Setup menu

Used to acquire correction data, plate PRI, filter combination position and data folder
assignment. All commands are protected by a password. Please inquiry to
management supervisors.

<Command>
Clicking Setup menu shows the following command list

P FDSSTO00EX/uGELL <Fura? [384wells] >

Filze  Protocol  Wiew
Supervizor Paszword Eile  Brotocol  Yiew belp
= Flate | Supervizor Pazsword "
ate

Microplate Mappine... Open Data Protoct

Open Data Protoct
g Microplate Mapping...

Auto Fluorescence...

Shadine... — Diark..

Shadine... [

fz=zay Protocol File Assay Protocol File

i Filter Combination... [ Filter Gambination
File Name I‘F Port.. File Hame I’F Part. n

<At luminescence [Analog][EMCCD] measurement>

Supervisor Password : To input a password to cancel restrictions for commands.
Microplate Mapping : To set ROI for a measurement plate.
Auto Fluorescence : To acquire auto fluorescence correction data.

(At fluorescence)

Dark : To acquire dark correction data.
(At luminescence [Analog][EMCCD] )
Shading : To get shading correction data.
Filter Combination : To set filter combinations.
I/F Port : To set control ports for related devices.
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1) Supervisor Password (Supervisor Password command)

Clicking ‘Supervisor Password’ command in Setup menu leads Supervisor Password
input box. Authorizing a password can enable commands available. Please inquiry a
password to management supervisors.

Supervisor Password

(1) ——(ID [FDSS ]
(2) ——(F‘asswnrd | ] l — ()
(1) ID : Toinput ID (‘FDSS’ has been input as default.).
(2) Password : To input password.
(3) OK : To execute authorization. If faulted, an error message
appears and it comes back to this screen.
(4) Cancel : To cancel operation.
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2) Microplate Setup (Microplate setup command

Below “Registration of Plate”window will show up when you select “Microplate Setup

Command’from the Setup Menu.
This window box is to register the information of the plate which is going to be used in

FDSS Software.

<Registration of Plate window >

Reeistration of Plate

1) —
(1) [~Gelect Pate | I-] g
(2) 1T late Mame |: £ 4 J \' (10)
(3) _,/faram,-"Oorr. Filename |Greiner J
late Map Mame |Standard j
@
(5) 7 Lid_ Pt Al A Chart related to height \
Thickness & Mormal " ThintHalf}
{1} Height on bottom 30 mm u u a0
(2) Height under bottom |29 mm
for PhotonGaounting @ j
(6) —_ e place used )\
v fzzay Plate [ Ligand Plate Mo3
[~ Ligand Loader Y, L (9)
Cancel |
(1) Select Plate : Choose the plate name to edit
Select ”_NewPlate” when creating new plate name.
(2) Plate Name : Plate name will appear here. Input plate name when this is for

new plate created by ”_NewPlate”
(3) Param/Corr.Filename
: Set the name of Parameter or Correction file used for this plate.
Normally, the plate name related file name is used.
(4) Plate Map Name
: Set the Plate Map Name used for this plate. Normally use
“Standard”in common with other plates
(5) Parameter : Configure each parameter of the plate here.
Lid : Choose “Use lid” or “No use lid”
Thickness : Set the plate thicknes in (1) and (2)
(1)Height on bottom
: Distance between well bottom and the plate skirt bottom.
(2)Height under bottom for PhotonCounting
: Distance between under the well bottom and the plate skirt to define
the position of the Photon Counting sensor to be connected on the
plate bottom.
(6) The place used : Check the position this plate being used.
(7) Registration Button
: Register with currently shown configuration.
(8) Delete Button : Delete the current plate information and configuration.
(9) Cancel Button : Cancel the edit of the information of the plate.
(10) Close Button : Stop registration and close the window.
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3) Microplate Mapping (Microplate mapping command

The available area for each well is set by ROI setup.
Clicking ‘Microplate Mapping’ command in Setup menu leads Setup Microplate ROI box.
It sets ROI (Region Of Interest) for wells at measurement.

<At fluorescence/ Luminescence[Analog][EMCCD] measurement>

Setup Microplate Mapping

(1 ) Mappine File Standardd=4 FRET EM.ROI

FUrrriat
(2) [ & Sfwells O 0

(3) _[ - o Gzl
@ —

L 18 e 18

(=S TNTE=

) Y ——T

. [ 18 vi[ T

—
(6) [l_ J:[lﬂ Fosition LIE'J Regist j
(7) ——( it Data]] Gl ] |~ (12)
(14) / Tt TFreshold = &7 x [100 \ m

<At luminescence [Photon Counting] measurement>

©)

=

Start Fll'ﬂ.lk:l!l\:ﬂ] ( Calcubation ] éStop Acquisition |
- | H

[hl Theeshold [T ;] , Cancel o | |
(14) | (11) - (10)

(1) Mapping File : To display a file name of ROI data to be created/ edited.

(2) Format : To display a plate format
(3) Form : To display ROI form (shape) corresponding to well shape.
(4) ROI Size : To set the size of ROI. Basically X and Y should be the same number.

(5) Real Well Size(At fluorescence measurement)
: To set actual well size. (Refer to 3-3)
(6) Position : To tune finely a ROI position. It is registered with Regist button.
(7) Acquire Data (At fluorescence measurement)
: To acquire image of plate.
(8) Calculation (At fluorescence measurement)
: To execute calculation.
(9) Start Acquisiton (At luminescence [Photon Counting] measurement)
: To acquire Photon Counting image of plate.
(10) Stop Acquisition (At luminescence [Photon Counting] measurement)
: To stop acquisition.
(11) Calculation (At luminescence measurement)
: To execute calculation.
(12) OK : To register created ROI data.
(13) Cancel : To cancel operation.
(14) Int. Threshold : Threshold level at binarization
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(3-1) ROI data creation

<Sample for shading correction data>
The sample for ROI data should be ideally bright enough to distinguish wells easily
and should not include unnecessary spots.

Click Microplate Mapping command in ‘Setup’ menu.

P FDSSI000EX/UGELL <Fura? [384wells] >

File Protocol  Wiew Help

= []

pen Data Pratoce Microplate Mappine...

s e e
|E b -aLar Auto Fluorezscence..

—~

Supervizor Pazzmord

[ Set plate map setting plate. ]

\ 4 \ 4
<In the case of FDSS3000/6000/7000EX> <In the case of uCELL>
Plate map setting plate loaded in. Plate map setting plate loaded in.
Set the plate onto the stacker and click Click Access button in Dispenser Control box
Load button in Dispenser Control box. and set sample plate.

Dizpenser Gontrol

Digpenser Gontrol

Access button

= Load button P |

TH1+Staes1 | THI+Stage2 | THI+Stagen | THI+Stage2 |

fizzay Plate

THi+Staee | THi+Staze2 | THi+Stage3 | THI+Loader |

Dizpense Start Nozzle Wash
| Dispense Start Mozzle Wash ‘ Detail.. | ” | 2
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l l

Plate image acquisition

<At fluorescence measurement & Luminescence [Analog][EMCCD] measurement>
Set Sensitivity a certain value in Camera Control and click ‘Acquire Data’ in Setup
Microplate ROI to acquire an image for ROI setting.

3 E

Live
Live O Live Off

Live Imase Window...

Sensitivity

(== 3 ’ = }—— Set Sensitivity a certain value.
Setup Microplate Mapping
Mappine File Standardd:x4. ROL
Format
® Honells O &
Form
o + Circle .
Set size of ROl so that the area can
ROI Size . I R f t (3 3)
P T J/ cover signal area. rerer 1o (9-9).
Peal Well Size

Set size of actual well. Refer to (3-3).

we [ 17 [ 1T }/_
|
|

Acquire Data JI {

Click ‘Acquire Data’ to start acquiring

fluorescence image for ROI setting.

<Luminescence [Photon counting] measurement>

Click ‘Start Acquisition’ in ‘Setup’ Microplate Mapping to acquire photon counting
images for ROI setting.

Bl oize

W 25 e 25

m——mﬂ‘l—"‘/__ Click ‘Start Acquisition’ to start acquiring
tart Acquizitio tlation

photon counting images for ROI setting.

Cancel

Acquiring Plate data

<Fluorescence measurement> Acquiring fluorescence images
<Luminescence[Analog] [EMCCD]measurement>

Acquiring luminescence images
<Luminescence[Photon counting]lmeasurement>

Acquiring Photon Counting images
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l

ROI Calculation

<At fluorescence measurement & Luminescence [Analog][EMCCD] measurement>
The following is shown after acquiring Plate data. Confirm it can distinguish visually wells

and background enough, and then click ‘Calculation’ after confirming the calculation is
executed.

Setup Microplate Mapping

Mappine File Standardd:d. ROT

Faormat
+ Ofwells ™

Farm

i * Circle

ROI Size

w. [ 18 v 18

Real Well Size

®. [ 17 v [17

| Acquire Dats [Oalculation]! ! Click ‘Calculation’ to execute ROI

calculation.
Cancel

<At luminescence [Photon counting] measurement >
The following is shown during Photon Counting image acquiring. Confirm it can
distinguish visually well and background enough in Photon Counting image, and then

click ‘Stop Acquisition’. And finally click ‘Calculation’ after confirming the calculation is
executed.

ML o

W 25 v 25

Click ‘Stop Acquisition’ to stop photon
counting acquisition.

i Stop Acguisition ‘

Click ‘Calculation’ to execute ROI
calculation.

Start Acquizition Calculation

Cancel

[ Creating ROI data. ]
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\

y

<At fluorescence measurement>
The following message might be displayed at two wavelength
fluorescent measurement.

In this case, please select the image of another wavelength, and make
the Mapping data for two wavelength.

nnnnnnnnnnnn

. \1) HIDDEROSEHFIRUT, 220ERHD Plate Map EFEFRLTIEE . .
[z v:[ 7z
T o I e $
[z v:[ 2
N o000 s00006000
o0 s00000000

Message Box of ‘Please create the plate
map of another wavelength~’

\ Please select the another wavelength —

The following appears after ROI setting calculation. Confirm on the images whether each
ROI covers each well correctly and then click ‘OK’ to register ROI data.

FDSS7000 uGELL

/AN

The RCI file which already exists is updated.
Is it all right?

Cancel I
J

Click ‘OK’ to register ROI data.

A

y

A\ 4

<In the case of uCELL>

<In the case of FDSS3000/6000/7000EX>

Plate map setting plate loaded out
Click Unload button in Dispenser Control box.

Dispenser. Control

Azzay Plate

Unload button

Unload |

THI+Staee] | THT Staze2 | THI*Stages] THi+Loader |

| Dispense Start MNozzle Wash | Detail.. | ”

Plate map setting plate loaded out
Click Unload button in Dispenser Control box
and take out sample plate.

Dispenser Control

Access I‘

TH1+Stagel | THI+Stoge2 | THI+Staget | THI+Stage2 |

Access button

Azzay Plate

[ Finish

!
)
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(3-2) File name of ROI data

A file name of ROI data is automatically named by a plate type which is chosen at
Plate Select bar and camera parameter (binning) which is set to be used for
measurement. Please confirm a plate type and camera condition before ROI data
creation. At an assay protocol setting box, correction data is automatically picked up
depending on a plate type and camera.

(3-3) Real Well Size (At fluorescence measurement & luminescence[EMCCD]

measurement)

ROI size is sometime set bigger than actual well size because of vibration mixing
function or device allowance. Output data of one well is an average value in one well
and it is shown as below:

Intensity of one well = Total intensity within ROl / ROI size (Pixel number)
However, depending on measurement condition such as vibration mixing function,
smaller intensity value may be output than actual one. So, FDSS application software
has one parameter ‘Real Well Size’ to set ROI area flexibly.

“Real Well Size*“ = Actual well size (Unit:Pixel)

For example, when set (X,Y)=(12,12) in case actual well size is (X,Y)=(10,10), “Real
well Size* is “10”.

ROl size (12,12)

Well size (10,10)

Intensity in well =1000

Total intensity / ROl size = 1000x(5x5x1r) / (6%6%T)

'

Total intensity / Well size = 1000x(5x5x1) / (5x5x1T)
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4) Auto Fluorescence / Dark (Auto Fluorescence/ Dark command)

Plates themselves have auto fluorescence and the characteristic depends on plate
types and manufacturers. FDSS application software can have correction data to
eliminate the auto fluorescence which affects measurement.

Clicking ‘Auto Fluorescence’ command in Setup menu leads Setup Auto Fluorescence
Data box. It creates, edits and displays auto fluorescence correction data. This
command is available only at fluorescence measurement & Iuminescence
measurement [Analog][EMCCD].

Setup AutoFluorescence Data

( 1 ) [Piutn Fluorescence File | Greiner Bx4ExpllFAF J
Format
(2) l (v Dfwells © ] (4)
(3) —f Pre fcouire ]H[ ficquire Data } Save — (5)
— ) o
(7) mpart Data | =anee (6)
Display Sencitivit \ (9)
(10) — 4| 0
Well No—-Ex340-Emba T Ev38iEmmdn [~
(1) —m 000 000
0.00 0o
3 000 0.o0
Ad 0.00 0.o0
AS 000 0.oo
Al 0.00 0.o0
Al 000 0.oo
A 0.00 0.o0
g 000 0.oo
A10 000 000
Al 0.00 0o
A12 000 000
E1 0.00 0o
B2 000 0.o0
B3 0.00 o.oo
B4 000 0.o0
ES 0.00 0.o0
=5 000 0.oo
E7 0.00 0.o0
B2 000 0.oo
E9 000 000
E10 0.00 0o
E11 000 000
31k nmn nnn A
Well Mo, [ Ex340:EmE40 | ExasD:Em540 [
werage  0.00 0.o0
M, 0.00 0.o0
Mix 000 o.oo

(1) Auto Fluorescence File
: To display a file name of correction data to be created/ edited.
(2) Format : To display a plate format
(3) Pre Acquire : To check a fluorescence image before acquiring correction data.
(4) Acquire Data : To acquire an auto fluorescence image and create auto
fluorescence correction data.

(5) Save : To register correction data which is displayed.
(6) Cancel : To cancel operation.
(7) Display Current Parameter: To display the original registered correction data.
(8) Export : To export correction data which is displayed to Excel file.
(9) Import : To import correction data which was exported and edited
to/in Excel.

(10) Display Sensitivity : To switch Sensitivity to show correction data.
Correction data is acquired at each Sensitivity.
(11) Correction data display : To display acquired correction data
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(4-1) Auto fluorescence/ Dark correction data creation

<Sample for auto fluorescence/Dark correction data>
The sample for correction should be prepared ideally under the actual measurement

conditions like the same plate, filter and buffer quantity/type.

File  Protocol  Wiew Help

= (]

Open Data Praotoc

Supervizar Password

Microplate Mappine..

Auto Fluorescence..
Shadine

Choose Autofluorescence or Dark command in file menu.
1 FDSSTO00EX/UGELL <Fura? [384wells]

[ Set sample plate for correction

)

<In the case of FDSS3000/6000/7000EX>

Sample plate for correction loaded in.
Set the plate onto the stacker and click
Load button in Dispenser Control box.

Digpenser Gontrol

Load button

fzzay Plate

THi+Staee | THI+5taze2 | THi+Stage3 | THI+Loader |

Dispense Start Mozzle Wash ‘ Detail.. | ”

<In the case of uCELL>

Sample plate for correction loaded in.
Click Access button in Dispenser Control box
and set sample plate.

Dizpenser Gontrol

Access button

4
Access r

TH1+Staes1 | THI+Stage2 | THI+Stagen | THI+Stage2 |

fssay Plate

| Dispense Start Nozzle Wazh

1 -

Live
Live On Live Off
Live Image Window.

Senzitivity

Setup AutoFluorescence Data

futo Fluorescence File Greinerdx4Expl. PAF

Format

Pre fcquire

Check an auto fluorescence image of the sample plate
Set Sensitivity (Max) in Camera Control box. Click ‘Pre Acquire’ button in Setup

Auto Fluorescence or Dark Data box and get image data.

[ I ]_— Set sensitivity (max)

Click ‘Pre Acquire’ to check an image

| S

Dizplay Current Data Cancel

Import Data
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)

The following box appears after getting an image. Check whether it has unnecessary
bright spots by dusts. If it has, load the plate out and remove dusts. And then try again.
If not, click Acquire Data button in Setup Auto Fluorescence Data box.

72360301-04

Setup AutoFluorescence Data

Auto Fluorescence File Greinerdx4Exp0.PAF

Format
&+ Ofiwells

|[Femersa ) o | Click ‘Acquire Data’.

Display Gurrent Data

T T

Pre Acquire

Cancel
Import Data |

[ Acquiring correction data.

)

The following box appears after acquiring correction data. Click ‘Save’ and register the
data. It is registered automatically.

Setup AutoFlucrescence Data

#uta Fluorescencs Fils GreinerdxdExpl PAF
Format
& Gwells 5
Pre Acauire Acquire Data Save C I H k ‘S ) t H t
IC ave 10 register.
Export Data
Ganesl
Tmport Data |
Display Sensitivity
1 « v
..... U1
Well No_J €%340.EmE40 [ ExanEnteq [~
Al e 000 0.00 *e
Az e 0.00 000
g 000 000
%d. 000 000
5 000 000
6 000 000
a7 000 000
8 000 000
9 000 0
10 000 0
a1l 000 0
12 000 o
81 0.00 000
B2 000 000 .
B3 o0 000 D | th It
% o 30 ISpla eresu
5 000 000
6 000 000
a7 000 000
=] 000 0 &
89 000 Qoo .
810 000 o Q
o |BI11 000 aon i
4512 i fn Ed
| iell No._[ Ex340.Em540 | Ex380:Em540 R
Averge 000 000 B
Mz 000 000 .
Mic i... 000, e
--------
v \4

<In the case of FDSS3000/6000/7000EX>

Sample plate loaded out
Click Unload button in Dispenser Control box.

Dispenser. Control

Unload button

Azzay Plate Unload

THI+Staee] | THT 5taze2 | THI*Stages] THi+Loader |

| Dispense Start MNozzle Wash | Detail.. | ”

<In the case of uCELL>

Sample plate loaded out
Click Unload button in Dispenser Control box
and take out sample plate.

Dispenser Gontrol

Access l/

TH1+Stagel | THI+Stoge2 | THI+Staget | THI+Stage2 |

Access button

Azzay Plate

Finish

!
)
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(3-2) Import and Export for Auto fluorescence correction data

It can export auto fluorescence correction data to Excel and edit it there. And then it
can import the edited one back to FDSS application software.

Wells data position is fixed at Import and Export between Excel and FDSS

application software. Please just edit numbers with the fixed position and
don’t move data position.

FDSS application software can import active Excel data which is saved
once with any name. Don’t forget saving the data before ‘iImport’ clicking.

(3-3) File name of auto fluorescence correction data
A file name of correction data is automatically named by a plate type which is chosen
at Plate Select bar and camera parameter (exposure time and binning) which is set to
be used for measurement. Please confirm a plate type and camera condition before
correction creation. At an assay protocol setting box, correction data is automatically

picked up depending on a plate type and camera condition when correction is set
ON.
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5) Shading (Shading command)

Plates themselves have shading and the characteristic depends on plate types and
manufacturers. FDSS application software can have correction data to eliminate plate
shading which affects measurement.

Clicking ‘Shading’ command in Setup menu leads Setup Shading Data box. It creates,
edits and displays shading correction data.

<Sample for shading correction data>
The sample for shading correction should be ideally prepared under the actual
measurement conditions like the same plate, filter and buffer quantity.

Setup Shading Data box <At fluorescence measurement>

Setup Shadine Data

(1 ) —(‘Shading File Greinerdx4.PS0 ]
Enrmat
(2) o Ofwells i ] (4)
(3) Pre fcouirs l Boquire Data Save (8) ( )
(7) —( ] (Export Dats | [ P ]
aAnce
Import Data - { (6)
10 Wiell Mo, | Fx3A0F mB5A0 | Ex380 Enbdl [~ (9)
( ) Al 0.00 0.an
A 000 [ufuli]
000 o.aon
vl 0.00 0.an
A5 ] 0.00
AB 0.00 0.an
AT 000 [ufuli]
) 000 o.aon
AD 0.00 0.an
A10 ] 0.00
Al 0.00 0.an
A2 ] 0.00
El 0.00 0.an
E2 000 [ufuli]
E3 000 o.aon
E4 0.00 0.an
ES ] 0.00
Ef 0.00 0.an
E7 000 [ufuli]
E2 000 o.aon
E2 0.00 0.an
E10 ] 0.00
Ell 0.00 0.an
Ao nnn nnn o
Vel Mo. | Ex340:EmB40 | Ex38:EmE40 [/
Pdgrage 000 o.aon
It 0.00 0.an
Mix il .00

(1) Shading File : To display a file name of correction data to be created/ edited.
(2) Format : To display a plate format.

(3) Pre Acquire : To check a fluorescence image before acquiring correction data.
(4) Acquire Data : To acquire a fluorescence image and create shading correction

data.
(5) Save : To register correction data which is displayed.
(6) Cancel : To cancel operation.

(7) Display Current Data
: To display the original registered correction data.

(8) Export : To export correction data which is displayed to Excel file.
(9) Import : To import correction data which was exported and edited in
Excel.

(10) Correction data display
: To display the acquired correction data
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<Setup Shading Data box : Luminescence [Photon counting] measurement>

Setup Shading Data

(1 ) _Fhading File Greinerlx1 PSD ]

Format

(2) —-[ & Snelle O r ] 4)

/
(3) Aoquire Start l quire SIDp&Oalc %— (5)

n — e ©
mport ata (6)
!l Mo, | Ex0) (9 )
( 1 0) AT 000
A 0.an
000
4 0.0
5 o.aon
i 0.00
AT 0.an
e o.aon
A9 0.00
10 0.an
A1 000
12 0.0
E1 0.an
B2 000
E3 0.0
E4 o.aon
BS 0.00
Efi 0.an
E7 o.aon
B3 0.00
E2 0.an
B10 U DD w
>
Well No. | ExD |
verage 000
0.0
Iz 0.an

(1) Shading File : To display a file name of correction data to be created/ edited.

(2) Format : To display a plate format.
(3) Acquire Start : To check a luminescence image before acquiring correction data.
(4) Acquire Stop&Calc
: To acquire a luminescence image and create shading correction
data.
(5) Save : To register correction data which is displayed.
(6) Cancel : To cancel operation.

(7) Display Current Data
: To display the original registered correction data.

(8) Export : To export correction data which is displayed to Excel file.
(9) Import : To import correction data which was exported and edited in
Excel.

(10) Correction data display
: To display the acquired correction data
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<Setup Shading Data box : Luminescence [Analog][EMCCD] measurement>

Setup Shading D ata

(1 ) l Shading File | Nunclx14_S5*PSD ]

(2) | o = IB4wells

( .] @ ()
(3) | Fre Acouire ] [ ) :ﬂ[ i ]]_W
(7) _{ Display EunenlDal} H% [ Close D_W (6)

Change Sensitivity

COushon Diale
1 4 | 2007/07 /16 12:55
el | TOmFEEEReE ~ (1 1 )
(10) —#=
2 008
&3 0.2
£ 048
&5 0.37

A5 0.0z
a7 0.0s

Y 01s

49 026

410 033

211 0.02

412 026

#13 0.43

A14 012

415 0.08

A16 0.47

17 0.0z

18 0.06

413 0.0z

420 nzg

A21 01z

422 0.45

423 033 M
< | =

wiellNo. | Luminescence [
Ayerage 0.26
ax 1.14
0.00

(1) Shading File : To display a file name of correction data to be created/ edited.
(2) Format : To display a plate format.
(3) Pre Acquire Start
: To check a luminescence image before acquiring correction data.
(4) Acquire Data
: To acquire a luminescence image and create shading correction data.
(5) Registration : To register correction data which is displayed.

(6) Close : To close setup box.

(7) Display Current Data : To display the original registered correction data.

(8) Export : To export correction data which is displayed to Excel file.

(9) Import : To import correction data which was exported and edited inExcel.

(10) Shading Correction Data

: To display shading accruing value of shading correction data
(11) Change Sensitivity

: To change sensitivity.
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(5-1) Shading correction data creation

The sample data that has homogeneous fluorescence can be used to correct
nonuniformity on hardware and optics.

<Sample for shading correction data>
The sample for shading correction should be ideally prepared under the actual

measurement conditions like the same plate, filter and buffer quantity.

Click Shading command in Setup menu.

P FDSS7000EX/UGELL <Fura? [384welis]

File  Protocal  Wiew Help

El Supervizor Pazzword ! r

Open Data | Protoct  picronste Mapping..

Sl

F 55 Application [N 5— Shading button
Azzaw Pratarnl File

[ Set the sample for shading correction. ]

\ 4

<In the case of FDSS3000/6000/7000EX> <In the case of uCELL>

Sample plate for correction loaded in.

Sample plate for correction loaded in.
Click Access button in Dispenser Control box

Set the plate onto the stacker and click

Load button in Dispenser Control box. and set sample plate.

Dispenser Gontrol

Dispenser, Gontrol

Access button

Load button P R |

THi+Stagel | THi+Stage2| THi+Stage1 | THi+Stee=2]

fezay Plate

TH1+Staee] | Ti=Staze2 | TH1+Stage3 | THi=Loader |

| Dispense Start | Nozzle Wash | Detail.. ‘ ”

Nozzle Wash

Dizpense Start
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<At fluorescence measurement and luminescence [Analog][EMCCD]
measurement >
To check shading image of the sample plate. Set Sensitivity a certain value in
Camera Control box. Click ‘Pre Acquire’ button in Setup Shading Data box to
acquire image data.

o K|
Live
Live On Live Otf
Live Image Windov.

Sengitivit

1 5 10
==

Set Sensitivity

Setup Shading Data

Shading File Greinerdxd PSD

Format
 Dowelsh O £

[ﬁpmw J lI i Click ‘Pre Acquire’ to acquire
fluorescence image.

g GCancel

ImpnrtDatal

Dizplay Current Data

<At luminescence [Photon Counting] measurement>
To acquire shading image of the sample plate. Click ‘Acquire Start’ in Setup
Shading Data box to start acquiring photon counting image data. Integration
images are observed then.

Setup Shadine Data

Shading File Greiner1x1 PSD

Format
& Ponelld =

‘ ‘ Click ‘Acquire Start’ to start acquire

Garce| photon counting image data.

Display Gurrent Data

Import Data |

<Fluorescence measurement>
Acquiring fluorescence image for checking
<Luminescence [Analog][EMCCD] measurement>
Acquiring luminescence image for checking
<Luminescence [Photon Counting] measurement>
Acquiring Photon Counting image
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l

<At fluorescence measurement and luminescence [Analog][EMCCD]
measurement>
To Check after getting an image whether it has unnecessary bright spots by dusts
or not. If it has, load plate out and remove dusts. And then try again. If not, click
Acquire Data.

Setup Shading Data

Shadine File Greinerdxd PSD
Format
& Ofwells o

[remewe [ wmeme] . | Click ‘Acquire data’.

Cancel ‘

Digplay Current Data

Import Data |

<At luminescence [Photon Counting] measurement >
Click ‘Acquire Stop&Calc.’ to stop acquisition and to create shading data when
total image is homogeneous and doesn’t have unnecessary bright spots.

Setup Shading Data

Shading File Greinerlx1.PSD

Format
o Qbwells )

’—nmﬁ_ Click ‘Acquire Stop&Calc.’.
o] |
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l

register the data. It is registered automatically.

Setup Shading Data

<Fluorescence measurement>
<Luminescence[Photon Countinglmeasurement>

The following box appears after acquiring correction data. Click ‘Save’ and

Shading File Greinerdxd PSD Shading Fils Muncix1s, $~PSD
Format Format
H & ’ H (2 & 384mells ©
© Gnolls € el e Click ‘Save’ to register.
(I |
Prs Acqure ||} Acquire Data [ Save ]| SenSitiVit Chan es
Export Data y g Display Current Data | Expon Data] Close
Gancel Import Data |
o o JiROLData I Thange Sensiimiy
o® Se, Acquisition D ate
Wiell No_ ef® Ex340Em540 | Ex380:Ema40 [~ 1 4 gl 2007/07/16 1255
a1 000 000 .
2, 000 0o \¥
* D . wellNo. | L 220 ee, ~
[ 0o 0 .
M ki) oo . DISplay the result B AL
5 0o 0 A —
o 86 000 0 . e o8,
7 000 000 " - s
3 000 lifi o s
3 000 000 Sar 008
#10 000 0o A8 018
11 0o 0 A9 0.25
#12 000 0 A10 039
B1 0o 0 2l oo
B2 000 0
83 000 000 413 0.43
B4 000 lifi 214 o1
B5 000 000 &1 08
B8 000 0o e o
B7 0o 0 i s
B3 000 0 e o
| B9 000 0 20 029
.aw 000 0 A= 012
i1 000 il . o 522 0.45
BA nmn nn s, & 823 0.33 -
e lfedo. [ ExA40EmE40 | ExaenEmEdn,e | | x
fveraze, 000 [T weklla, [ Luminescence D
Max ‘-S,DU oo . Averagty | 0.25
Mix o, e * Max J.14 e
.......... Min EI'D].........‘..'

<Luminescence[Analog][EMCCD]measurement>

Setup Shading Data

Fluorescence/Luminescence[Photon
Countinglmeasurement
The relation is not in sensitivity,
and common correction data is used.

Luminescence[Analog][EMCCD]

measurement
It has the correction data of each sensitivity.
Sensitivity is changed and all the sensitivity
correction data is acquired.

\ 4

A 4

<In the case of FDSS3000/6000/7000EX>

Sample plate loaded out
Click Unload button in Dispenser Control box.

Dispenser. Control

Azzay Plate

Unload button

Unload

THI+Staee] | THT Staze2 | THI*Stagea] THi+Loader |

| Dispense Start MNozzle Wash | Detail.. | ”

<In the case of uCELL>

Sample plate loaded out
Click Unload button in Dispenser Control box
and take out sample plate.

Dispenser Gontrol

Access button

TH1+Stagel | THI+Stoge2 | THI+Staget | THI+Stage2 |

Azzay Plate

[ Finish

7
)
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(5-2) Import and Export for shading correction data

It can export auto shading correction data to Excel and edit it there. And then it can
import the edited one back to FDSS application software.

Wells data position is fixed at Import and Export between Excel and FDSS
application software. Please just edit numbers with the fixed position and
don’t move data position.

FDSS application software can import active Excel data which is saved
once with any name. Don’t forget saving the data before ‘Import’ clicking.

(5-3) File name of shading correction data
A file name of correction data is automatically named by a plate type which is chosen
at Plate Select bar and camera parameter (exposure time and binning) which is set to
be used for measurement. Please confirm a plate type and camera condition before
correction creation. At an assay protocol setting box, correction data is automatically

picked up depending on a plate type and camera condition when correction is set
ON.
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6) Filter Combination (Filter Combination command)

It sets filters and dichroic mirror combination and which combination should be shown
on Filter Control box. 10 combinations are set here and 4 of them can be operated in

Filter Control box

Clicking ‘Filter Combination’ command in Setup menu leads Setup Filter Combination

box.

@ This setting is saved and managed at each Measurement Method.

Setup Filter Combination

Dizplay Filter Set
Disolav  ExEi }m_LDM_EMH_\ Cancel
v 1 Shutter = || [EmB40/DMV  + |
™ v 2 340 || EmB40/DMV + |
v 3 380 || [EmB40/DMV + | (3)
4 Shutter v || [EmE40/DMLY v |
[ 5 Shutter v || [EmE40/DMLY v |
v 6 | |50 || [Ems40/DME  ~|
7 Shutter v || [EmE40/DMLY v |
8 Shutter v || [EmE40/DMLY v |
g Shutter v || [EmE40/DMLY v |
10 ) [Ghutter V}‘ mB40 DMLY -
B I — 4
(2) Ex Filter Exchanger Em/DM Filter Exchaneer —/ (5)
Waveleneth Ciambination ?ﬂ Filter Waveleneth
1 [ Shutter nm o1 | EmB40 DMLY Mol [ 540 nm
(4) - Mo.2 IW nm 0.2 EmbE65/DME Mo.2 IW nm (6)
Mo.3 lw nm 0.3 Em0/DME Mo.3 I—D hith
Mod | Shutter nm 0d Em0/DME Mod [ 0 nm
MoS | Shutter nm o5 | Em540/DME \—/
6 [ @0 R P
7 | EmO/DME e L (7)
\o8 Emo/ome ) | 02 B )
‘Display Filter Set’ Filter combinations are set.
(1)Display : To specify maximum 4 combinations to be operated

in Filter Control box.
: To set which excitation filter to be used for combination
: To set which emission filter and dichroic mirror (DM)

(2)Ex Filter
(3)Em/Dm Filter

A filter set in an excitation filter is set.
: To input wavelength of an excitation filter which is
employed in filter switching devices (999=Shutter).

‘Ex Filter Exchanger’
(4)Wavelength

‘Em/DM Filter Exchanger’ shows filter setting when a filter exchanging
device at an emission side.
: To display combinations between emission filters and
dichroic mirrors(DM) which are automatically combined.
(6)Em Filter Wavelength : To input wavelength of an emission filter which is
employed in filter exchanging devices.
: To input a dichroic mirror type which is employed in filter

exchanging devices.

(5)Combination

(7)DM Filter Type
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(6-1) Filter setting

Setting is needed in Setup Filter Combination command when a new filter is added or
changed.

Procedure

a) Excitation filter setting
Set to input wavelength of a new excitation filter into ‘Wavelength’ on ‘Ex Filter
Exchanger’.

b) Emission filter setting
Set to input wavelength of a new emission filter into ‘Em Filter Wavelength’ on
Em/DM Filter Exchanger”.

c) DM (Dichroich Mirror) setting
Set to input wavelength of a new emission filter into DM Filter Type on ‘Em/DM
Filter Exchanger'.

d) Filter combination setting
Set the combination between excitation filters, emission filters and dichroich
mirrors at ‘Ex Filter and ‘Em/Dm Filter’ in ‘Display Filter Set. And specify at
‘Display’ maximum 4 combinations to be operated in Filter Control box.

e) Setup Filter Combination command finish
Click ‘OK’ to set and finish ‘Setup Filter Combination’ command.

f) Assay Protocol change
Set again filters to be used at Assay protocol for new filter setting to reflect.

The filter combination setting effects on all Assay Protocol on the Method.

Be sure of Assay Protocol setting after any filter is added or changed.
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7) I/F Port (I/F Port command)

FDSS application software controls several devices and it can set serial ports for each
device.

Clicking ‘I/F Port’ command in Setup menu leads ‘Device Setup box'.

This setting is saved and managed at each Measurement Method.

Setup IFF Port

Serial Port

(1)
Dispenser l — (2)
TS . Ny

Filter! - G214 — (4)
Fiter2 - FRET (Nore =]~ ©

(6) __l ] 14 J [ Cancel ]__ @)

Camera

(1) Camera : To set a port for a fluorescence detector
(Fluorescence configuration).

(2) Dispenser : To set a port for a dispenser.

(3) Il Controller : To set a port for an I.I. (Image Intensifier) controller
(At luminescence configuration).

(4) Filter1 : To set a port for an excitation filter switching device
(5) Filter2 : To set a port for FRET filter switching device

(6) OK : To renew the setting.

(7) Cancel : To cancel operation.
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9. Help menu

Help menu shows version information of FDSS application software.

<Command>
Clicking ‘Help’ leads the following command.

¥ FDSST000EX/uGELL <Fura? [384wells] > - [Q
File  Protocol Wiew Setup B&EE

(= El L About F.DS_S"'__K Flate ]_

e R TR {E HETR 1w | o

About FDSS : To show version information of FDSS application software version.
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1) About FDSS (About FDSS command)

It shows version information of FDSS application software. Clicking ‘About FDSS’ in
‘Help’ menu shows the following box.

fAbout FDSS7000EX/uGELL

Qa[ FOS57000ERACELL Wer 2.9.%0
Copyright G 20042072 Hamamatzu Photonics KK (2)

/ﬁ:lule Name Date Wergion
FDSS Mov 16 2012 2950
IMAGS ORCADLL Mov 16 2012 2,950
IMACS TXDLL MNov 16 2012 2960
IMAGS_DISFENSORDLL Mov 16 2012 2950
IMACS COLORDLL MNov 16 2012 2950
IMAGS_ENHANCE.DLL MNov 16 2012 2960
CALCLABELDLL Mov 16 2012 29,50 (3)
DATAMONITORDLL MNov 16 2012 2950
IMAGS_RES.DLL Mov 16 2012 2950
FDSSTOOLDLL Mov 16 2012 2,960

(1) OK : To close the box.
(2) Software information

: To display version information of FDSS application software module
(3) Module information

: To display version information of each software module.
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10. Plate Data display and analysis

1) Over View

The following screen appears when measurement is completed. And it is also shown at
Plate Data is loaded. It can display, output and analysis Plate data.

}‘i ererepyae s v A=

(1) All wells graph display
: To display all wells graph data. Single remark graph is chosen here.
(2) Remark graph display
: To display single remark graph and specified graph by Hit analysis function
with anoverlay.
(3) Correlation diagram display
: To display correlation diagram between Ratio (Fluorescence
measurement) / Intensity (Luminescence measurement) and Integral.
(4) Micro plate display
: To display Ratio/Intensity/Integral on the specified sampling line with
pseudo colors.
(5) Calculation result table
: To display calculation results such as Max, Min, Av. and Max-Min.
Group calculation results will also be shown here.
(6) Data Control box
: To set items, scale and sampling line to be displayed. And it sets setting
for calculation parameter and output items.
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2) All wells graph display

All wells graph display has the following functions, and it has 2 modes such as Select
Well mode and Hit Well mode for functions.

a) All well graph display such as Ratio, Intensity (Photon Count) and Integral
b) Mark display

)
¢) Well choice for remark graph
d) Hit well display

e) Select group well (including negative/positive control well)

<Se|ect UnI|m|ted WeII mode> <H|t WeII mode>

iliil“ii l'ila
Chosen weIIs ! 7

\ To switch in Data Control box

H|t weII

<1, e Well mag’nlflcatlon> ‘\ ‘\

<Display Groups mode>
Marker <Se|ect Group Wells mode>

Intensity (green)
Integrate (Blue) Ratio (red) Group List Box

(1) Select Well mode : To display remark graph with 10 wells.
(2) Display Groups Mode : Zoom in the selected group.
- How to select group

: Move the mouse cursor on to the group and double click or check on/off in the
group list box.

(3) Hit Well mode : To display Hit wells picked up by the specified conditions.
(4) Select Group Wells Mode
: Select the well in each group.
+ How to select well

: Select the group in the group list box and then select the well by mouse
click/drag.
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3) Remark graph display

Remark graph display has the following functions.
a) Overlay display for chosen wells or groups
b) Overlay display for Hit wells
¢) Marker display and sampling line display
d) Overlay display for Av. and S.D graph

< Display Groups/Select Group Wells Mode>
3)

(1 =

$To switch in Data Control box
<Select unlimited mode, Hit Well mode>

Ratip Wiell No. Ratio

2.02;

@ —

-
-
&
-
-
&
-
&
-
-

W Marker
[~ Av&SD.

o&

40.0 1:00.0 1:09.0

(1) Display Groups/Select Group Wells
: Shows all selected group data overlayed.
Each group graph color can be configured as desired.
(2) Hit Well mode
: To display graphs of Hit wells with an overlay. Each item is
distinguished by colors.
(3) Group List Box
: Group list which can be configured will show up here.
Select and check the group to show details.
(4) Marker : To set a marker On/Off to be displayed.
(5) Clear : To all-clear the chosen wells.
(6) Print Out : To printout the remark display.
(7) Av.&S.D. : To overlay Av.and S.D. of the selected graph.
(8) Auto Scal : To auto-scale of selected well
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4) Correlation diagram display

Correlation diagram display has the following function. (Correlation diagram is not
available in Display Groups - Select Group Wells Mode.)

a) Correlation display between maximum and integral value of Ratio/Intensity.

b) Histogram display of maximum value of Ratio/Intensity

c¢) Histogram display of integral value of Ratio/intensity

el

<Correlation diagram display>

18.000 20.000

<Histogram display>

i To switch with display item choice

[ Wil No.

KMo Datax
W Intee. Rat.
[ Max Rat:
[Mo.2 Data
[~ Intee. Rat.
| Max Rat.

| Intee. Rat.
[~ Max Rat.

e

Step = 0.095 22.640

(4) Print Out
(5) Scale
(6) Auto

Mo.1 Integ.Ratio

(1) Correlation diagram display
: To display correlation diagram between maximum and integral value

of Ratio/Intensity.

(2) Histogram display
: Todisplay Histogram between maximum and integral value of

Ratio/Intensity.

(3) Display item
: To choose Well No., Max value and Integration value with max 3

areas. When 2 items are chosen, the correlation chart appears.
When 1 item is done, the histogram display shows up.

: Printout correlation diagram and histogram.
: Set scale of correlation diagram and histogram manually. (Refer to 4-1)
: Set scale of correlation diagram and histogram automatically.
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(4-1) Scale setting for correlation diagram

(4-1) Scale Setup
Clicking ‘Scale’ in correlation diagram display, scale can be set manually in the

following box.
Setup Diagram Scale g|
Ihteg. Ex340:Em540
~
216 427618 (1)
Masx. |6204.80 | 28460
tax. Ex340:Em540
om
Min. [22591 22591
Max [33535 3%.35 (2)
(3) __——H OF ][ Gancel l——— 4)

(2) Integ.Ratio item
: To set scale of Integral value. Input number on left boxes,
referring to a right box which shows minimum and maximum value

within sample data.
(2) Max.Ratio item
: To set scale of Maximum value. Input number on left boxes,
referring to a right box which shows minimum and maximum value

within sample data.
: To renew grape with the set scale value

(3) OK
: To cancel operation.

(4) Cancel
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5) Micro plate pseudo color display

Micro plate pseudo color display has the following function.
a) Data kinetic display with specified item and time.

— 2 3 4 ] 5] 7 g 9 10 1 12
OO OOOOD
OO OOOO®

—

() 0000000000 Q
F33333IIIITT

b

(1) Micro plate pseudo color display

: To display micro plate pseudo color display.
(2) Color table : To display a color table

(3) Color Setup : To set a color table type. (Refer to 5-1)

(5-1) Color Setup

Clicking ‘Color Setup’ in the pseudo color display leads Color Setting box. The color

table can be chosen in it.

Select Table (1)

Steg A
dation A

radation B

R:jdat ioh ( 2 )

@) T

[ ‘ et \]| ( Cancel ]+— (6)
= (@) N (5)

(1) Invert : To invert a color table.
(2) Select Table

: To set a color table in this selection.
(3) Now color table
: To display the currently used color table
(4) New color table
: To display the newly chosen color table in Select Table.
(5) Set : To renew a color table.
(6) Cancel : To cancel operation.
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6) Calculation table display

(6-1) Unlimited Wells/Hit Well Display
Calculation table display has the following functions.
1) To display the result data of each well.
2) Calculation parameter is set at Hit&Calc.Param in Data Control box.
The item for calculation is as below:
a) Hit well
b) Number well
c) Integral value : maximum 3 data (To set at Hit&Calc.Param)
d) Peak value : maximum 3 data (To set at Hit&Calc.Param)

l i . | Mol Intee.. | Mol MaxF. | Mo2 Intee.. | Mo2 MaxR. | Mo3 Intee... ( 1 )
o] 3
13827
(o} A3 14930 0.648 1487 0.647 14.899
o] Ad 15348 0670 1513 0669 15.305
o} A5 14660 0623 14708 0624 14734
o} A6 15504 0.659 16503 0.659 16528
6] A7 167658 0718 16794 0718 16822
o} A8 16773 0.720 16813 0.7 16.849
o} A9 17652 0737 17616 0.736 17.669 (2)
o} A10 19572 0813 19559 0813 19570
o} A1 18677 0.801 18744 0.802 18781
o} A12 16634 0.735 16.640 0.735 16.689
o} B1 16257 0.646 168201 0.645 16.261
o] = 15.220 0655 18217 0655 15.270
B3 18822 0.689 16,799 0.688 16836
O B4 16432 0.713 16.463 0.714 16.486
< ¥

(1) Calculation item
: To display calculation item. Clicking an item sorts the data line.
(2) Calculation table
: To display calculation table view. Clinking well data reflects on all
wells graph display and remark graph display.

(6-1-1) Setting change for calculation parameter
Calculation parameter can be changed or re-set in ‘Param’ at ‘Hit&Calc.Param’ in
‘Data Control’ box. (Refer to 7) It sets item for Integral, Hit well condition,
calculation area at Max,Min,Average,Max-Min,Integral and baseline setting.

(6-1-2) Text out of calculation table
The calculation table can be output as a text format. ‘Text Out’ in ‘Data Control’ box
executes a text output (Refer to 7)
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(6-2) Display Groups Display
When ‘Display Groups' is selected, calculation results table display indicate following
data with some function shown below.
- Shows the calculation data of each group.
- Calculation parameters can be changed at the ‘Hit&Calc.Param’ TAB in Data

Control box.
- Calculated items are
a) Group No. : Group number
b) Concentration : Group concentration
c) Calculation value : Calculation value which configured at Hit&Calc.Param
TAB
d) Standard Deviation : Standard deviation of each group
e) Z Factor : Z factor of each group using Min/Max data
f) Z Factor with N.C. : Z factor of each group using N.C.data
g) Comment : Comment of each group

<Calculation results table>

IG/EGE0 Mol Mas Ratio <Chanee Param> Display IG/EC Graph ( )

(1) Calculation item : Show calculated items
(2) Calculation Table : Show calculation results
(3) IC/EC X No.Y xxxx<Change Param> button
: Set parameter for IC/EC Calculation
Setup Table Box will appear. Refer to (7-2-1) for detail
(4) Display IC/EC Graph button
: IC/EC Graph Box will appear. Refer to (6-2-3) for detail

(6-2-1) How to change IC/EC calculation parameter
Parameters can be changed and re-calculate IC/EC value.
In order to re-calculate, select IC/EC X No.Y xxxx<Change Param> button or
Hit&Calc.Param button on the select well part in data control box. Refer to 7) Data
Control box.

(6-2-2) How to output calculation result table in text file data.
Results can be output as text file data. In order to output in text file, Please refer to
7) Data Control Box part for detail.

(6-2-3) IC/EC Graph Display
By clicking Display IC/EC Graph button below IC/EC graph will be displayed.
This button will be changed to Hide IC/EC button when IC/EC  Graph is displayed.
To hide the IC/EC  Graph, push Hide IC/EC Graph button.
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<IC/EC Graph>

(11)

111018003 Max Ratio Sampling 1-361 (Proc:All OFF)

(1
(2)
(3)
(4)

13

11
_é IC/IECED =1781 [uM]
=]
v 0.8
g ]
B
E 0.6
2
B 4

03

0.0 "

1 10 100

1000 1E+04 1E+05 1E+06 1E+07

Concentration <uM>

(1) Auto Scale

(2) Zoom

(3) Log

(4) Grid

(5) Display OnOff
(6) IC/EC Parameters
(7) Original Graph
(8) Fitting Graph

(9) IC/EC Value

(10) Data Plot

(11) Text,Bitmap out

: Automatically change the graph scale

: Zoom in and extend the graph display

: Change Log/Linear in x axis

: Overlays the grid in the graph

: Display On/Off of title, X/Y axis title, scale

: Set value 10 to 90, 10 value step

: Graph which the data point connected with straight line
: Graph which the line fit in curve

: Display the IC/EC value in the graph

: Plot the data and the standard deviation

: Text data and Bitmap file will be output and copied to

the clipboard

137

HAMAMATSU PHOTONICS KK




FDSS7000EX/uCELL Software Instruction Manual Ver.2.9.3 72360301-04

(6-3) Select Group Wells Display
When Select Group Wells is selected in Select Well, group configuration item will be
displayed have below function.
-Displays group parameter configuration box
-Returning to Display Groups

<Group parameter configuration window>

Nows, it is in eroup setting mods.  Please return after a setup to Group mods.

If it clicks here, it will retum to Group mode.

Setup Group Paramster

(1) If it clicks here,it will return to Group Mode button

: Switches between Select Well and Display Groups
(2) Setup Group Parameter Button

: Displays Setup Group Box Refer to (6-3-1)
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(6-3-1) Setup Group Box

Setup Group Box will show up when Setup Group Parameter button is clicked.

Group can be added, deleted and edited from this box.

<Setup Group Parameter Box>
Setup Group Parameter
Gancel
Save Groupj
Load Groupj
Delete j
Delete All d/
Giroup ]Ser\eS] \/
Group Name Calar
Cioncentration |T DDU |mM Cancel
Comment
<Group Tab>
Giroup ]Series ]
Group Mame J—_ﬁ& ~ GCaolor 1 Lpdate i
Goncentration  [1.000 |mbd = _Eﬂl?ﬂj_
Comment
<Series Tab>
Group Series]
Group Name Series0h Color_| Undate_1
Start Gone.  [10000 T | Gancel |
Step Conc. [10.000 /]yphﬁ |
Replicates [Nane gl kil -
Comment

(1)

(2)
@)

(4)
®)
(6)

7)

(14)
(15)
(16)
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(1) Group List : Show current group/series in the list.
Select the group/series to edit group parameter
(2) Save Group : Save the parameter configured to the file
(3) Load Group : Load the parameter from the file
(4) Add : Add new group/series in the list
(5) Delete : Delete group/series from the list
(6) Delete All : Delete all group/series from the list

(Negative/Positive Control will not be deleted)
(7) Group Parameter / Group-Series TAB
: Switch group setup and series setup

Group TAB : Setup each group one by one

Series TAB : Setup in batch row/column when selecting the well
(8) Group Name : Show/edit name of the group and series
(9) Color : Set group color

Push Color to set color of the group in Select Group Color Box
Refer to (6-3-2) for detail

(10) Update : Resister the set value
(11) Cancel : Return to original value before edit
(12) Concentration : Setup concentration
(13) Comment : Input comment if needed
(14) Start Conc.  : Start value for batch setup
(15) Step Conc. : Step value for batch setup and calculation method
+ : Plus (Addition)
- : Minus (Subtraction)
* : Multiply (Multiplication)
/ : Divide (Division)
(16) Replicates : Setup for replicating row column and replicating number
None : No setup replication in column/row
Columns : Replicate setup in columns
Rows : Replicate setup in rows
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(6-3-2) Select Group Color Box
When Color button is clicked, below Select Group Color Box will show up.
Select the color for each group.

<Select Group Color Box>

Select Group Golor

Selected Color Calar?

ﬁ'_ lor2S Calordd

Color54

Colorl ¥ ColorEs
Colorla Colorba
Colorl2 Color57
R >
(1) Color List : Choose color
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7) Data Control box

Data Control has the following function.

a) To set display item, scale and sampling line for all wells and remark graph and

pseudo color display.
b) To output data with a text format or printout.
c) To set calculation parameter.
d) To set data processing

Data Caontral - (1)
[Samp.Line: 00:00.0(mezme2[1/361] j_‘l jﬂ!ﬂ )/_ (2)
[SE|ECt el EEE % :!'.5% Z% Hit & Calc.Param. j[_]— (8)
Select Graph wBFatin : Pioceszing : I:I 9
o Eaasensin £ [NE | ®
I~ Intes Ratio ; (3)
— | Info.: ext rint : ale :
® —{ @ @) &))" mlwmw~ 7)
(4) (5)
(1) Samp.Line : To set and display sampling line.
(2) Select Well : To switch display mode, Select Well mode or Hit well mode.
(3) Select Graph : To display items to be displayed in graph.
(4) Save Text : To set items to be output at Text Out.
(5) Print Out : To print out all graphs.
(6) Info. : To display and output plate data.
(7) Graph Scale : To switch a scale method and set manual scaling.
(8) Diagram : To show Diagram.
(9) Processing : To set On/off of data processing
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(7-1) Samp.Line
It sets sampling line and display the setting. And it sets and excuses Playback
function with kinetic change. Playback function shows kinetic change of micro plate
data with pseudo colors.

(4)
Sampline: [ o001 /20 («J | i@d@

(1) @ L@ e

(1) Sampling line
: To display sampling time (unit; s) and sampling number
[sampling number / total sampling numberl].
(2) Scroll bar : To set sampling number to display micro plate pseudo color data.
(3) Playback : To execute Playback function to show kinetic change of micro
plate data with pseudo colors.
(4) Stop : To stop Play back function.
(5) Setup : To set parameter for Playback function.

(7-1-1) Playback setup
It sets playback speed and step reading number for Playback function.

Replay Setup |
Interval {mseci ﬂﬁ L I I » I]-— (1)
step ] S)— (@)
0] % I Cancel |
\ \
_ (3 (@)
(1) Interval : To set playback speed with a millisecond unit. The number
shows an interval period between samples.
(2) Step : To set step reading number. The number shows how many
samples are skipped between displayed samples.
(3) OK : To apply and renew the setting.
(4) Cancel : To cancel operation.
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(7-2) Select Well
It switches display mode, Select Well mode or Hit well mode. And it sets parameter of
conditions for Hit well function.

Select Wl :

i
Wikl
[ (=11 ]

ﬁﬁ% @ Fit & Cale.Param.
M- @\ @\ )

(1) Select Unlimited Well
: To display graphs with Select Well mode. It can choose unlimited number of
well and display them on remark graph display. Wells can be chosen by
left-clicking on all wells graph display, calculation table or correlation diagram
display. The frame of the graph is enclosed with pink at each chosen well.

(2) Display Groups
: Display graph of the wells in the selected group
Group graph display will be on/off by double clicking the well in the group
Calculation table shows the group calculation data
(Group setup can be configured by Select Group Wells Button)

(3) Hit Well
: To display Hit wells which are resulted by Hit well conditions. The frames of
the graphs are enclosed with a red color at the chosen wells and they are
displayed on a remark display. A correlation diagram display shows wells with
red dots.

(4) Hit&Calc.Param
: To set condition parameter for Hit well function. It sets area for Integral value
and Max value. (Refer to 7-2-1)

(5) Select Group Wells
: Select the well in the group
Well selection can be done by left click on the mouse
Group will should be chosen in group list box before selecting the well

(4)

At select of Select Group Wells button, after select of control well, click Select
Unlimited Well/Display Groups/Hit Wells button in order to set the select.
(When selecting Select Group Wells button, operation is restricted.)
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(7-2-1) Hit & Calc.Param
It sets conditions for Hit well and Calculation functions.

™)
[Rauu Denominator |15t Samp. Paint =] feflsamp ] ] ok ‘ (2)
[Hn Well: nteral Bem  [Ratio - % L | (3)
[Hit Well: Select Peak | Mo -] ]/ !
[[o/Ec [50° | uses |Moi Data | < PRatia | Max > ]’_— (4)
H WET Fange
/(N1Dt> [~ Inteeral =
AL | - — (5)
oo b T Temal = =
I No2 Max T = =1
i = =
5 - L (T |
= || _Ereble Cutput Mot Data } (6)
aseline Unteer: e Mine A M= Min,
|| | % Enable SubBassline
[ TolstDispense Start |l i
End |l i (7)

¥ All ranges A

\|=!= = == )LL_IL
=

kil
M Ma-Min Range
% All ranges |
£l
Averaes Ranes
¥ il ranges K|
|

(1) Ratio / Denominator : To define the denominator item of ratio
<when two wavelength measurement>
Wavelength2 Intensity
: Intensity value of wavelength2 of each sampling point is used.
<when one wavelength measurement> (Refer to 1-8-6-1 Chap.4)
1St.Samp.Point: To use Intensity value in which 1%, sampling point is
assumed to be a reference point
Ave. : To use Average value of Intensity from the
the set sampling
Delay (Option Function)
: The reference point is moved behind the set sampling
X Disp. Point (Option Function)
: To use Intensity value in which sampling point before No.X
dispensing point is assumed to be a reference point
Ave. : To define Average value of Intensity from a reference point to
the set sampling
Delay : The reference point is moved behind the set sampling

(2) Hit Well/Integral Item : To choose an item to be applied for Hit well function,

whether Ratio or Ex1/Lumi

(3) Hit Well/Select Peak : To choose a peak to be applied for Hit well function,
whether Max , Min , Av. or Max-Min.

(4) IC/EC X uses No.Y Data

: Setup parameters for IC/EC calculation
IC/EC X : Set value from 10 to 90, 10 value step
No.Y Data : Select which data number to be used for group calculation
Calculation use the item set in Integral Item and Select Peak in
HIT WELL, use the range value set in the data number tab.

(5) Hit Well Range : It sets conditions for Hit well function. The parameter
is Integral value and Peak value. The area is set here
and the correspond wells are picked up automatically.

All Area : To apply all ranges for calculation.
Start/End  : To set a calculation range manually.

1%, sampling point to
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(6) Enable Output No.X Data
: To set On/Off of No.X data.
(7) Baseline : To set baseline subtraction.
To 1% Dispense
: To set a range from measurement start to the first dispensing
timing as baseline.
Start/End  : To set a range as baseline manually.
(8) Integral/Max/Min/Max-Min/Average Range
: To set a calculation range.
(9) No.1,2,3 Tab : To switch data number by Tab.

(7-3) Select Graph
It sets items to be displayed at all wells graph display and remark graph display. And
the top item within the checked ones is applied for micro plate pseudo color display.

(1) Ratio
: To display Ratio value. It is not available on luminescence.
(2) Fluorescence 1/Luminescence
: To display fluorescence or luminescence. A numerator is applied
here at two-wavelength excitation or emission fluorescence
measurement.
(3) Fluorescence 2
: To display fluorescence No2 at two-wavelength excitation or
emission fluorescence measurement. A denominator is applied
here. It is not available at luminescence or one wavelength
excitation and emission measurement.
(4) Integral
: To display Intergral value. It is set at Hit Well/Intergral Item in
table setup whether ratio or Ex1/Lumi is applied for Intergral.
(5) Display Ratio
: The display ratio of all wells graph and remark graph is switched.
(6) Background color of graph
: The background color of the graph is switched to the black and
the white.
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(7-4) Graph Scale

It sets a scale type and switch it for all wells graph display, remark well display and
micro plate pseudo color display.

(1) Auto

Graph3cale :

(1) (2) ®)

: To display with a scale automatically adjusted.

(2) Manual : To display with a scale which was set at data acquisition or
manual setting value.
(3) Setup : To set a scale setting manually in a setup box. The number
which is set at an assay protocol appears as default values.
(7-4-1) Setup

Clicking ‘Setup’ leads Graph Scale Setup box and a scale for each item is set in it.

(5) OK

Setup Graph Scale

Ratio Range

)

[Min. =Y |
Mazx. Jﬂﬁﬂi 1] ]

| }— (1)

Intensity Range

Min 000 o |
Max. [FZ0000 o] |

|
T

Integral Range

Min. (000 ﬂJ
Max. (10000 4

Time Scale [5]

Min [ 000«
Man | 208 o

Do

-

[

(1) Ratio Range
(2) Intensity Range

(3) Integral Range
(4) Time Scale

(6) Cancel

— (5) = (8)

: To set a scale for ratio value.

: To set a scale for intensity value for fluorescence
and luminescence.

: To set a scale for Integral value.

: To set a scale for time.

: To apply a setting.

: To cancel operation.
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(7-5) Info.

It displays Plate Data information such as a plate type and assay protocol. It exports
data with a text format.

Ihfa. :

Information : To display Plate Data information.

(7-5-1) Info.

Clicking ‘Info.” leads Plate Information box and it displays the information of Plate
Data. Comment input and text output is capable here.

Plate Information

— (1)

L @)

((Plate Name  [eheckStmel )j
( Comment |
Serial N = Time Hit el Total Wel Hit/Total | Gomment
89900042 09/27/08 21313 a0 o 1.667%
/ >
tem Parameter Valuel Value? Value3 Valued
Measursment Para
Protocol Mame
Measurement Made 1ExIEm
Measurement Wavel . Ex480EmEAD / Exd.
Samples 121
Tnterval Mods Sinele
Interval st [sec] 100
Interval 2nd [sec] 080
Double Sequence —
Dispense Timeing
Preparation Dispens, —
Pre Incubation [min] None
<Correction Paramet..
Putoflucrescencs . NuncdxdExpd PAF
Shading Corrastion Nunodx4 PSD
Galibration Cerrecti None
<Gamera Parameter
Exposure Time [sec] 0207 sec
Sencitivity 1
Birning 4x4
<Dispenser Paramete.. <Ligand1> <Ligandzy <Ligand3>
Volume [ul] 50 50 50
fspirate Speed [ulf, 50 50 50
Aspirate Hight [mm] 05 05 05
Dispense Speed [l 50 50 50
Dispense Hight [mm] 25 50 50
Wiagh Count 5 5 5
fspirate Pipet i 0 0
Digpense Pipet o 0 0
Aspirate From Stage Stage Staes
Mixing off
<Caleuration Parame,
Hit Well / Inteeral It Ratio
Hit Well Integral Ra 1500 10000
Hit Well Rastio Rane. 080 200
Baceline Sub off
Baseling Start/End - -
Inteeral Area Start/. All frea Bl frea
Peak frea Start/End All trea Bl frea
Pveraee Area Start.. All frea Al frea
<PIg Paramster>
Assay Plate NUNC OpticalBottom
Ligand1/2/3 Plats NUNG PP MUNG PP UG PP

Cancel

(1) Plate Name
(2) Comment

(4) Save as Text
(5) OK
(6) Cancel

@)

_ (5)

(6)

: To display a file name of Plate Data.
: To display, input and edit comments
(3) Basic and parameter information
: To display information of Plate data.
: To export data with a text format.

: To apply comments.
: To cancel operation.
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(7-6) Save Text
It sets items for exporting data with a text format in Save Text.

Text : @

Save Text : To export data with a text format. Clicking this icon leads Setup
Text Out Parameter box.

(7-6-1) Text Out
Clicking Save Text leads Setup Text Out Parameter box to set a filename and to
choose items to be exported. <refer to 2)Text Output in Chapter 6>

Setup Text Out Parameter

Filename oK I (1 )
[ Data Hame — [f7078008 J
= = Cancel
Han LIETe LFFL U THFERWTEATF T TOTOUDS_REWITAT
Flate Format Dats Mol : G¥FDSSDATA%TEXTE 110 8003 THT (2)
No2 : G¥FDSSDATA¥TEXTYIT101B008 2 TXT
Mo3: | N/A
Group Data : GEFDSSDATA¥TEXTH1 11018003 GRF THT
Qutput tem
i 3)
[[ 7 FRatio T EasnEnsi [ hteg | with Sep Fils] [~ Lise Assay Protocal }
I et EneD e ( 4)
Hit ez I~ Hit
Ratio [~ Max [~ Min [~ Av. [T Max-Min [~ Intee
Ex4B0Ema40 | Max [ Min [ Av. [~ Max-Min [ Intee. [~ Rat Max
EcdfEmbdn [ = Hin = = r r (5)

(1) Data Name : To set a file name of data
(2) File Name : To appear an actual file name
(3) Use Assay Protocol
: To employ output items which are set in Assay protocol.
(4) Raw Data : To choose items to be output at Raw data.
With Sep. File : Raw data of each item is output with another file.
(5) Plate Format Data
: To choose items to be output at Plate Format data.
(6) Group Data
: Check “Group Data” to output group data.
(7) Raw Data & Plate Format Data <Footer>
: To set to output the assay protocol information at the footer
part of text data.
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(7-7) Print Graph

It prints out all well graph display at Print Graph.

Print :

=

Print Graph : To print all well graph display with a printout setting box.

(7-7-1) Setup box

The printout setting box appears all wells graph display to set the printout.

Print @E|
Printer
Mame: [ MAESWR1F DELLASLP-87005\EPSON ] Properties..
Statuz: Ready
Type EPSOM LP-5700 (1 )
Where:  WWLP-BF00NEPSOM
Comment [ Print to fle:
Frint range: Copies (2)
c T
- Gl
(4)
o

(1) Printer name

: To specify a printer to be used for printout.

72360301-04

(2) Copy : To set how many copies are printed.
(3) OK : To execute printout.
(4) Cancel

: To cancel operation and go back to original screen.
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(7-8) Diagram

Display/non-display of the correlation diagram display is switched.

<Diagram ltem>

U Criagram ] O

(1) Diagram :
Display/non-display of the correlation diagram display is switched.
When the button is put into the state of the check, the correlation diagram is
displayed. The correlation diagram becomes non-display when putting it into the
state of the uncheck.

<Checked>
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(7-9) About Processing
In the Processing, On/Off of 4 kinds of data processing and parameter setup is
performed

<Processing>

1
2

(1)
(2)
3)
(4)
®)

Processzing :

4
5

i
BES

(1) S.U.(Spatial Uniformity Correction) : Select of ON/OFF(OFF: Grey)
Spatial Uniformity Correction is performed by using specified range.
(2) N.C.(Negative Control Correction) : Select of ON/OFF(OFF: Grey)
Canceling Negative Control Correction is performed by dividing
changed portion of specified control well.
(3) S.B.(Subtract Bias) : Select of ON/OFF(OFF: Grey)
To subtract the data of specified range
(4) P.C.(Positive Control Scaling) : Select of ON/OFF(OFF: Grey)
To perform correction on the basis (100) of intensity of specified control well
(5) Setup :
To setup parameter of above 4 data processing (For detail: Refer to 7-9-1)
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(7-9-1) About Setup
After clicking Setup button, the following box is displayed.
In here, Parameter setup of 4 data processing is performed.

<Setup Processing>

Setup Frocessing

Spatial Lniformit 1
Reference range i < i ] ( )
JEN S [N s
AT INEEFITVE COmroT
MAC Point T < 1 (2)
L B e
(oubtract Blas )
[~ Minug clip 1 (3)
Ranes of bias 1 < 1
¢ i MY 1)
Pozitive Gontral (4)
Range of calc. ,— ,— i
[ W Allarea " < 5] ]/
Cancel |

(1) Spatial Uniformity
Reference range (By Sampling No.)
Specify the reference range act as a standard for spatial uniformity correction
Specify the range which is considered it has most uniformity at the
measurement data (e.g. the first sampling )
(2) Negative Control
N/C Point (By Sampling No.) :
Specify the reference range act as a standard of time axis used for Negative
Control Correction is performed by using the value of reference range
specified as a standard.
(3) Subtract Bias
Minus clip :
To select whether to null the minus value which might occur by being
subtracted or not.
Range of bias (By Sampling No.)
Specify the range used as Bias. (The mean value in the range is used as
Bias.)
(4) Positive Control
Range of calc. (By Sampling No.)
Specify the calculate range used for scaling.
To perform scaling on the basis (100) of maximum value in the specified
range
All ranges :
To set all of range as the range to calculate
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(7-9-2) About the order of data processing

When a data is loaded on FDSS, data processing is run as below.
Doing On/OFF is possible on each processes, and each processes are run by such
flow as described below.

o Ok W

<Flow of calculation>

. Spatial Uniformity Correction (
. Negative Control Correction  (
. Calculate Ratio (
. Subtract Bias ( On/Off is possible )
. Positive Control Scaling (
. Calculate Integral (

On/Off is possible )
On/Off is possible )
Constantly On)

On/Off is possible )
Constantly On)

Intensity Data Ex1

Intensity Data Ex2

A4

Spatial Uniformity Correction

Negative Control Correction

v

A

Ratio Calculation Process »| Ratio Data

y

v v

Subtract Bias

Positive Control Correction

v

v v

Integral Calculation Process

l

l l l

Result of Intensity Data Ex1

Result of Intensity Data Ex2 Result of Ratio Data Result of Ratio, Intensity and Integral Data
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(7-9-3)About the calculation method of data processing

1. Spatial Uniformity Correction
It spatial uniform corrects it by using data within the range set by Ref.range.
<Parameter>
-reference range :Start -> End (Ref.range)
<Calculation method>
1. The correction factor of each well is requested by dividing the mean value
within the range set by Ref.range of all wells by the mean value within the
range set by Ref.range of each wells.
2. It corrects it by multiplying the correction factor of each well by all data of
each well.
<Calculation type>
Correction Factor:
Corr.Factor[well] = Av.[all well][t=Ref.range] / Intensity[well][t=Ref.range]
Corrected Intensity:
Value[well][t] = Intensity[well][t] * Corr.Factor[well]

2. Negative Control Correction
The time direction is uniformly corrected by using set Negative control well.

<Parameter>
-Negative Control point : Start->End  (NC point)
-Negative Control well (NC well)

<Calculation method>
1.  The correction factor of each sampling is requested by dividing the mean
value of NC well within the range set with NC point by the mean value of NC
well at the time of each sampling.
2. It corrects it by multiplying the correction factor of each sampling by all
data of each sampling.
<Calculation type>
Correction Factor :
Corr.Factor[t] = Av.[NC well][t=NC point] / Av.[NC well][t]
Corrected Intensity :
Value[t] = Intensity[t] * Corr.Factor[t]

3. Calculate Ratio
The ratio is calculated from the intensity data. The calculation method is
different according to measurement Method.
<Calculation type>
2ex1em,1ex2em and 2ex2em(Fura2 , FRET etc.)
Ratio[t] = Ex1[t}/Ex2[t]
1ex1em(Fluo4 etc.)
Ratio[t] = Ex1[t}/Ex1[t=0]
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4. Subtract Bias
The mean value within the set range of Bias is used and subtracted.
<Parameter>
‘range of bias : Start->End (BiasRange)
<Calculation method>
1. The mean value within the range set with BiasRange of each well is
assumed to be Bias value of each well.
2. It corrects it by subtracting the Bias value of each well from all sampling of
each well.
<Calculation type>
Bias Value :
Bias[well] = Intensity[well][t=BiasRange]
Corrected Intensity :
Value[well][t] = Intensity[well][t] — Bias[well]

5. Positive Control Scaling
Scaling that uses set Positive control well is done.

<Parameter>
‘range of calculation (range)
- Positive Control well (PC well)

<Calculation method>
1. The PC well mean value of the first sampling set with range is subtracted
from the mean value of PC well of each sampling set with range. (Dif[t])
2. The maximum value of Dif[t] is divided from 100 and it is assumed the
correction factor.
3. It scales it by multiplying the correction factor by all intensity data.
<Calculation type>
Dif[t] = Av.[PC well][t] - Av.[PC well][t=Start]
Correct Factor :
Corr.Factor = 100 / Max(Dif[t])
Corrected Scale :
Value[well][t] = Intensity[well][t] * Corr.Factor
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11. Filter Control (at fluorescence measurement)

Fluorescence optics such as a filter switching and shutter operation can be manually
controled by FDSS application software. At measurement they are automatically controled

by FDSS software.

1) Filter Control box

Filter Control box is shown as below and it stands by on screen.

Eilter Control

1) . Ex340/Em540
Ex380/Em540 Ex480/Em540
\
Shutter N
2
( ) 1 Open Cloze
(1)Filter : To switch 4 kinds of filter combination.
(2)Shutter : To switch shutters at excitation light scources.

in ‘Setup’ menu.

Filter combination can be set at ‘FilterCombination Setup’ command
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12. Dispenser Control box
1) Dispenser Control box

(In the case of FDSS3000/6000/7000EX)

Used to control a dispenser manually and set dispensing parameter. Setting can be
done as a Stage unit, and the dispensing heads corresponding to the stages are set at
shipping according to the configuration.

Dispenser Gontrol

— (1)

Pusan Plate ‘ """""""""" [ ]/ (2)

[TH1+8tage1 | TH1+Stagez | THI+Staze3 | TH1+Loader]1/

/ Dizpense Start Maozzle Wash ‘ Detail...

L— ()

Volume 10 ul ﬂ J
fapirate

Speed B0 s 4
Heieht 05 mm ﬂJ

I
1
i
Digpengze
Spead I_Wulfsﬂ Jﬂ
\Height [ 20 mm ﬂ J 7»)/ | (7)

i Setu (4)
= 7 (8)
%ﬁ\[ohange Head & Ligand F‘Iate]‘* (6) (5)

(1) Assay Plate: To load an assay plate in or out when manually controlling the dispenser.
Load : Toload an assay plate in.
Unload : To load an assay plate out.
(2) Stage selection tag
: To display combination between dispensing heads and ligand plate stages
and to set dispensing parameter here.
(3) Dispensing parameters
: To set dispensing parameter with a Stage unit, choosing Stage selection
tag (Refer to 1-1)
(4) Mixing Assay Plate
: To choose ON or OFF of the mixing (vibration) function for an assay plate.
It is available only at fluorescence measurement.
(5) Auto Ligand Tank:To choose ON or OFF of auto ligand feeding function. (Option)
(6) Change Tip & Ligand Plate
: To exchange dispensing head tips or ligand plates, specifying which tips
and plates with Stage selection tag.
(7) Multi Wash/Wash Cycles: To set the number of times to wash
(8) Wipe : To choose ON or OFF of the wiping function after washing.

@ Click the tag into active and then click this command.

@Dispensing parameter set here reflects on Assay Protocol. And when
Assay Protocol is loaded after setting here, the loaded parameter is valid.
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(1-1) Dispensing parameter
Used to set dispensing parameter. Setting can be done as a Stage unit, and the
dispensing heads corresponding to the stages are set at shipping according to the

configuration.
(1) —{ THI+Staget |—;..- +Stage? | TH1+Stage3 | TH1+lu-~.-‘Jvrﬂ 3)
S
Dispense Start Nozzle Wash Detail..
@ el | (B Y
[ Volume 10 ul ﬂ J D" (5)
( Bspirate =\
Speed 50 ulfs 4| [»
\_ Heieht 05 mm «| | [T (6)
(Dispense =\
Speed [—50 ul/s _1J J..’_J
KHeight 20 mm LJ 1 _pjj (7)
[Multi Wash | Off Setup] (I~ after measurement ) 9)

(8)

(1) Stage selection tag
: Choose at which combination dispensing parameter is set.
(2) Dispense Start
: To start dispensing operation when operated manually. It dispenses
liquid with the set parameter in an active tab head/stage.
(3) Nozzle Wash
: To wash dispensing head when operated manually. It washes with the
set washing times at ‘Multi Wash’ in an active tag head.
(4) Details: To set detail parameter such as aspirated place, mixing in/out function
(Refer to 1-2).
(5) Volume
: To set dispensing quantity (unit: pl) with an active tag head.
(6) Aspirate
: To set aspirating parameter with an active tag head.
Speed : To set aspirating speed (unit: pl/s).
Height : To set aspirating position, height from the bottom of a plate.
(unit: mm).
(7) Dispense
: To set dispensing parameter with an active tag head.
Speed : To set dispensing speed (unit: pi/s).
Height : To set dispensing position, height from the bottom of a plate.
(unit: mm).
(8) Multi Wash or Wash Cycle
: To set how many times the dispensing head is washed.
(9) after measurement
: To choose at which timing the dispensing head is washed.
Check : To wash dispensing head after measurement.
No Check : To wash dispensing head after each dispensing operation.
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1-2) Dispensing detail parameter settin
Used to set dispensing parameter. Setting can be done as a Stage unit, and the
dispensing heads corresponding to the stages are set at shipping according to the
configuration.

<In the case of FDSS7000EX>

Tin & Hand Ho
& Mol TidHsad o2 TotHead )| (1)
e
I J 2)
Tewturaion

F Gource Plate Triboration
Cont [ B a4
~ Volme [ 20wl .LJ
Heght [EDmm |

OffgatiDisp—Aspd | a0 mm A

Wash Position

[Heu:hl [E0mm 4] v

(4)

Ligand Tank

[ Acoess n_ (5)
—

<In the case of FDSS3000/6000> (Tip&Head No in FDSS7000EX is different as follows.)

Detail Setup

Head Type
i« Tip i Mozzle (1)

Azpirate From

(1) Tip&Head No : To choose a combination of dispensing head and tip.

Head Type : To choose a dispensing head type, tip or nozzle.
(2) Aspirate From: To choose from which place liquid is aspirated and then dispensed.
Stage : Aspirate from a ligand plate on the round table.
Loader : Aspirate from a ligand plate on a loading line.
(3) Trituration : To set mix-in/out at aspirating and/or dispensing.
Source Plate : To run mix-in/out at aspirating.
Destination Plate: To run mix-in/out at dispensing.
Count : To set how many times mix-in/out is done.
Volume : To set how much quantity is used at mix-in/out.
Height : To set the height at mix-in/out from Aspirate or Dispense height.
Offset : To set the difference of the height when mix-in and mix-out
(4) Wash Position: To set washing position
Height : To set washing height at washing.

(Unit: mm, from the default value where the edge of tip a bit
entrances into the washing nozzle.)
(5) Ligand Tank ( Option )
Access : To turn the position of the cell tank for the auto ligand feeder to
the door position and then to open the door so that it can be
accessed for exchanging it.
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(1-3) Dispenser basic working

1) To load assay plate into measurement position.
Set an assay plate onto a stacker and click ‘Loading’. When ‘Loading’ is disabling
and ‘Unloading’ is enabling, the plate is already set at the measurement position.

2) To load assay plate out
Click ‘Unloading’. When ‘Loading’ is enabling and ‘Unloading’ is disabling, the plate
is already not set at the measurement position.

3) To dispense liquid
Choose ‘TH+Stage’ tab or ‘Head+Stage’ tab for the head and stage combination to
be used when an assay plate is set at the measurement position and then click
‘Dispense Start’

4) To change dispensing parameter
Choose ‘Head+Stage’ tab for head and stage combination to be used and then
change dispensing parameter. And click ‘Detail’ and set Trituration function.

5) To set ON/OFF for assay plate vibration function
Choose check (ON) or not on 'Mixing Assay Plate’.

6) To exchange tip of dispensing head and ligand plate on round table
Click ‘Change Tip&Ligand Plate’
In the case of FDSS7000EX, A Box to select exchange mode is displayed and then
can select either the mode to exchange only ligand plate on the ligand stage or the
mode to exchange not only the ligand plate but also dispensing head and tip.
(About in detail please refer to 3-2)
In the case of FDSS3000/6000, the ligand stage and dispensing head move a
position to be able to change them and then the door of FDSS open.

7) To exchange applied mode of dispensing head and tip ( only FDSS7000EX )
Click ‘Change Tip&Ligand Plate’
As a box to select exchange mode is displayed, select the mode to exchange not
only the ligand plate but also dispensing head and tip. It can be changed at the
time of the setup of dispensing head and tip. (refer to 3-3)

8) To wash dispensing tip (At configuration which has washing function)
Click ‘Nozzle Wash’ to wash dispensing tip with the set number in Wash Cycles
parameter.

9) To set ON/OFF for auto ligand feeder (Option)
Choose check (ON) or not on Auto Ligand Tank to feed ligand from a special tank
to an assay plate.

10) To exchange the ligand tank of auto ligand feeder (Option)
Click ‘Detail’
The detail setup box is displayed.
Click ‘Access’ button of the Ligand Tank item.
The tank moves to the exchange position and the door opens.
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2) Dispenser Control box <In the case of uUCELL>

Use to control a dispenser manually and set dispensing parameter. Setting can be
done as a tab unit.

Dispenser Control (1 )

[F\ Ay Plate flcess ]

(TAT StaeeT | THT+stoesz | THi+Stagel | THI*Staz=g)| A (4)

Setup
~ Dizpenze Start Mozzle Wash —_—
J

Aspir

c
/

®)

D Stage |Stagel

\\ olume 110 ul ﬂ J
pesd B0 Ule 4
Height 1100 mm 4
v Trituration

I Val [10ul 4

Count |3 J

Height [00mm 4 |
et 00mm 4

Di =
(7) peed [FOul/s 4
Height 100 mm 4

v Trituration

v &ali 10 ul

4
Gourt [ J
Height 00 mm 4 |
00 mm 4
(1 1 ) \ Change Head

(C_wip=a ) [ ficcess Ligand Mol 7]

|~

Lk

I= ==

ash [ After Measurement

L IRE

=

H®

===

©)
(10)

(2) Assay Plate Access : Loading and unloading of assay plate

(2) TH1+StageX tag : Switching of dispensing parameter combination
(3) Dispense Start : Execution of dispensing

(4) Setup : Setting of various setting box

(5) Nozzle Wash : Washing of tip nozzle

(6) Aspirate : Setting of aspiration parameter

(7) Dispense : Setting of dispensing parameter

(8) Wash : Setting of washing parameter

(9) Change Head : Exchange of dispensing head

(10) Access Ligand No.X : Exchange of ligand plate

(11) Wipe : Setting of On/Off of wiping after washing

The dispensing parameters which were set here is used in Assay Protocol.
And please care about when Assay Protocol file is loaded after parameter setup,
loaded parameters are going to change.
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(2-1) Assay Plate Access
Loading and unloading the plate are done.

fzzay Plate Access

Access :Loading and unloading of assay plate
It becomes to access the assay plate folder when ‘Access’
button is clicked and the message box is displayed.
Please set up or take out the assay plate and click ‘OK’ button

(2-2) TH1+StageX Tab
Switch of dispensing parameter,

_—-—_———

-
-~y
THY+SlageT8Staeel || TH1+Stagez | TH1+Loader | TH1+Laader |
T ] =
'l

L —
_—l————1 Setup

TH1+Stagex : Switch of dispensing parameter
Up to 4 dispensing parameter setup is possible

If Preparation setup is performed at Prepa tab in Assay Protocol,
Available stage is limited

(2-3) Dispense Start
Dispensing is performed.

) Setup |
Dizpensze Start Mozzle Wazh
P4
—_—

Dispense Start: According to the dispensing parameter set in
TH1+StageX, dispensing is performed.

This can not be executed in AssayProtocol setup, execute it with Manual
Mode.
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(2-4) Setup

The optional function setup is available. (This option only activated in supervisor
mode which require password.)

]—— [

[THi+Si5esTB5teel]| TH1+Staze2 | THI+Loader | THI 308

Setu
Digpenze Start Mozzle Wazh S _|:|
Setup : The following option function setup is available.

1) Setup of reset (This is the recovery command when the
dispenser has trouble)

QOption Setup

Option
Reset |

Rezet Function

| Clear Head |

Rezet Dispenser |

Please use this function, when a dispenser head
cannot be remaoved in the trouble of Dispenser.

s oE Gancel |

Clear Head : Remove the dispenser head
Reset Dispenser : Reset the dispenser

(2-5) Nozzle Wash
Washing is performed

[ TH+StageT&5tagel]| THI+Staee2 | THI+Loader | THi+Loader |

/ - =
Set
Dizpensze Start ‘ Mozzle Wazh ZuP |
~
—_—

Nozzle Wash : According to the dispensing parameter setup in
TH1+Stage, washing is performed

This can not be executed in AssayProtocol setup, execute it with Manual
Mode.
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(2-6) Aspirate

The aspirate parameter is set.

<Tip head >
Azpirate

fzp. Stage |Stage1

Valume |20 ul ﬂ J
Speed  [10ulfs 4 j
L |

Height |20 mm

[v Trituration

[w ol |20 ul A

Count |2 ISR P

Height [2.0mm 4] |
L |

[l | |1

3

Offget |00 mm

3

Asp.Stage : Setup of where aspiration is performed
Volume  : Setup of aspiration volume
Speed : Setup of aspiration speed
Height : Setup of aspiration position (height from bottom of plate)
Trituration : Setup of On/Off of tritulation at aspiration
Vol. : Setup of trituration volume
Count : Setup of how many trituration is perfomed
Height : Setup of height of trituration
(height from aspiration position)
Offset : Setup of offset of aspiration and dispensing at trituration

(2-7) Dispense

The dispense parameter is set.

<Tip head >

Digpenze

Speed |20 [PO0ulfs :‘ :H :‘

Height |20 mm

[v Trituration
W Wol [@0ul A 2
Count |9 N I
Height |30 mm 4] | ¥
Offgst 00 mm 4] | ¥

Speed : Setup of speed of dispensing
Height : Setup of dispensing position (height from bottom of plate)
Trituration : Setup of On/Off of trituration at dispensing

Vol. : Setup of volume of trituration

Count : Setup of how many trituration is performed

Height : Setup of trituration position (height from the dispensing)

Offset : Setup of offset of aspiration and dispensing position at
trituraltion
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(2-8) Wash

The washing parameter is set.

Wazh

[v Wazh [ After Measurement
1=t

Wat oo |
Cycle 3 = |

Pos. 0.0 mm

Wash : Setup of On/Off of washing
After Measurement
: Setup of washing after measurement (On)
or after dispensing (Off)

Vat : Setup of washing vat
The mounted washing bat A is selectable
Cycle : Setup of how many washing is performed
Pos. : Setup of height of washing (for fine adjustment)

(2-9) change Head

The head are exchanged.

’_———__

-~ Chanege Head
[ Wipe:d fcocess Ligand Mol
Change Head : Exchange of dispensing head

(For detail, refer to 7)
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(2-10) Access Ligand No.X
The ligent plate are exchanged.

Chahege Head

| LB |
—Pn:cess Ligand Mol

[~ Wipe:A

Access Ligand No.X : Loading and unloading of ligand plate
It becomes to access the ligand plate folder when ‘Access’
button is clicked and the message box is displayed.
Please set up or take out the ligand plate and click ‘OK’ button

(Ligand plate that can be accessed is ligand plate that has been selected in
“(2-2)TH1+StageX” tab.)

(2-11) Wipe

The wipe function is set.

Chanege Head |

— - gy,

(W'pﬁ - b fccezs Ligand Mol |

- m -

Wipe:A : Setup of On/Off of wiping per washing unit
(If washing vat is not mounted, this is not displayed)
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3) Height setting on Trituration

The relationship between the parameters and actual poisons are shown as bellow.
Trituration item in Detail Setup box includes Count, Height and Offset as parameters.

<At aspirating>

1-1. Aspirating for trituration =>. 1-2. Dispensing for trituration = 2. Aspirating

Repeat with the set count
L]
:Dispense

Aspirate \/ A

v +Aspirate
-}-1-Y_~ Height +

Plate Bottom +\ Plate Bottom

Aspirate Height Aspirate Height Aspirate Height

<At dispensing>

1. Dispensing =Jp 2-1. Aspirating for trituration =% 2-2. Dispensing for trituration

Repeat with the set count

:Dispense

. A
o Aspirate \/

:Dispense

+\ Plate Bottom

t \— Dispense Height

Plate Bottom

Dispense Height Dispense Height
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4) Exchange of dispensing head & tip and ligand plate

(In the case of FDSS7000EX)

Click ‘Change Tip & Ligand Plate’ in the Dispenser Control box and the following box is

displayed.
In this box, select of each exchange mode can be performed.

GChanee Tip & Ligand Plate

Please select it from the following two,

[| The door iz opend (Access Lieand Stage! | (1)
[ The tip and the head are exchanged I’" (2)

O ——

(1) The door is opened : The door of dispenser opens
This is used for exchange of only ligand plate
The exchange of dispensing head & tip can not be performed.
(2) The tip and the head are exchanged
: After keeping dispensing head & tip to be enable to
exchange, the door of dispenser opens.
This is used for exchange of dispensing head & tip
At the same time, ligand plate also can be exchanged.
At the time of the exchange, the applied mode of dispensing head and tip
can be changed
(3) Cancel : The box is closed without performing the exchange
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(4-1) Processes of ‘the door is opened’
The door of dispenser opens.
After the door opens, the following box is displayed.

FOSS7000/uCELL x|

!E Yiou can access Ligand Stage,
Plzase push the OF button after i completes i,

[ o)

Exchange the ligand plate etc.... After it finishes, click ‘OK’ button.

The door closes.

When the door closes, the following box is displayed.

(It is not displayed according to the system, and Preparation is done by the
automatic operation. )

I Continue

y ! 5 Dispenser :

[100] Please push <Preparation> butkan that exists in the operation panel of the dispenser,

Please push the OK button of the above-mentioned box after pushing ‘Preparation’
button of the front panel of following dispenser.

When the processing of the dispenser is completed, using software becomes
possible.

ST

‘Preparation’ button
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(4-2) Process of ‘tip and head are exchanged’

The following confirmation message for operation of head and tip is displayed.
In the case of exchange, click ‘OK’ button.

T\ Rivies toexchange the tip and the head.

Is it gosdi?

In the case the dispensing head and tip keep to be loaded, after they get unloaded,
the door opens. When the door is opened, the following box is displayed.

Ghange Tip & Head Combination

Select Tip & Head Combination Mode

<f> Mo Tip + Mo Head <B» 1 Tip + 1 Head {Cr 2 Tip + 2 Head
Head1
Tipl
Plate Format Tip & Head are used as follows,
TH Mo Combination TH MNo.2 Combination

384wl T .,

Set Tip & Head (The mode iz chaneed)

The exchange of the dispensing head & tip and ligand plate are performed.

Choose the combination between dispensing head and tip and then click ‘Set Tip &
Head’ button. The door closes.

When the door closes, the following box is displayed.

(It is not displayed according to the system, and Preparation is done by the
automatic operation. )

B Continue E|

! 5 Dispenser :

[100] Please push <Preparation button that exists in the operation panel of the dispenser.

Please push the OK button of the above-mentioned box after pushing ‘Preparation’
button of the front panel of following dispenser.

When the processing of the dispenser is completed, using software becomes
possible.
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(4-3) Applicable modes of dispensing head & tip

In the FDSS7000EX, there are such 3 applicable modes as follows.
A) The mode not to use any dispensing head and tip. (In this case, the dispensing
operations are not performed at all.)
B) Dispensing head: 1, Tip: 1
C) Dispensing head: 2, Tip: 2

These 3 modes can be changed when the dispensing head and tip is exchanged.

It is set by the following box that the dispensing head and tip used in the case FDSS
perform the dispensing.

That is set by specifying the combination between 2 dispensing heads and tips.

This specification can be performed in the ‘Detail Setup Box’

The following shows the combination in the each usage mode

Ghanege Tip & Head Combination

Elect Tip & Head Combination Mode
<A>» Mo Tip + No Head

Plate-Forma
TH Mo.1 Gombination TH Ho.2 Gombination

384wol T T

[ Set Tip & Head (The mode is chaneged)

— (1)

<Er 1 Tip +1 Head <Gy 2 Tip + 2 Head

in-& Haad d-zcfall

— (2)

)
(4)

(1) Select Tip&Head Combination Mode
: Select the usage mode of dispensing head & tip
<A> No Tip + No Head : Any dispensing are not performed
<B> 1 Tip + 1 Head : Dispensing head: 1, Tip: 1
<C> 2 Tip + 2 Head : Dispensing head: 2, Tip: 2

(2) Tip&Head are used as follows
: The combination between dispensing head and tip to be set in above

TH No.1 Combination

TH No.2 Combination

<A> No Tip + No Head

Be not in use

Be not in use

<B> 1 Tip + 1 Head

Tip 1 + Head 1

Tip 1 + Head 1

<C> 2 Tip + 2 Head

Tip 1 + Head 1

Tip 2 + Head 2

(3) Plate Format

(4) Set Tip & Head

: The plate format being selected at the starting

: To load the dispensing head and tip corresponding to the select
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5) Exchange of dispensing head and ligand

late

(In the case of FDSS3000/6000)

Select any tab which lists the name of the head & stage which you want to exchange.
It can be exchanged by clicking ‘Change Tip & Ligand Plate‘ button.

<Dispenser Control Box>

Dispenser, Gontrol

Azzay Plate

[ Headl+5tagel

Head2+Stage? | Head3+Staged | Head!+Loader

Dizpenze Start Mozzle Wash Detail..

Wolume 10 ul ﬂ J ﬂ
Azpirate

Speed B0 s 4 »
Height 05 mm «| | 2
Dizpenze

Speed 50 ulfz ﬂ L
Height 20mm «f | 2

Wash Cvcles 04 [ after measurement

— Select any tab

[ Mixing Azzay Plate

| Change Tip

[~ Wipe
[~ Auto Cell Tank

&Ligand Plate button

[ Chanee Tip & Ligand Plate

When the ‘Change Tip & Ligand Plate’ button is clicked, after the selected dispensing
head and ligand plate move to exchange position, the door opens.

And then as the following message is displayed, after finish of the exchange of
dispensing head and ligand plate, click ‘OK’ button.

After that the door closes, the dispensing head and ligand plate is set.

FDSS3000/6000/7000

AN

‘¥ou can access Ligand Skage.

Flease push the OF button after jt completes i

Click ‘OK’ button
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6) Exchange of dispensing head and ligand plate

(In the case of uCELL)

The dispensing head can be exchanged by clicking ‘Change Head* button.
The ligand plate can be exchanged by clicking ‘Access Ligand No.X’ button.

(6-1) About the exchange of the ligandd plate

Select any tab which lists the name of the stage which you want to exchange.
It can be exchanged by clicking ‘Access Ligand No.X* button.

<Dispenser Control Box>

fissay Plate

(T S(g1ITH1 s«gz]Tm sugw][rm Slszll/_

s |
Disperse Start Nozzle Wash
Aspirats
Asp. Stage lm
vome [0 ¢ | |
Speed B0 ul/s <:|
Height [100mm <
v Trituratiot
W Vol lul [»
Gount |5 |
Height [00 mm | »
Offset POmm <[ | »
Dispenss
Speed B0 ul/s ‘:| P @ owash [ Ater Mea
Height /100 mm
[ Trituration Vat A -
Wl fiow  «| ||| Gve -
Caurt 5 D
Height 00 mm  «| | »
Offset 0O mm 4| | Pos. [00 mm

L Select any tab

I~ Wipe:t

Access Ligand No.X button

When the ‘Access Ligand No.X’ button is clicked, after the selected ligand plate move to
exchange position, the following message is displayed.
After finish of the exchange of ligand plate, click ‘OK’ button.

The ligand plate is set.

FOS53000 uCGELL

l:;./

Yiou can acoess Ligand Stage,
Please push the O button after it complets

x|

- Click ‘OK’ button
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(6-2) About the exchange of the dispensing head

The dispensing head can be exchanged by clicking ‘Change Head* button.

<Dispenser Control Box>

Dispenser Gontrol

tsay Plate frcess

THI+Stage] | THi+5tage2 | THI+Stagel | THI+Stage2 |

Dispense Start Nazzle Wash ‘

Aspirate
Asp. Stage [Stage -
vome [0 ¢ | |
Speed B ul/s 4 jﬂ
Height [100mm <
¥ Trituration
W ovel flou <] |
GCount 15 TIND
Height [00mm— «| |
Offset [00mm <[ |

Dispense Wash
Speed [Buls 4 v || @ wash [ After Measurement
Height 100 mm ¢ , -
[ Triturstion vat  [A -

v faa | (]| cvee B
Court 5 D
Height 00 mm  «| | »
Offset 00mm | |

Pos O0mm +— Change Head button

Chanee Head
I Wipe:a Access Ligand Nol

When the ‘Change Head’ button is clicked, the following message is displayed.
Please click ‘OK’ button to exchange the dispenser head.

g Yiou can access Ligand Stage.
Please push the 0K button after & completes £, Click ‘OK’ button
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In the case the dispensing head keep to be loaded, after they get unloaded, the
following box is displayed.

Please select ‘Head Mode’ used and click ‘Set the head’ button when the
exchange of the dispenser head is finished.
The processing matched to ‘Head Mode’ is done.

<Change the dispenser head box>

Ghange the dlspenser head

Select Head Mode ¢ y
<A Mo Head <B» Head 1 [ Choose Head 1
: The head is installed
Headl
PeftD Rz Choose ‘No Head’

: The head is not installed

384 well

Click ‘OK’ button

N

Set the head (The made is changed)
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(6-3) Applicable modes of dispensing head

In the uCELL, there are such 2 applicable modes as follows.
A) The mode not to use any dispensing head.
(In this case, the dispensing operations are not performed at all.)
B) The mode to use 1 head.

These 2 modes can be changed when the dispensing head is exchanged.
It is set by the following box that the dispensing head used in the case FDSS perform

the dispensing.
The following shows the combination in the each usage mode

Ghange the dispenser head
elect Head Mode — (1)

<A> Mo Head <B> Head 1

- ™

Flate Format

384 well

Set the head (The mode iz changed)

(2)
@)

(1) Select Head Mode
: Select the usage mode of dispensing head
<A> No Head : Any dispensing are not performed
<B> Head1 : One dispensing head is performed
(2) Plate Format
: The plate format being selected at the starting
(3) Set the head
: To load the dispensing head corresponding to the select

178
HAMAMATSU PHOTONICS KK



FDSS7000EX/uCELL Software Instruction Manual Ver.2.9.3 72360301-04

13. Camera Control box
Use to control a camera manually and it displays output from the camera.

Camera Control box controls a camera and periheral devices and display output on Image
Window and Microplate Window. It displays live images with Sensitivity 10 at
fluorescence.

And it displays live images and photon counting images at luminescence [Photon
counting] measurement.

And it displays live images with sensitivity 3 at luminescence [Analog] measurement.

And the pseudo colors display and enhance processing are available.
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1) Camera Control box
(at fluorescence & luminescence [Analog][EMCCD] measurement)

The following Camera Control box appears just after FDSS software starts up with a
fluorescence or luminescence [Analog][EMCCD] method. Clicking ‘Live On’ displays
Image Window and Microplate Window, and then fluorescence images are observed.

m Do not open the door of the dark box at Live ON. I

<Camera Control box:
fluorescence & luminescence [Analog][EMCCD]measurement>

Gamera Gontrol
1

(1)
[ Live On ]‘ ( Live Off (2)
3)

o Y )
(4)

1 5 10
= — — (5)
Camera Parameter

lEx;o. Time | 200 ms ij (6)
(7)

Live

Birriing 2x2

(1) Live On : To acquire live images. It automatically turns ‘Live Image
Window’ on.
(2) Live Off : To stop acquiring live images.
(3) Camera Temp
: To display the cooling temperature of the camera.([EMCCD])
(4) Live Image Window
: To switch display ON/OFF for Image Window and Microplate
Window.
(5) Sensitivity
Sensitivity (Fluorescence)
: To set sensitivity (camera gain) with 10 steps.
Sensitivity (Luminescence [Analog] )
: To set sensitivity (1.1 gain) with 3 steps
Sensitivity (Luminescence [EMCCD] )
: To set sensitivity (EM gain) with 5 steps
(6) Expo. Time : To display an exposure time which is currently set.
(7) Binning : To display a binning which is currently set.
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2) Camera Control box
(at luminescence [ Photon Counting ] measurement)

The following Camera Control box appears just after FDSS software starts up with a
luminescence [Photon counting] method. Clicking ‘Live On’ displays Image Window and
Microplate Window, and then Photon counting images are observed.

m Do not open the door of the dark box at Live ON. I

<Camera Control : Luminescence measurement>

Camera Gontrol (Photon Counting)

Live { Phaton Counting/T (1)
[ Live On J ‘( Live Off )__ 2
(oo ®

Time

[ Photon Counting Time 00:00:00 }__ (4)

Raw Image { Manual Sengitivity-by-Cantratier (5)

[ Camera On ]‘ [ Camera Off ]

(6

<Camera Control : Luminescence (with Gate function) measurement>

ﬁ |

Live ¢ Photon Gounting

Live On Live Off
Live Image Window.. (7)
BT

1 2 3

- ——
=
Time
Photon Counting Time 000000

Raw Image { Manual Sensitivity by Gontroller 3

Camera On Camera Off

(1) Live On : To start Photon Counting acquisition. It automatically turns
‘Live Image Window’ on.
(2) Live Off : To stop Photon Counting acquisition.
(3) Live Image Window
: To switch display ON/OFF for Image Window and
Microplate Window.
(4) Photon Counting Time
: To display the elapsed time of Photon Counting acquisition.
The image is newed each one second.
(5) Camera On: To acquire and display live image for checking when
sensitivity is controlled by an 1.1. controller.
(6) Camera Off: To finish acquiring and displaying live images.
(7) Sensitivity : To set sensitivity (Gate Duty) with 3 steps.
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3) Image Window , Microplate Window
Clicking ‘Live On’ or ‘Live Image Window’ in Camera Control box leads Image Window,
Microplate Window and Tool Bar. Camera output images are displayed in Image
Window and intensity data with a micro plate well in Microplate Window.

<At Live On>

(1) Image Window : To display camera Live image / Photon Counting images.
And when mouse-arrow is located in a image window,
coordinate and intensity value are displayed.

(2) Microplate Window

: To display camera Live images / Photon Counting images.

(3) Live Toolbar : To set Color LUT and Enhance table.

4) Live Toolbar

Toolbar appears to set the pseudo color setting and enhance setting for Image Window
and Microplate Window respectably.

ﬂ@ | (37,0 65262

(1 @) @) (4)
(1) Color LUT : To set psuedo color LUT table. (refer to 5)
(2) Auto enhance : To display intensity with auto enhance.
(3) Enhance table setup: To set an enhance table for intensity.
(4) Coordinate and intensity
: To display coordinate and intensity value at the specified
point by a mouse-arrow in image Window.
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5) Color setup box
Clicking ‘Color LUT setup’ in Toolbar leads Color setup box to set a psuedo color setting
for Image Window and Microplate Window.

Select Table __ (1 )

Stey A

dation A
radation B
radation G

. — (6)
]| ( Cancsl H/
) ©)

(1) Invert : To invert a color table.

(2) Select Table : To set a color table in this selection.

(3) Now color table : To display the currently used color table

(4) New color table : To display the newly chosen color table in Select Table.
(5) Set : To renew a color table.

(6) Cancel : To cancel operation.
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6) Enhance setup box
Clicking ‘Enhance table setup’ in Toolbar leads Enhance table setup box to set an
enhance setting for Image Window and Microplate Window.

b (6)
1] \ 4095
(7)
(1) Auto Enhance : To execute an auto enhance.
(2) Enhance lower limites : To set lower limite of an area for enhancement.

(Also available with a draging graph.)
(3) Enhance higher limites  :To set higher limite for an area for enhancement.
(Also available with a draging graph.)
(4) Graph : To display graph with (X,Y)=(Intensity value,
conveted value). It is changed by a draging
graph with a mouse.

(5) Histgram : To display a histgram of an image.

It refers to the set enhancement manually.
(6) Scale switching : To switch an intensity scale.
(7) Intensity scale : To display an intensity scale.

184
HAMAMATSU PHOTONICS KK



